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Ubersicht

UBERSICHT

Willkommen in der Software-Bedienungsanleitung fir den System-Prozessor Shure P4800. Das Ziel dieses
Dokuments ist es, Ihnen ein Verstandnis der Funktionen des P4800 zu vermitteln, wahrend Sie den Umgang mit der
Software-Oberflache erlernen. Das Gerat kann als unabhéngiger Front-End- und Back-End-System-Prozessor
eingesetzt werden, der sich extern durch eine einfache Benutzerschnittstelle steuern lasst, wahrend die Software
dazu dient, die interne Signalfiihrung und Audioverarbeitung des Geréts zu konfigurieren. Das Gerét ist fur kleine und
mittelgroRe Soundsysteme vorgesehen, fur die die Leistung und Flexibilitat eines Digital-Signalprozessors benétigt
wird, der sich aber bei der Installation einfach konfigurieren und vom Benutzer einfach bedienen lassen soll.

Aufbau dieser Anleitung

Mdoglicherweise empfinden Sie die Software-Oberflache als so intuitiv und benutzerfreundlich, dass Sie die
Dokumentation gar nicht mehr lesen wollen, sondern gleich mit der Programmierung des Geréts beginnen mdchten.
Vorher sollten Sie aber unbedingt die Ubersicht uberfliegen und dann den Abschnitt Einrichtung auf Seite 12
aufmerksam lesen. Antworten auf Fragen zur Benutzung der Software finden Sie in den folgenden Abschnitten dieser
Anleitung.

= Ubersicht .., Stellt die wesentlichen Merkmale des System-Prozessors vor und
diskutiert die Betriebsmodi der Oberflache und des Hauptfensters.

= Einrichtung ..o, Beschreibt die grundlegenden Schritte in der Software, um den
System-Prozessor fur eine Installation einzurichten.

= Erstellen einer Konfiguration..Behandelt die Elemente einer Signalflusskonfiguration des
System-Prozessors wie Verstarkungsstruktur des Geréts, Signalfihrung von Eingangen zu
Ausgéangen, Hinzufligen von Prozessoren in den Signalweg und Arbeiten damit im Hauptfenster.

= Speichern einer KonfigurationErlautert die Speicherung einer Konfiguration im Computer,
Speicherung als Preset im P4800 und Datensicherung vom Gerat zum Computer.

= Prozessor-Funktionen............... Beschreibt die Funktionen, die in vielen Signalprozessor-Modulen
vorkommen, wie Fader, Momentaufnahmen von Parameter-Einstellungen sowie Speichern und
Abrufen von Einstellungen in den bzw. aus dem Computer.

» Feste Prozessoren .......cccoee... Erlautert die Funktionen der Ein- und
Ausgangsverstarkungs-Prozessoren und des Matrixmischers.

» Modulare Prozessoren.............. Erklart die jeweiligen Funktionen der einzelnen modularen
Signalprozessoren.

B StEUErPINS .o Beschreibt die interne  Architektur der externen
Geratesteuerfunktion des System-Prozessors und erlautert die Konfiguration der Steuerpins
des P4800 mit der Software, nachdem die externe Hardware angeschlossen wurde.

= Sicherheit ....cccooveeveeeeeveceeee Behandelt die Sicherheitsfunktionen des  System-
Prozessors, die den Benutzerzugang zu den Gerateeinstellungen einschréanken.

Merkmale des System-Prozessors

Der P4800 ist ein digitaler Audio-Prozessor mit 4 Ein- und 8 Ausgangen und einer Software-Oberflache, die die
Bedienelemente an der Geratevorderseite vollstandig ersetzt. Er bietet 24-Bit-Umwandlung, Sampling mit 48 kHz und
einen minimalen Dynamikbereich von 100 dB. Die Soundplex-Digitalsignalverarbeitung gewébhrleistet hohe Leistung
und Systemstabilitat. Das Gerat kann, abhéangig von der Komplexitat der Konfigurationen, zwischen 16 und 128 vom
Benutzer definierte Presets speichern.

Software-Oberflache mit Drag & Drop

Die Computerschnittstelle zum System-Prozessor ahmt die funktionalen Blockdiagramme nach, die im
Soundsystem-Design verwendet werden. Dadurch lasst sich die Software sehr leicht erlernen, weil die
Benutzeroberflache fur Tontechniker sofort vertraut erscheint. Systemkonfigurationen kénnen ausschlieflich
durch Klicken, Ziehen wund Ablegen mit der Maus erstellt und bearbeitet werden. Dieser
Digitalsignalprozessor ist in groRem Umfang konfigurierbar, seine modularen Signalprozessoren lassen sich
beliebig vom Benutzer anordnen.
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Ubersicht

Modulare Sighalprozessoren

Jedes Signalprozessormodul ist in einem Grafikblock eingeschlossen, der mit der Maus bearbeitet werden
kann. Zum Zugriff auf die Einstellungen des Prozessors wird auf den Block doppelgeklickt, um sein
Parameterfenster einzublenden. Einstellungen kénnen im Computer gespeichert und von dort abgerufen
sowie zwischen &hnlichen Modulen kopiert werden. Prozessor-Einstellungen lassen sich au3erdem tber die
Verknupfungsfunktion miteinander synchronisieren. Der P4800 enthalt die  folgenden
Signalprozessormodule.

= Leistungsstarker digitaler
Ruckkopplungsreduzierer von Shure

= Automatische Pegelregelung und Ausgleicher = Gate/Expander

= 2- bis 5-Wege-Frequenzweichen und -Verteiler

= Kombinierende und nichtkombinierende = Mono- und Stereo-Kompressoren/Limiter mit
grafische Equalizer mit 10 und 30 Béndern Soft-Knee-Option

= Parametrische Equalizer mit 3 bis 10 Bandern = Separate Filter mit steilflankiger und
und Filter mit steilflankiger und Kuhschwanz- Kuhschwanz-Charakteristik mit einer Flanke von
Charakteristik 24 dB pro Oktave

= Ducker = Peak-Stop-Limiter

Externe Geratesteuerung

Nach der Installation und Programmierung Uber die Software-Oberflache lasst sich der System-Prozessor nicht
nur per Computer und MIDI steuern, sondern auch Uber eine einfache Hardware-Schnittstelle fir den
Endbenutzer. Die Steuerpins an der Geratertickseite kdnnen mit externer Hardware verbunden werden, sodass
der P4800 auf SchlieRen von Kontakten, Potentiometer und Schalter reagiert. Die Ausgangspins lassen sich so
konfigurieren, dass sie Preset- und Stummschalt-Zustande an LEDs, Steuerrelais und andere Vorrichtungen
leiten.

Sicherheit

Die Sicherheitsfunktion verhindert, dass andere Personen nach der Installation am Gerat ,spielen” und dabei
Einstellungen verandern. Der Benutzerzugang lasst sich vollstandig beschranken, sodass der Benutzer keine
Einstellungen verandern und nicht einmal Presets umschalten kann. Dann ist es nur mdglich, die Einstellungen
des jeweiligen Presets auf der Software-Oberflache zu sehen. AufRerdem kann die Endbenutzer-Kontrolle
konfiguriert werden, sodass Zugang zu bestimmten Einstellungen méglich ist, zu anderen aber nicht.

Mindesterfordernisse fur die Software des P4800

Fir einwandfreie Installation und einwandfreien Betrieb erfordert die Software Version 3 des P4800 einen PC
mit der folgenden Ausstattung:

= 20 MB verfuigbarer Festplatten-Speicherplatz

= CD-ROM-Laufwerk

=  VGA-Monitor mit 640 x 480/256 Farben oder héherer Auflésung
= Maus oder anderes Zeigegerat

Die CPU-Taktrate und der erforderliche Speicher sind abhéngig von der Windows-Version und der Anzahl
der im Hintergrund ausgefuhrten Anwendungen. Der gleichzeitige Betrieb der P4800 Software mit anderen
Programmen wie SIA-Smaart® oder Gold Line TEF™ erfordert einen schnelleren Prozessor und mehr RAM-
Speicher. Die nachstehende Tabelle enthalt die Mindesterfordernisse zur Ausfiihrung der P4800 Software,
wahrend keine anderen Anwendungen einschlie3lich Virenschutz-, Firewall-, Instant-Messaging- und E-Mail-
Anwendungen ausgefihrt werden.

Windows-Version CPU-Taktrate RAM
95, 95B und 98 Pentium 166 MHz 32 MB
98, Second Edition Pentium 166 MHz 48 MB
NT Pentium 233 MHz 64 MB
ME Pentium 300 MHz 64 MB
2000 Professional Pentium 300 MHz 96 MB
XP Professional, Home Pentium 300 MHz 128 MB

SHURE® System-Prozessor P4800 Software-Bedienungsanleitung Seite 6 von 108



Ubersicht

Betriebsmodi der Benutzerschnittstelle

Die Benutzerschnittstelle verfugt tiber zwei hauptsachliche Betriebsmodi: Design-Modus und Live-Modus. Dadurch besteht
die Mdoglichkeit, unabhangig davon, ob das Geradt am Computer angeschlossen ist, Konfigurationen fur den System-
Prozessor zu erstellen. Bestimmte Funktionen sind nur in einem Modus verfigbar und werden an entsprechender Stelle in
der Anleitung erlautert.

Design-Modus

Beim Starten wird die Anwendung immer im Design-Modus geéffnet. In diesem Modus werden die Presets
erstellt, die spater im System-Prozessor gespeichert werden. In diesem Modus ist es nicht erforderlich, dass
der Computer am Geréat angeschlossen ist. Die erstellten Signalfluss-Konfigurationen kénnen in Szene-
Dateien im Computer gespeichert werden und lassen sich spater wieder o6ffnen und Uber die RS-232-
Verbindung zum Gerat Gbertragen. Dadurch kénnen Presets an anderen Orten als unmittelbar an der Anlage
erstellt werden. Szene-Dateien entsprechen Presets in jedem Aspekt mit der Ausnahme, dass sie im
Computer und nicht im Gerét gespeichert werden.

Live-Modus

In diesem Modus kdnnen Echtzeit-Einstellungen an den Hardware-Presets vorgenommen werden, wahrend
der Computer am System-Prozessor angeschlossen ist. Auf diese Weise konnen die Anderungen der
Signalverarbeitung beim Andern von Einstellungen sofort gehort werden, um die Presets vor Ort
.,maBzuschneidern®. Alle Bedienvorgange im Live-Modus werden direkt in das jeweils getffnete Preset
geschrieben.

Vorschau-Modus

Beim Arbeiten im Live-Modus mit einem Gerat, das mehrere Presets enthélt, kdnnen diese einzeln zur
Veranderung in Echtzeit abgerufen werden. Wenn ein Preset gewahlt wird, das in das Signalflussdiagramm
geladen werden soll, schaltet das Fenster in den Vorschau-Modus, damit die Wahl bestatigt werden kann,
bevor das Preset als nachstes Live-Preset zugewiesen wird. Die Schnittstelle kehrt zum Live-Modus zurlck,
wenn das Preset geladen oder der Vorgang abgebrochen wird.
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Ubersicht

Das Hauptfenster

In diesem Abschnitt werden die Elemente des Hauptfensters vorgestellt und ein Teil der Terminologie der Software
eingefuhrt. Dieses Fenster ist der hauptsachliche Arbeitsplatz in der Software-Schnittstelle. Das Fenster kann proportional
vergrof3ert oder maximiert werden, sodass es den gesamten Bildschirm ausfilit. Durch Schlief3en dieses Fensters wird die
Anwendung beendet.

P4800 : Ofline Security - Levell
Fle Edt View Processor Devices Secumty Window Help

. Mame: (unnamed)
- Lazt Saved:

Description:

|
© 2001 Shure Incoporated  In Fl:(fé %i Ouwt  DSP

Abbildung 1 - Hauptfenster

1. Titelleiste

Die Informationen in der Titelleiste dieses Fensters andern sich entsprechend des Betriebsmodus. Im
Design-Modus enthélt die Titelleiste ,P4800: Offline” und zeigt die Standard-Sicherheitsstufe an. Im Live-
Modus werden Informationen Uber das angeschlossene Gerat angezeigt.

Gerate-Kennnummer Geratename Sicherheitsstufe

P43800 : Device ID 15 : PRIMARY Security - Levell
File Edit View Processor Devices Secuity ‘Window Help

Abbildung 2 - Titelleiste im Live-Modus

Die Gerate-Kennnummer wird mit den DIP-Schaltern an der Geraterlickseite eingestellt, und der
Geratename und die Sicherheitsstufe werden im Menu [Device] (Gerét) im Live-Modus gewahilt.

2. Hauptmenu

Einige Menloptionen sind nur in bestimmten Modi verfugbar und werden in den anderen Modi
abgeblendet. Kontextbezogene Menus sind auch verfiugbar, indem mit der rechten Maustaste geklickt
wird, wenn der Cursor sich im Signalflussdiagramm (unten Nummer 11) befindet.
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Ubersicht

3. Steuerleiste

Dieser Fensterabschnitt verandert sich im Erscheinungsbild und in der Funktion abhéngig vom
Betriebsmodus. Im Live-Modus bildet die Steuerleiste die LED-Pegelanzeigen an der Vorderseite des

Gerats nach.
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Abbildung 3 - Steuerleiste im Live-Modus

Die Pegelanzeigen lassen sich ein- und ausschalten, indem mit der linken Maustaste darauf geklickt
oder indem [View > Enable 1/0O Meters] (Ansicht > E/A-Pegelanzeigen aktivieren) im Hauptmeni gewahlt
wird.

T
mwm I Presetdt 2 Auditariom 2 ;I
Last Downloaded: 05-Mar-2001 Click Load to make Preset Live
(Default) Return to Live

Dizeription: Sterea Plagback with Automix
Abbildung 4 — Steuerleiste im Vorschau-Modus

Im Vorschau-Modus bietet die Steuerleiste die Méglichkeit, das gewahlte Preset zu laden oder den Vorgang
abzubrechen und zum vorherigen Live-Preset zurlickzukehren.

4. Schaltflache , Live Mode" (Live-Modus)

Durch Klicken auf diese Schaltflache wird in den Live-Modus geschaltet, in dem jedes im Gerat
gespeicherte Preset als Vorschau angezeigt und bearbeitet werden kann. Um in diesen Modus schalten
zu kénnen, muss der Computer am P4800 angeschlossen sein.

5. Schaltflache , Design Mode* (Design-Modus)

Durch Klicken auf diese Schaltflache wird in den Design-Modus geschaltet. Das Preset, mit dem im Live-
Modus gearbeitet wird, bleibt im Signalflussdiagramm geladen, wodurch das jeweilige Preset als Vorlage
verwendet und mehrere Presets durch wiederholtes Speichern im Geréat erstellt werden kénnen.

6. Informationsfeld

Hier werden Informationen Uber das Preset oder die Szene-Datei angezeigt, das/die gegenwartig auf
dem Bildschirm geladen ist, wie Name, Datum der letzten Speicherung und Beschreibung. Im Live-
Modus erscheint ein Pulldown-Meni im Namensfeld, in dem alle im Gerat gespeicherten Presets
aufgelistet werden (siehe Abbildung 3 oben).

7. Store Preset (Preset speichern)

Diese Schaltflache ist nur im Design-Modus verfligbar. Durch Klicken darauf werden die aktuellen
Signalflussdiagramm-Einstellungen als Hardware-Preset im System-Prozessor gespeichert.

8. Recall Preset (Preset abrufen)

Diese Schaltflache ist nur im Design-Modus verfugbar. Durch Klicken darauf wird ein Preset aus dem
System-Prozessor in das Signalflussdiagramm geladen.

9. Save As (Speichern unter)

Durch Klicken auf diese Schaltflache werden die aktuellen Signalfluss-Konfiguration und -Einstellungen
in eine Szene-Datei gespeichert.

10. Open (Offnen)

Diese Schaltflache ist nur im Design-Modus verfiigbar. Durch Klicken darauf wird der Inhalt einer Szene-Datei
in das Signalflussdiagramm geladen.

11. Signalflussdiagramm

Das Signalflussdiagramm stellt dar, wie Audiosignale durch die verschiedenen Prozessoren in der
Hardware gefiihrt werden. Es veranschaulicht, wie Audiosignale von links nach rechts durch die Ein- und
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12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

Ubersicht

Ausgangskanalstreifen verlaufen. Jeder Kanalstreifen enthalt feste Komponenten zum Einstellen der
Verstarkung und Mischen der Kandle. Sie enthalten au3erdem eine Reihe von leeren Steckplatzen zum
Hinzufiigen von verschiedenen Verarbeitungsarten.

Eingangskanalstreifen

Die Eingangskanalstreifen entsprechen den vier Eingangskandlen des System-Prozessors. Jeder
Streifen kann bis zu finf verschiedene Signalprozessoren aufnehmen.
Eingangskanal-Kennzeichnung

Hier wird die Kanal-Kennzeichnung angezeigt, die im Fenster ,Input Gain“ (Eingangsverstarkung)
eingegeben wird.

Eingangsverstarkung

Dies ist die Anfangsstufe der Verstarkungsstruktur des System-Prozessors. Durch Doppelklicken auf
diesen Block wird das Fenster ,Input Gain“ eingeblendet, das Skalierungs-Optionen von -10 dBV/+4
dBu, Kanal-Stummschaltung, Polaritatsregelung und einen +/-30 dB-Fader fiir jeden Eingangskanal
aufweist. AuRerdem werden hier die Namen fir die Eingangskanéle eingegeben.

Modusanzeige

Hier wird der jeweilige Modus des Signalflussdiagramms angezeigt, wie nachstehend abgebildet.

Design-Modus Live-Modus Vorschau-Modus

Control P4S00 Device
Eingangswahler

Durch Klicken auf diese nummerierten Eingangswahler am Mischpunkt jedes Ausgangsstreifens erfolgt
automatisch die Verbindung mit dem entsprechenden Eingangskanal-Mischpunkt.

Matrixmischer

Dies ist die Zwischenstufe der Verstarkungsstruktur des System-Prozessors. Durch Klicken auf diesen Block
wird das Fenster ,Matrix Mixer* eingeblendet, in dem das Signal von jedem Eingangskanalstreifen zu jedem
Ausgangskanalstreifen geftihrt und relative Pegel mit den Fadern eingestellt werden kénnen. Dieses Fenster
verfugt Uber eine separate Registerkarte fir jeden Ausgangskanalstreifen, auf der Verstarkungs-, Polaritats-
und Stummschaltungs-Steuerelemente fiir jeden an seinem Mischpunkt angeschlossenen Eingangskanal
angezeigt werden.

Kanalnummern

Diese Nummern entsprechen jeweils den vier Ein- und acht Ausgangskanélen des P4800.

Mischpunkte

Durch Klicken auf diese Punkte werden Signale zwischen Eingangsstreifen und Ausgangsstreifen
gefihrt. Zwischen den verbundenen Punkten werden Linien angezeigt, die den Signalfluss darstellen.
Jeder Eingangsstreifen kann mit beliebigen oder allen Ausgangsstreifen verbunden sein.

Prozessor-Steckplatze

Diese Steckplatze dienen zur Unterbringung von Prozessormodulen. Sie kénnen durch Ziehen und
Ablegen aus der Prozessor-Toolbox, mit der Option [Add Processor] (Prozessor hinzufligen) des
Hauptmenis oder mit dem Kontextmend, das durch Klicken mit der rechten Maustaste eingeblendet
wird, bestuckt werden.

Ausgangsverstarkung

Dies ist die Endstufe der Verstarkungsstruktur des System-Prozessors. Durch Doppelklicken auf diesen
Block wird das Fenster ,Output Gain“ eingeblendet, das Skalierungs-Optionen von -10 dBV/+4 dBu, Kanal-
Stummschaltung, Polaritéatsregelung, ein -20 dB-Dampfungsglied und einen +/-30 dB-Fader fiir jeden
Ausgangskanal aufweist. AuRerdem kann hier ein benutzerdefinierter Name fir jeden Ausgangskanal
eingegeben werden, der fur die jeweilige Einrichtung gilt.
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Ubersicht

22. Ausgangskanal-Kennzeichnung
Hier wird die Kanal-Kennzeichnung angezeigt, die im Fenster ,Output Gain“ (Ausgangsverstarkung)
eingegeben wird.

23. Ausgangsstreifen
Die Ausgangskanalstreifen entsprechen den acht Ausgangskandlen des System-Prozessors. Jeder
Streifen kann bis zu sechs verschiedene Signalprozessoren aufnehmen.

24. Alle Eingange stumm schalten

Durch Klicken auf dieses Steuerelement werden automatisch alle Eingangskanale stummgeschaltet.

25. Alle Ausgéange stumm schalten

Durch Klicken auf dieses Steuerelement werden automatisch alle Ausgangskanéle stummgeschaltet.

26. DSP-Belegungsanzeige

Hier wird der Prozentanteil der Digitalsignalverarbeitungs-(DSP)-Ressourcen des P4800 angezeigt, der
durch die jeweilige Konfiguration der Prozessorblocke, die in das Signalflussdiagramm gesetzt wurden,
eingenommen wird. Der angezeigte griine Balken verlangert sich, wenn die Belegung zunimmt.

27. Verzdgerungsspeicher-Anzeige

Hier wird der Prozentanteil des Verzogerungsspeichers angezeigt, der durch die Delay-Prozessoren, die
in das Signalflussdiagramm gesetzt wurden, eingenommen wird. Der angezeigte blaue Balken
verlangert sich, wenn die Belegung zunimmt.

Die Prozessor-Toolbox

Die Prozessor-Toolbox wird beim Starten der Anwendung neben dem Hauptfenster eingeblendet. Dieses Fenster
enthalt die Bibliothek der Prozessormodule, die in leere Steckplatze des Signalflussdiagramms gezogen und dort
abgelegt werden konnen. Seine GrofRe kann in vertikaler Richtung durch Ziehen des unteren Rands nach oben oder
unten verandert werden. Eine Bildlaufleiste erscheint an der rechten Seite, sodass unabhangig von der Hohe des
Fensters Zugriff auf jeden Prozessorblock mdglich ist.

Ein- und Ausblenden

Die Prozessor-Toolbox wird vor jedem anderen offenen Fenster in der Anwendung angezeigt, wenn sie nicht durch
Klicken auf das Steuerfeld rechts in der Titelleiste geschlossen wird. Mit [View > Show
Processor Toolbox] (Ansicht > Prozessor-Toolbox anzeigen) aus dem Hauptmeni wird sie
wieder eingeblendet. Neben dieser Meniioption wird ein Hakchen gesetzt, wenn dieses
Fenster angezeigt wird. Durch die Wahl dieser Option, wéhrend die Prozessor-Toolbox
eingeblendet ist, wird das Fenster geschlossen.

Dropdown- >

Prozessorblocke Schaltflache

Prozessorblécke sind die grafische Darstellung der Prozessormodule.
Nachdem sie in das Signalflussdiagramm gesetzt wurden, ist Zugriff T Eiard
auf die Einstellungen moglich, indem auf den betreffenden Block Prozessor- > '
doppelgeklickt wird, um sein Parameterfenster einzublenden. blocke

Dropdown-Schaltflachen

Eine Dropdown-Schaltflache erscheint Uber jeder Prozessor-Kategorie in der Prozessor-
Toolbox. Klicken Sie auf eine Dropdown-Schaltflache, um alle Prozessorbldcke innerhalb
dieser Kategorie anzuzeigen oder zu verbergen.

Abbildung 5 - Prozessor-Toolbox
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Einrichtung

EINRICHTUNG

In diesem Abschnitt werden die grundlegenden Schritte fur die vollstandige Einrichtung des System-Prozessors
erlautert. Bevor diese Anweisungen ausgefuhrt werden, sollte der Abschnitt ,Ubersicht* gelesen werden, der einige
grundlegende Merkmale der Software-Schnittstelle beschreibt.

Viele dieser Anweisungen kénnen ausgefuhrt werden, ohne dass das Gerat angeschlossen ist, indem die Konfigurationen
im Computer gespeichert und spater zum Geréat Gibertragen werden. Um die Mdglichkeiten des System-Prozessors optimal
vorzustellen, wird bei diesen Anweisungen folgendes vorausgesetzt:

= Beim Arbeiten in der Software ist das Gerat angeschlossen.
= Die Installation umfasst externe Geratesteuerung.
=  Gerate-Sicherheit ist erforderlich.
In den Anweisungen kénnen Schritte vorkommen, die nicht unmittelbar auf die bestehende Installation zutreffen. Wir

empfehlen jedoch, den gesamten Abschnitt ,Einrichtung” durchzuarbeiten, um die empfohlenen Arbeitsablaufe fur die
Einrichtung des Gerats kennen zu lernen.

Software installieren

Wenn die Software noch nicht installiert wurde, die nachstehenden Anweisungen ausfihren, um die
Anwendung von der CD-ROM zu installieren.

So wird die Software von der CD-ROM installiert:
1. Die CD in das CD-ROM-Laufwerk des Computers einlegen.
2. Das Installationsprogramm startet automatisch. Die angezeigten Anweisungen ausfiihren.

- Falls die Installation nicht automatisch beginnt -

1. Auf die Schaltflache [Start] der Windows Taskleiste klicken und [Ausfiihren...]
aus dem Popup-Menu wéhlen.

2. ,D:\setup” eingeben (wobei ,D“ der CD ROM-Laufwerksbuchstabe ist).
3. Auf [OK] klicken und die Anweisungen des Installationsprogramms ausfihren.

Wenn die Software per Datenlibertragung erhalten wurde, die Datei mit der Endung ,.exe* im
Windows Explorer 6ffnen. Die Anweisungen des Installationsprogramms ausfuhren.

Kommunikation herstellen

Dieses Verfahren ist auszufiihren, wenn der Computer zum ersten Mal an das Gerat angeschlossen wird.
Dies ist die erste Méglichkeit zur Uberpriifung, ob der Computer und der P4800 einwandfrei miteinander
kommunizieren. Fiur weitere Informationen zum AnschlieBen des Computers an das Gerat und zum
Einstellen der Gerate-Kennnummer siehe den Abschnitt Computeranschlussoptionen der Hardware-
Installationsanleitung.

1. Den Computer an den System-Prozessor anschliel3en

Den COM-Anschluss des Computers mit dem seriellen RS-232-
Anschluss an der Vorder- oder Riickseite des P4800 verbinden. Select Com Port

COM Part

com
EEMT
COM2
COM3
COM4

2. Die Software-Anwendung starten

3. Den COM-Anschluss wahlen

a) Die Option [Devices>Select COM Port] (Gerate > COM-
Anschluss wahlen) im Hauptmeni wahlen.

b) Das Dialogfeld ,Select COM Port* (COM-Anschluss wahlen) wird

eingeblendet. ok | cencel | Hep |

c) Den COM-Anschluss wahlen, an den das RS-232-Kabel

angeschlossen ist, und auf [OK] klicken. Abbildung 6 — Dialogfeld,Select COM
Port* (COM-Anschluss wéhlen)

Ehate humber I
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Einrichtung

4. Den System-Prozessor in den Live-Modus schalten

a) Auf die Schaltflache [Live Mode] in der Steuerleiste des

Hauptfensters klicken. Devices:

b) Das Dialogfeld ,Select Devices" (Gerate wahlen) mit einer Liste
aller verfiigbaren Gerate wird eingeblendet. Die Kennnummer an
der linken Seite der Liste wird mit den DIP-Schaltern an der
Geraterilickseite eingestellt.

c) Den System-Prozessor wahlen, mit dem gearbeitet werden
soll, und auf [Connect] (Verbinden) klicken.

d) Die Software-Schnittstelle schaltet in den Live-Modus, ersichtlich Conmect I
durch die blaue Farbe des Signalflussdiagramms und der in der
Steuerleiste angezeigten Signal-Pegelanzeigen.

Cancel | Help

Abbildung 7 - Dialogfeld ,Select Devices*

.. Gerate wahlen
5. Das Geréat benennen ( )

a) Die Option [Devices>Name Device] (Gerate > Gerat benennen) im

Hauptmenti wahlen.

b) Das Dialogfeld ,Name Devices* (Gerate benennen) wird Device 15 name:
eingeblendet. |MP Confrnce 1

c) Einen aus bhis zu fiinfzehn Zeichen bestehenden Geratenamen
eingeben und auf [Name] (Benennen) klicken. Name i!) Cancel | Help |

d) Der Geratename erscheint im Live-Modus in der Titelleiste des Abbildung 8 - Dialogfeld ,Name
Hauptfensters und wird im Ment [Devices] (Gerate) aufgelistet. Device" (Gerat benennen)

Externe Steuerung konfigurieren

Wenn externe Geréate an den Steuerpins angeschlossen sind, muss das Gerdt zum Erkennen der externen
Steuerung konfiguriert werden. Diese Konfiguration wird auf Gerateebene gespeichert und sollte eingerichtet
werden, bevor Presets erstellt werden. Wenn kein Anschluss an das Gerat besteht, kann eine Konfiguration
erstellt und im Computer gespeichert werden, um sie spater tUber die RS-232-Verbindung zum P4800 zu
Ubertragen. Siehe die Anweisungen daflr im Abschnitt Steuerpins auf Seite 76.

1. In den Design-Modus schalten

Zum Konfigurieren der externen Steuerung muss der Design-Modus aktiviert sein. Im Live-Modus auf die
Schaltflache [Design Mode] in der Steuerleiste des Hauptfensters klicken.

2. Steuerpins konfigurieren

Die Option [Devices>Control Pin Configuration] (Gerate>Steuerpin-Konfiguration) im Hauptfenster wahlen,
woraufhin das Fenster ,Control Pins“ (Steuerpins) eingeblendet wird. Zuerst wird entschieden, zwischen wie
vielen Presets umgeschaltet werden soll und welche Art der Codierung das Gerat fir die Preset-Nummern
verwenden soll. Dann werden die anderen Steuerungs-Verbindungen vorgegeben.

3. Die Konfiguration im Geréat oder PC speichern

Die MenUoption [Configuration>Store to Device] (Konfiguration>Im Gerét speichern) oder [Configuration>Save
to PC] (Konfiguration>Im PC speichern) wahlen.

Hinweis: Wenn es nach der Konfiguration der Steuerungs-Eingangsanschliisse erforderlich
werden sollte, Presets vom Computer umzuschalten, missen die Verbindungen im
Fenster ,Control Pins" vor dem Fortfahren deaktiviert werden.
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Einrichtung

Eine Signalfluss-Vorlage erstellen

Dieser Vorgang kann im Live-Modus oder Design-Modus ausgefiihrt werden. Wenn mehrere Presets im System-
Prozessor gespeichert werden sollen, ist eine betrachtliche Zeiteinsparung méglich, indem eine Signalfluss-
Vorlage erstellt wird, die die Attribute enthalt, die gemeinsam fiir diese Presets gelten. Diese Vorlage kann dann
aus dem Geréat abgerufen oder aus einer Szene-Datei im PC gedffnet, nach Erfordernis bearbeitet und dann als
neues Preset im Gerét gespeichert werden.

1.

Ein- und Ausgangskanale benennen

Auf die Eingangs- und Ausgangs-Verstarkungsblocke doppelklicken, um die Prozessorparameter-
Fenster einzublenden, und die Kanal-Kennzeichnungen unter den Pegelstellern bearbeiten. Fur weitere
Informationen siehe den Abschnitt Ein- und Ausgange kennzeichnen auf Seite 17.

Das Signalflussdiagramm bestiicken

Signalprozessorblocke aus der Prozessor-Toolbox ziehen und im Signalflussdiagramm ablegen. Wenn
Frequenzweichen verwendet werden, sollten diese als erster Prozessortyp in die Konfiguration gesetzt
werden, gefolgt von Limitern, um Schaden an den Lautsprechern zu vermeiden. Fir weitere
Informationen siehe den Abschnitt Prozessoren hinzufligen auf Seite 20.

Verknupfte Gruppen erstellen

Die Taste STRG driicken und dabei klicken, um mehrere Prozessoren des gleichen Typs zu wahlen, die
als Gruppe gesteuert werden sollen, z.B. als Stereo-Paare, Lautsprechergruppen, Zonen usw. Es ist
auch mdoglich, Verstarkungsblécke zu verkniipfen, um den Gesamtpegel des Systems zu steuern. Fir
weitere Informationen siehe den Abschnitt Verknipfungen auf Seite 25.

Ausgangspegel einstellen

Auf die Ausgangsverstarkungsblocke  doppelklicken, um das Fenster ,Output Gain®
(Ausgangsverstarkung) einzublenden. Die Ausgangsverstarkung jedes Kanals um -30 dB reduzieren,
um zu verhindern, dass laute Signale durch das System laufen. Wenn Ausgangskanale miteinander
verknlpft sind, muss nur ein Fader betétigt werden, um alle verknUpften Kanéle auf den gleichen Pegel
einzustellen.

Signale von Eingangen zu Ausgéangen fuhren

Das Signal durch Klicken und Ziehen von Eingangsstreifen-Verbindungspunkten zu Ausgangsstreifen-
Verbindungspunkten durch den Matrixmischer fiihren. Fur weitere Informationen siehe den Abschnitt
Signalfuihrung auf Seite 18.

Prozessor-Parameter einstellen

Auf die einzelnen Prozessorblocke doppelklicken, um ihre Parameter-Fenster einzublenden. Beim
Arbeiten im Design-Modus ohne Verbindung zum Gerat kénnen vorlaufige Pegel eingestellt und spéter,
wenn der Anschluss zum Gerat besteht, Uberarbeitet werden. Fir weitere Informationen zum Arbeiten
mit Prozessoren siehe den Abschnitt ProzessorFunktionen auf Seite 31 sowie die Referenzabschnitte fur
die einzelnen Prozessoren.

Prozessoren zu Steuerungsanschlissen zuordnen

Jedes Preset muss eine Zuordnung zu den Steuerpin-Anschliissen haben, damit das Geréat die externen
Gerate erkennen kann, wenn das Preset aktiv ist. Das Fenster ,Control Pin“ o6ffnen und die
Kontrollkastchen neben den Ein- und Ausgangskandlen markieren, die von den einzelnen
Steuerungsanschliissen angesprochen werden. Fir weitere Informationen siehe den Abschnitt
Steuerpins auf Seite 76.

Prozessoren fir schreibgeschitzten Zugriff sperren

Dieser Schritt ist nur erforderlich, wenn die Sicherheit fir den Endbenutzer definiert werden soll. Dieser
Sicherheitstyp wird fur jeden Prozessor auf Presetebene gespeichert. Die Prozessoren wahlen, die vor
Anderungen durch den Benutzer geschiitzt werden sollen, und [Security>Level 2>Lock Selected]
(Sicherheit>Stufe 2>Sperre gewahlt) im Hauptmeni wahlen. Fir eine umfassende Erlauterung und
weitere Anweisungen siehe den Abschnitt Sicherheit individueller Prozessoren auf Seite 87.
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9.

10.

11.

Einrichtung

Preset benennen
Einmal mit der linken Maustaste irgendwo im

Preset Information E |

Informationsfeld in der Mitte der Steuerleiste klicken, um Hame: &, ditarium 1
das Dialogfeld .Preset Information” (Preset-
Informationen) einzublenden. Einen aus bis zu 15 Description: |Flavback with One Solo

Zeichen bestehenden Namen fiir das Preset und eine
Beschreibung eingeben und auf [OK] klicken. Fur
weitere Ein Preset oder eine Szene-Datei benennen auf

Seite 19 1[4 I Cancel Help

Das fertiggestellte Preset im Gerét speichern Abbildung © - Dialogfeld ,Preset Information*

Beim Arbeiten im Live-Modus wurde das Preset bereits (Preset-Informationen)

im Geréat gespeichert. Wenn im Design-Modus gearbeitet

wird, auf die Schaltflache [Store Preset] (Preset speichern) in der Steuerleiste des Hauptfensters klicken.
Fur weitere Informationen siehe den Abschnitt Preset-Verwaltung auf Seite 28. Ein Duplizieren dieses
Presets ist nur im Design-Modus mdglich. Einfach weiter auf die Schaltflache [Store Preset] klicken, um
Duplikate zu erzeugen, bis so viele Presets im Geréat gespeichert sind, wie benétigt werden.

Externe Steuerung aktivieren

Wenn die Steuerungsanschliisse vorher deaktiviert wurden, um den System-Prozessor vom Computer
steuern zu konnen, das Fenster ,Control Pins“ 6ffnen und die Steuerungsanschlisse wieder aktivieren,
nachdem das Erstellen und Bearbeiten der Presets beendet ist.

Sicherheit einrichten

Dies ist der letzte Schritt bei der Einrichtung des Gerats. Vor dem Fortfahren sollte der Abschnitt Sicherheit
auf Seite 85 grundlich gelesen werden. Die folgenden Anweisungen sind lediglich als Ubersicht des
Verfahrens anzusehen.

1.

Den System-Prozessor in den Live-Modus schalten

Zum Einstellen der Geratesicherheit muss der Live-Modus aktiviert sein. Im Design-Modus auf die
Schaltflache [Live Mode] in der Steuerleiste des Hauptfensters klicken.

Kennwort einstellen

Die Option [Security>Set Password] (Sicherheit>Kennwort einstellen) im Hauptmeni wahlen, woraufhin
das Dialogfeld ,Create Password“ (Kennwort erstellen) eingeblendet wird. Ein Kennwort eingeben, die
Taste TAB driicken und dann das Kennwort zur Bestatigung erneut eingeben. Auf [OK] klicken.

Benutzer-Zugangsstufe einstellen

Die Option [Security>Set Level] (Sicherheit>Stufe einstellen) im Hauptmeni wéahlen, woraufhin das
Dialogfeld ,Set Security* (Sicherheit einstellen) eingeblendet wird. Die gewlnschte Benutzer-
Zugangsstufe wahlen. Auf [OK] klicken.Informationen siehe den Abschnitt.
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Erstellen einer Konfiguration

ERSTELLEN EINER KONFIGURATION

Eine Konfiguration ist eine bestimmte Kombination von Signalfiihrungs-Verbindungen, Wahl und Anordnung von
modularen Prozessoren und Prozessor-Einstellungen. Eine Konfiguration wird im Signalflussdiagramm des
Hauptfensters erstellt und entweder als Preset im Gerat oder als Szene-Datei im Computer oder auf beide Weisen
gespeichert. Im System-Prozessor ist anfanglich einfach ein leeres Preset geladen, d.h. im Gerat bestehen keine
Signalfiihrungs-Verbindungen und es erfolgt keine Signalverarbeitung.

Signalfluss-Konfiguration

Um Audio-Informationen durch das Gerat zu leiten, missen Signale durch Verbinden von Mischpunkten von den
Eingangen zu den Ausgangen gefiihrt werden. In diesem Abschnitt werden die Grundlagen des Signalfluss-Designs
in der Benutzerschnittstelle des System-Prozessors erlautert.

Verstarkungsstruktur

Der System-Prozessor bietet Pegelregelung an drei Stufen des Signalflusses: Eingangsverstarkung,
Matrixmischer und Ausgangsverstarkung. Es ist wichtig, diese Verstarkungsstruktur zu verstehen, bevor
Signale durch das Gerat geleitet werden, um Schaden an den hinter dem System-Prozessor
angeschlossenen Geraten durch Gibermaiige Verstarkungspegel zu vermeiden. Die folgende Abbildung zeigt
eine Ubersicht der Verstarkungsstruktur des P4800.

Signalfuhrungs-Verbindung
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Abbildung 10 - Verstarkungsstruktur des P4800

Eingangsverstarkung

Durch Doppelklicken auf einen Eingangsblock wird das Fenster ,Input Gain processor (Eingangsverstarkungs-
Prozessor) eingeblendet, in dem Steller fur alle vier Kanale angezeigt werden. Dieses Fenster ermdglicht
Einstellung vor der Verarbeitung, es bietet Bedienelemente fur Skalierung, Verstarkung und Polaritat fur jeden
Kanal und gestattet die Zuweisung von benutzerdefinierten Namen fir die Eingangskanalstreifen.

Hinweis: Signalpegel, die die Eingangsschwelle des System-Prozessors (berschreiten, miissen
extern eingestellt werden, um eine Ubersteuerung der A/D-Wandler zu vermeiden.

Hier befindet sich der Eingangspunkt eines Signals in das Signalflussdiagramm. Hinter dem
Eingangsverstarkungs-Prozessor wird das Signal der Reihe nach durch die Prozessor-Steckplatze in seinem
Eingangskanalstreifen gefiihrt. Am Ende des Kanalstreifens erreicht das Signal einen Mischpunkt, von dem
es zu beliebigen oder allen Ausgéangen durch den Matrixmischer gefuhrt werden kann.

Matrixmischer

Nachdem ein Signal zum Mischpunkt eines Ausgangskanalstreifens gefuhrt wurde, tritt es in die
Matrixmischer-Stufe der Verstarkungsstruktur ein. Durch Doppelklicken auf einen Mischblock wird das
Fenster ,Matrix Mixer" eingeblendet, das fir jeden Ausgangskanalstreifen einen Fensterabschnitt enthalt.
Wenn Frequenzweichen Uber mehrere Ausgangskandle gesetzt werden, werden die Mischer-
Fensterabschnitte fur diese Kanadle zusammengefasst, um diese Konfiguration zu reflektieren. Dieses
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Fenster dient zum Einstellen der Polaritat und der relativen Pegel aller Eingénge, die zum gewahlten
Ausgangskanal gefuhrt werden.

Hinter dem Matrixmischer wird das Signal der Reihe nach durch die Prozessor-Steckplatze des
zugewiesenen Ausgangsstreifens gefuhrt. Am Ende des Kanalstreifens erreicht das Signal den
Ausgangsverstarkungsblock.

Ausgangsverstarkung

Dies ist die Endstufe der Pegelregelung im System-Prozessor. Durch Doppelklicken auf einen
Ausgangsverstarkungsblock wird das Fenster ,Output Gain processor” (Ausgangsverstarkungs-Prozessor)
eingeblendet. Es dient fur Einstellungen nach der Verarbeitung und verfigt dafiir iber Bedienelemente fur
Skalierung, Verstarkung und Polaritat sowie ein optionales 20-dB-Dampfungsglied fir jeden Kanal. In diesem
Fenster ist es auBerdem moglich, den Ausgangskanalstreifen benutzerdefinierte Namen zuzuweisen. Hinter
dem Ausgangsverstarkungs-Prozessor wird das Signal durch den Digital-Analog-Wandler zum Audio-
Ausgang gefuhrt.

Kanale stumm schalten

Es gibt verschiedene Mdoglichkeiten zum Stummschalten der Ein- und Ausgangskandle des System-
Prozessors. Stummgeschaltete Kandle werden im Signalflussdiagramm gekennzeichnet, wie in der
nachstehenden Tabelle dargestellt.

Eingénge 3 und 4 Ausgang vom Frequenzweichen-

VBT e Sl slee s zum Matrixmischer Matrixmischer Ausgangskanéle

IGAIN i

Alle Ein- oder Ausgange stumm schalten

= Auf das Steuerelement ,Mute All Inputs” (Alle Eingdnge stumm schalten) oder ,Mute All
Outputs” (Alle Ausgéange stumm schalten) an der Unterseite des Hauptfensters klicken.

= Die Mentoption [Processor>Mute All Inputs] (Prozessor>Alle Eingange stumm schalten)
oder [Processor>Mute All Outputs] (Prozessor>Alle Ausgange stumm schalten) wahlen.

= Das Gerat ausschalten, um automatisch alle Ausgange stumm zu schalten.

Einzelne Kanale stumm schalten

1. Das Fenster ,Input Gain“, ,Matrix Mixer* oder ,,Output Gain“ durch Doppelklicken auf den
entsprechenden Verstarkungs- oder Mischblock einblenden.

2. Auf die Stummschaltungs-Schaltflache fir den entsprechenden Kanal klicken.

3. Der Block wird durch ein rotes ,M* gekennzeichnet, um darauf hinzuweisen, dass er
stummgeschaltet ist.

Ein- und Ausgange kennzeichnen

Beim Erstellen einer neuen Szene-Datei sind Ein- und Ausgénge unbenannt, sie kénnen aber im Fenster ,Input
Gain“ und/oder ,Output Gain“ leicht mit Namen versehen werden. Kanal-Kennzeichnungen werden zusammen
mit dem Preset oder der Szene-Datei gespeichert, sodass Ein- und Ausgange fur jede Systemkonfiguration mit
benutzerdefinierten Namen versehen werden kdnnen.

So wird eine Kanal-Kennzeichnung geéndert:

Auf den Verstarkungsblock des Kanals doppelklicken.

Im Prozessor-Fenster das Namensfeld des Kanals suchen.

Klicken und den Mauszeiger Uber den Text ziehen, um ihn zu markieren.

Einen neuen Namen von bis zu flinfzehn Zeichen eingeben.

o > D PRE

Die Anderung wird wirksam, indem auf ein anderes Steuerelement geklickt oder das Fenster
geschlossen wird.
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Signalfiihrung

Im System-Prozessor ist es mdglich, ein Signal von jedem der vier Eingange zu beliebigen oder allen der
acht Ausgange zu fuihren. Damit Signale von den Eingangskanalstreifen zu den Ausgangskanalstreifen
gelangen, missen sie durch den Matrixmischer gefuihrt werden. Zum Verbinden der Eingange mit den
Ausgangen sind die nachstehend beschriebenen Methoden verfiigbar.

Verbindungen im Signalflussdiagramm herstellen

Fur einfache System-Konfigurationen lassen sich Eingdnge am besten mit Ausgéangen verbinden, indem die
Maus im Signalflussdiagramm eingesetzt wird.

Auf Mischpunkte klicken
1. Auf einen Eingangsmischpunkt klicken.

2. Der Cursor andert sich, was bedeutet, dass jetzt eine Ausgangsverbindung bestimmt werden
muss.

3. Auf einen Ausgangsmischpunkt klicken.

Tipp! Nach dem Klicken auf einen Eingangsmischpunkt kann die Verbindung mit der Taste
Esc aufgehoben werden, bevor auf einen Ausgangsmischpunkt geklickt wird.

Klicken und zwischen Mischpunkten ziehen
1. Auf einen Eingangsmischpunkt klicken und von dort zu einem Ausgangsmischpunkt ziehen.

2. Entlang des Signalwegs erscheint eine Verbindungslinie. Sie wechselt zu griin, wenn die
Verbindung zulassig ist.

3. Die Maustaste freigeben, um die Verbindung herzustellen.

Auf Eingangswahler klicken

1. Auf den nummerierten Eingangswahler eines Ausgangskanals fir den zugehérigen
Eingangskanal klicken.

2. Eine Verbindungslinie erscheint im Signalflussdiagramm zwischen den Mischpunkten und der
nummerierte Eingangswahler wird markiert.

Verbindungen im Matrixmischer-Fenster herstellen

Fur komplexere Konfigurationen mit vielen sich kreuzenden Verbindungslinien bietet das Matrixmischer-
Fenster eine prazisere Methode zum Verbinden von Eingangen mit Ausgangen.

1. Auf den Mischblock fur den Ausgang doppelklicken, mit dem die Verbindung hergestellt werden
soll.

2. An der linken Seite des Matrixmischer-Fensters auf die Eingangs-Schaltflache fur jeden
Eingangskanal klicken, der verbunden werden soll.

3. Eine Verbindungslinie erscheint im Signalflussdiagramm zwischen den Mischpunkten, und der
nummerierte Eingangswabhler wird fur jede aktive Verbindung markiert.

Verbindungen Idschen

= Auf eine Verbindungslinie klicken und die Taste ENTF driicken.

= Auf den Eingangswahler der entsprechenden Verbindung klicken.
Dadurch wird die Verbindung ausgeschaltet.

=  Auf eine Verbindungslinie klicken und das durch Klicken mit der rechten Maustaste
eingeblendete Kontextmeni verwenden.

= Zum Wahlen mehrerer Verbindungen beim Klicken die Taste STRG gedriickt halten.
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Ein Preset oder eine Szene-Datei benennen

Da bis zu 128 verschiedene Presets im System-Prozessor gespeichert werden kdnnen, ist es hilfreich, wenn
sie mit Namen und kurzen Beschreibungen versehen werden. Diese Angaben werden im Informationsfeld in
der Mitte der Steuerleiste des Hauptfensters angezeigt.

Informationsfeld

2 ! . Mame: Concert 1
WWI\E Lact Saved: 05-Mar-2001
Dieseription: Solo Mic with Stereo Mix Recall E‘ -
Preset save s || Open
'— Device — e

Abbildung 11 - Informationsfeld

Der hier eingegebene Name wird sowohl dem Preset beim Speichern der Konfiguration im Gerat als auch
der Szene-Datei beim Speichern im PC zugewiesen. Die Beschreibung wird auRerdem in allen Dialogfeldern
angezeigt, in denen Presets oder Szene-Dateien aufgelistet werden. Diese Angaben kdnnen jederzeit im
Live-Modus oder Design-Modus geandert werden.

Scene Information
So wird ein Preset oder eine Szene-Datei benannt:
M ame: IF‘rfmnce &
1. Einmal mit der linken Maustaste irgendwo im
Informationsfeld klicken. Deseription: |Steren Playback with One Solo
2. Das Dialogfeld ,Information“ wird eingeblendet.
3. Einen Namen mit bis zu 15 Zeichen und eine Beschreibung
mit maximal 80 Zeichen eingeben. ITI Carcel Help
Auf [OK] klicken.
Das Informationsfeld wird mit diesen Angaben aktualisiert. Abbildung 12 - Dialogfeld ,Scene Information*

(Szene-Informationen)

Prozessor-Konfiguration

Das Arbeiten mit Prozessoren kann auf zwei Ebenen erfolgen: auf der Konfigurationsebene im Signalflussdiagramm
und im individuellen Parameterfenster jedes einzelnen Prozessors, das durch Doppelklicken auf den Prozessorblock
aufgerufen wird. Dieser Abschnitt behandelt das Arbeiten mit Prozessoren im Signalflussdiagramm und erlautert die
Unterschiede zwischen den zwei Hauptkategorien von Prozessoren.

Prozessortypen

Im Signalflussdiagramm wird mit zwei Haupttypen von Prozessoren gearbeitet: feste und modulare. Der
wesentliche Unterschied zwischen diesen beiden Typen besteht darin, dass feste Prozessoren Bestandteile der
Verstarkungsstruktur des P4800 sind und daher in jeder Signalfluss-Konfiguration vorkommen. Modulare
Prozessoren sind die Prozessorblocke, die ausgewahlit und gemafR den Anforderungen des gewilnschten
Systems angeordnet werden.

Feste Prozessoren

Die Verstarkungs- und Mischblécke werden als feste Prozessoren angesehen, weil ihre Positionen auf den
Kanalstreifen permanent sind. Sie kdnnen nicht geléscht, versetzt, kopiert oder eingefiigt werden. Sie
kénnen jedoch verknipft werden und ihre Einstellungen lassen sich speichern und abrufen.

Modulare Prozessoren

Diese Prozessorblocke werden als modular bezeichnet, weil sie in jeden leeren Steckplatz (aulRer
Frequenzweichen und Verteiler) gesetzt und nach Wunsch versetzt, kopiert, eingeftigt und geléscht werden
kénnen. Jeder Prozessorblock im Signalflussdiagramm arbeitet vollstdandig unabhéngig. Wenn das
Prozessorparameter-Fenster eines modularen Prozessors geoffnet wird, werden nur die Einstellungen fir
diesen Block geandert, aufRer unter den nachstehenden Bedingungen.

= Der Block bildet die Halfte eines Stereopaares.
= Der Block gehort zu einer verknupften Gruppe.
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Prozessoren hinzufliigen

Jeder Kanalstreifen weist eine Reihe von leeren Steckplatzen auf, die jeden der modularen Prozessorblocke
aufnehmen koénnen. Mit der Ausnahme von Frequenzweichen und Verteilern bestehen keine
Einschrankungen, wo Prozessoren im Signalflussdiagramm angeordnet werden oder wie oft ein gegebener
Prozessor im gleichen Kanalstreifen eingesetzt wird. Leere Steckplatze zwischen Prozessoren haben keine
Auswirkungen auf den Signalfluss, sodass die Blocke in den Kanalstreifen nicht unmittelbar nebeneinander
liegen missen.

Wenn Prozessorblocke anfanglich dem Signalflussdiagramm hinzugefiigt werden, weisen sie
Werksvoreinstellungen auf. Die Einstellungen jedes einzelnen Prozessors kénnen im zugehdrigen
Parameterfenster individuell gedndert werden. Die Blocke behalten ihre Einstellungen bei, wenn sie in einen
anderen Steckplatz kopiert oder verschoben werden.

Leere Steckplatze bestiicken

Prozessorblécke kénnen mit der Prozessor-Toolbox oder durch Menlbefehle dem Signalflussdiagramm
hinzugefuigt werden. Diese Methoden werden nachstehend beschrieben.

Mit der Prozessor-Toolbox

Ein Prozessorblock kann mit der Maus aus der Prozessor-Toolbox enthommen werden. Der Mauszeiger
andert sich, um darauf hinzuweisen, dass der Block durch die n&chste Mausaktion in das
Signalflussdiagramm gesetzt wird. Das Aussehen des Cursors ist von seiner Position abhéangig, wie in der
nachstehenden Tabelle dargestellt.

Position, an der der Prozessor
angeordnet werden kann

Unzulassige Position fiir diesen
Prozessor

So wird ein Prozessorblock aus der Prozessor-Toolbox hinzugefugt:

= Die linke Maustaste klicken und halten, um einen Prozessorblock aus der Prozessor-Toolbox
zum Signalflussdiagramm zu ziehen. Die Maustaste freigeben, um den Block an der jeweiligen
Cursorposition anzuordnen.
- ODER -

=  Einmal auf einen Prozessorblock in der Prozessor-Toolbox klicken und dann auf den
vorgesehenen leeren Steckplatz im Signalflussdiagramm klicken.

Tipp! Wenn ein Prozessorblock, nachdem in der Prozessor-Toolbox darauf geklickt wurde,
doch nicht in das Signalflussdiagramm gesetzt werden soll, kann der Vorgang durch
Dricken der Taste Esc abgebrochen werden.

Mit einem Menibefehl

Es ist moglich, dem Signalflussdiagramm Prozessoren hinzuzufiigen, ohne die Prozessor-Toolbox zu 6ffnen,
indem das Hauptmeni oder das Uber Klicken mit der rechten Maustaste zugangliche Kontextmeni
verwendet wird, wie nachstehend beschrieben.

So wird ein Prozessorblock tiber das Meni hinzugefugt:
1. Durch Klicken einen leeren Steckplatz wéhlen.

2. Mit der rechten Maustaste klicken, um das Kontextmenu einzublenden, und daraus einen
Prozessor wahlen.

- ODER -

3. Die Option [Processor>Add] (Prozessor>Hinzufuigen) in der Hauptmenileiste verwenden.

Ein weiterer Vorteil in der Verwendung eines Meniibefehls zum Positionieren von Prozessorblécken besteht
darin, dass der gleiche Prozessortyp mit nur einem Menubefehl in mehrere Steckplatze gesetzt werden
kann.
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So werden mehrere Prozessorblocke hinzugefugt:

1.
2.

Durch Gedruckthalten der Taste STRG und Klicken mehrere leere Steckplatze wahlen.

Mit der rechten Maustaste klicken, um das Kontextment einzublenden, und einen
Prozessor wahlen, der dann in jeden gewahlten Steckplatz gesetzt wird.

- ODER -

Die Option [Processor>Add] (Prozessor>Hinzufligen) in der Hauptmeniileiste verwenden.

Stereo-Prozessoren

Stereo-Prozessoren werden auf &hnliche Wiese wie die anderen modularen Prozessorblécke in das
Signalflussdiagramm gesetzt. Jeder der Stereokanéle erscheint jedoch als ein separater Block. Durch
Doppelklicken auf einen der Blécke wird das Parameterfenster fiir beide Kanale eingeblendet.

Jeder der folgenden dynamischen Prozessoren kann als Stereopaar fungieren:

Blockname Beschreibung

ST COMP Stereo-Kompressor

SFT ST COMP  Stereo-Kompressor - Soft-Knee-Option
ST LIM Stereo-Limiter

SFT ST LIM Stereo-Limiter - Soft-Knee-Option

So wird ein Stereo-Prozessorblock aus der Prozessor-Toolbox hinzugefugt:

1.

Auf einen Prozessorblock klicken.

Wenn ein Stereo-Prozessor aus der Prozessor-Toolbox gewahlt wird, sieht der Cursor etwas anders aus
als fur andere Prozessoren, wie in der folgenden Tabelle dargestellt.

2.

Position, an der der erste Kanal des Stereo-
Prozessors angeordnet werden kann

Position, an der der zweite Kanal des Stereo-
Prozessors angeordnet werden kann

Den ersten Kanal des Stereopaars hinzufiigen.
Die linke Maustaste klicken und halten, um einen Prozessorblock aus der Prozessor-Toolbox
zum Signalflussdiagramm zu ziehen. Die Maustaste freigeben, um den ersten Prozessorkanal
an der jeweiligen Cursorposition anzuordnen.
- ODER -
Einmal auf einen Prozessorblock in der Prozessor-Toolbox klicken und dann auf den
vorgesehenen leeren Steckplatz im Signalflussdiagramm klicken.

Der Cursor andert sich, um darauf hinzuweisen, dass der zweite Kanal des Prozessors
positioniert werden muss.

Auf den vorgesehenen Steckplatz klicken, um den zweiten Stereokanal hinzuzufligen.

So wird ein Stereo-Prozessor Uber das Menu hinzugefugt:

1.

Die Taste STRG gedriickt halten und durch Klicken leere Steckplatze in zwei verschiedenen
Kanalen wahlen.

Mit der rechten Maustaste klicken, um das Kontextmenu einzublenden, und beide Kanéle
des Stereopaars positionieren.

- ODER -

Die Option [Processor>Add] (Prozessor>Hinzufligen) in der Hauptmenileiste verwenden.
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Frequenzweichen und Verteiler

Da Frequenzweichen ausschlie3lich Ausgangsprozessoren sind, kdnnen sie auch nur in Ausgangskanalstreifen
positioniert werden. Sie kénnen wie andere Prozessorblocke in Ausgangsstreifen hinzugefligt werden, dabei
muss jedoch folgendes bertcksichtigt werden:

=  Eine Frequenzweiche erstreckt sich nach unten Uber die angegebene Anzahl von Ausgangen.
Daher muss ein Kanalstreifen gewahlt werden, unter dem noch gentigend viele Ausgéange
vorhanden sind.

= Ein Frequenzweichenblock kann nur nebeneinander liegende Ausgange benutzen.

=  Frequenzweichen kénnen an keinen Ausgangsstreifen tUberlappen.

= Fir alle Ausgange, die von der Frequenzweiche belegt werden, mit Ausnahme des obersten
Kanalstreifens verschwinden die Mischpunkte.

= Von Ausgangen unter dem obersten Kanalstreifen verschwinden die Prozessor-Steckplatze
links von der Frequenzweiche.

=  FUr Verteiler gelten die gleichen Auswirkungen auf den Signalfluss und Einschréankungen wie fur
Frequenzweichen.

Wenn die Konfiguration Frequenzweichen erfordert, sollten sie aufgrund dieser Uberlegungen dem
Signalflussdiagramm hinzugefiigt werden, bevor Mischpunkte verbunden und andere Prozessoren den
Ausgangskanalstreifen hinzugefiigt werden.

Ducker

Der Ducker sollte nur auf dem Eingangskanalstreifen abgelegt werden, der das Durchsagesignal tragt. Das
System gestattet nicht das Ablegen eines Duckers auf einem Ausgangsstreifen.

Prozessoren ersetzen

Nur jeweils ein Prozessorblock kann einen gegebenen Steckplatz belegen. Um einen vorhandenen Prozessor
durch einen anderen zu ersetzen, muss zuerst der vorhandene aus dem Steckplatz geldscht und dann der neue
Prozessor mit einer der oben beschriebenen Methoden hinzugefiigt werden.

DSP-Ressourcen verwalten

Obwohl der P4800 Uber ausreichend Verarbeitungsleistung fur viele Anwendungen verfigt, ist es moglich,
das Signalflussdiagramm mit mehr Prozessorblécken zu bestiicken, als die DSP-(Digital Signal Processing)-
Ressourcen des Gerats handhaben kénnen. In diesem Abschnitt wird in allgemeiner Weise erlautert, wie der
System-Prozessor die Signalverarbeitungserfordernisse einer Konfiguration verwaltet. AuBerdem enthalt er
Ratschlage, wie die DSP-Ressourcen optimal ausgenutzt werden kénnen.

Ressourcenzuweisung

Indem ein Prozessorblock auf einen Kanalstreifen gesetzt wird, werden ihm die DSP-Ressourcen zugewiesen, die
er benétigt, um mit maximaler Kapazitat zu arbeiten. Aus diesem Grund werden so viele verschiedene
Ausfiihrungen der gleichen Prozessorblocktypen bereitgestellt, damit nur der Umfang an Verarbeitung gewahlt
werden kann, der fiir ein gegebenes Modul benétigt wird. Beim Erstellen einer einfachen Konfiguration ist es nicht
bedeutsam, wie viel DSP-Kapazitéat verbraucht wird. Wenn die Konfiguration jedoch komplizierter wird, ist es
wichtig solche Prozessorblécke zu verwenden, die nur die minimalen Verarbeitungsressourcen, die fir die
jeweilige Aufgabe benétigt werden, in Anspruch nehmen.

Wenn beispielsweise ein parametrischer Equalizer mit zehn Bandern auf einen Kanalstreifen gesetzt wird,
wird dadurch die Verarbeitungsleistung zugewiesen, die von allen zehn Filtern benétigt wird, auch wenn
tatsachlich nur vier davon eingesetzt werden. In diesem Fall ware der PEQ5 die optimale Wahl.

Verzégerungsspeicher

Der System-Prozessor verfiigt Uber einen Zwischenspeicher fur bis zu 20 Sekunden Verzdgerungszeit, die
unter jeder beliebigen Kombination von Verzégerungsprozessoren aufgeteilt werden kann. Wie bei der
Zuweisung der DSP-Ressourcen wird der Verzégerungsspeicher den Prozessorblocken gemaR der
maximalen Verzogerungszeit, die im Blocknamen angegeben ist, zugewiesen.

Wenn zum Beispiel eine Verzégerung von 45 Millisekunden benétigt wird, ist kein 2-Sekunden-Delay
erforderlich, weil das 150-ms-Delay vollkommen ausreicht. Auch wenn beide Prozessoren auf den
gleichen Verzogerungswert eingestellt werden, belegt der DLY 2s volle zwei Sekunden im
Verzégerungsspeicher.
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Hinweis: Der Verzogerungsspeicher sollte nicht mit den DSP-Systemressourcen verwechselt werden.
Jede Verzégerung verbraucht die gleiche DSP-Kapazitdt unabhangig von der Lange
ihrer maximalen Verzégerungszeit.

Belegungsanzeigen

Diese Anzeigen an der Unterseite des Hauptfensters geben an, wie viel DSP-Ressourcen und
Verzogerungsspeicher von der jeweiligen Konfiguration verbraucht wird, sodass die Auswahl der
Prozessoren dementsprechend erfolgen kann. Wenn ein Prozessorblock dem Signalflussdiagramm
hinzugefiigt oder daraus entfernt wird, berechnet die DSP-Anzeige sofort die Systemressourcen, die von der
neuen Prozessorkonfiguration verbraucht werden, und zeigt diese an.

Hinweis: Angezeigt wird der Prozentanteil der Gesamtressourcen, die ein Preset verbraucht, und
nicht die von einzelnen Prozessoren verbrauchten Ressourcen.

Da der P4800 die digitale Signalverarbeitung mit mehreren Prozessor-Chips durchfiihrt, werden die verfligbaren
Ressourcen unter Umsténden nicht prazise auf der DSP-Anzeige dargestellt. Wenn angezeigt wird, dass 20 %
verfugbar sind, aber kein Prozessor hinzugefiigt werden kann, kann der Grund darin liegen, dass die verfligbaren
Ressourcen auf mehreren Prozessor-Chips verteilt und nicht zusammenhéangend verflgbar sind. Der folgende
Abschnitt Giber DSP-Optimierung enthalt einige Ratschlage fir solche Falle.

Hinweis: P4800 Einheiten mit einer Seriennummer, die mit dem Buchstaben N oder hdher
beginnt, ermdglichen die Speicherung jeder beliebigen Szene, die im Design-Modus
erstellt werden kann. Fur &ltere Einheiten (aus Seriennummern, die mit L oder M
beginnen, ersichtlich) sollten Szenen, die gemal DSP-Anzeige weniger als 87 %
belegen, verwendbar sein. Da die Ressourcen allerdings Uber mehrere Prozessorchips
verteilt sind, stellt die Anzeige die verflgbare Kapazitat des digitalen Signalprozessors
eventuell nicht prazise dar. Es ist moglich, dass ein alteres Gerat eine Szene nicht
verwenden kann, selbst wenn die DSP-Anzeige weniger als 87 % anzeigt. Dies kann
vorkommen, wenn lhre Szene mehrere DFR5-, DFR10- und/oder GEQ30-Blocke belegt.
Um sicherzustellen, dass eine Szene fir einen P4800 mit einer Seriennummer, die mit L
oder M beginnt, verwendbar ist, sollten Sie das Gerat anschlieRen und auf den Live-
Modus schalten. Im Live-Modus sind die in der Prozessor-Toolbox aufgefiihrten DSP-
Anzeigen- und Prozessorbelegungsprozentsatze skaliert, um die Geratekapazitat genau
wiederzugeben.

Ratschlage zur DSP-Optimierung

Wenn beim Versuch, dem Signalflussdiagramm einen
Prozessor hinzuzufiigen, die in Abbildung 13 dargestellte kil ]|
Meldung angezeigt wird, kann die Konfiguration optimiert @

Cannot complete operation. DSP rezources

werden, um Ressourcen freizustellen und den Prozessor e
BeRCEEde0.

anschlieBend hinzuzufiigen. Es folgen Ratschlage zur
Optimierung des DSP-Verbrauchs einer Konfiguration.

=  Prozessorblécke von einer Seite des Matrixmischers zur
anderen versetzen, beginnend mit dem Prozessor, der
den groRten Prozentanteil der Systemressourcen belegt .
(siehe Annhang B: auf Seite 102 fiir Einzelheiten zum Help |
DSP-Verbrauch der Prozessoren).

Wenn beispielsweise ein DFR10 an der Abbildung 13 - Meldung Uber DSP-Ressourcen
Ausgangsseite des Signalflussdiagramms
vorhanden ist, diesen zur Eingangsseite und umgekehrt versetzen.

= Mehrere Equalizer im gleichen Signalweg nach Mdglichkeit zu einem Modul zusammenfassen.

Zum Beispiel verbrauchen zwei PEQ3 mehr DSP-Ressourcen als ein PEQ7. AulRerdem sind
alle PEQ auch mit Filtern mit steilflankigen und Kuhschwanz-Charakteristika verfligbar, um die
DSP-Ressourcen zu schonen. Das einzige besondere Merkmal des CUT/SHELF-Moduls ist die
24-dB/Okt.-Flanke. Wenn dieses Merkmal nicht benétigt wird, besteht kein Grund, dass der
Filter mit steilflankigen und der Filter mit Kuhschwanz-Charakteristika in einem separaten Modul
von einem anderen PEQ im gleichen Signalpfad vorhanden sind.
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= Mehrere Delays im gleichen Signalweg nach Méglichkeit zu einem Modul zusammenfassen.

Obwohl durch die Verwendung von zwei DLY5ms, wenn sieben Millisekunden Verzégerung
bendotigt werden, Verzégerungsspeicher eingespart wird, wird doppelt soviel DSP-Kapazitat
als bei Verwendung eines DLY150ms verbraucht.

= Nach Mdoglichkeit Prozessoren an der Eingangsseite des Matrixmischers und nicht an der
Ausgangsseite hinzufiigen.

=  Prozessoren von nicht benutzten Kanéalen entfernen.

= Verteiler benutzen, um identische Signalverarbeitung in mehreren Ausgangskanélen
zusammenzufassen.

= Einen PEQ10 anstelle eines GEQ30 benutzen. In den meisten Fallen werden nicht alle dreilig Filter
verwendet, und der PEQ10 verbraucht weniger als die halbe DSP-Kapazitat.

= DFR durch parametrische EQ ersetzen, nachdem Riickkopplungen aus dem System entfernt wurden.

Wenn beispielsweise in einer Konfiguration mehrere DFR in mehreren Eingangen fiir eine bessere
Verstarkungsleistung vor dem Ruickkopplungseinsatz bendtigt werden, konnte anféanglich in jedem
Eingang ein DFR verwendet werden, um Rickkopplungen zu vermeiden. Nach dem Anwenden der
Filter die DFR-Filter kopieren und in einen PEQ einfligen, dann den DRF I6schen. Dieser Vorgang
kann fir jeden Eingang durchgefiinrt werden, sodass zuletzt nur ein DFR im kritischsten
Lautsprecherausgang fur automatische Erkennung von Rickkopplung verbleibt.

Hinweis: Es ist moglich, dass in der DSP-Anzeige nach der Optimierung der Konfiguration keine
Anderung ersichtlich ist, weil der Gesamtanteil der verfiigharen Kapazitat gleich
geblieben ist. Die Ressourcen wurden lediglich umgeschichtet, sodass sie besser
ausgenutzt werden kénnen.

Kopieren und Einflgen

Die herkdbmmlichen Befehle fur Kopieren, Ausschneiden und Einfigen funktionieren nur bei den modularen
Prozessorblécken. Damit bieten sie eine praktische Méglichkeit zum Duplizieren von Prozessorblécken
mitsamt ihren Einstellungen in andere Kanéle.

So wird ein Prozessorblock kopiert und eingefigt:
1. Einen Prozessorblock durch einmaliges Klicken mit der linken Maustaste wéahlen.

2. Den Kopierbefehl mit einer der folgenden Methoden wahlen.
= Mit der rechten Maustaste klicken, um das Kontextmeni einzublenden.
= [Edit>Copy] (Bearbeiten>Kopieren) aus dem Hauptmenul wéhlen.
=  STRG+C auf der Tastatur betatigen.

Einen leeren Steckplatz wahlen.

4. Den Einfugbefehl mit einem der Menis oder STRG+V wéhlen.

Hinweis: Dieses Befehle funktionieren nicht bei Mehrfachwahl.

Aus Steckplatzen l6schen

Modulare Prozessorblécke lassen sich auf einfache Weise aus einer Konfiguration entfernen, ohne andere
Bereiche des Signalflusses zu beeintrachtigen.

So wird ein Prozessorblock geldscht:
1. Den Prozessorblock durch einmaliges Klicken mit der linken Maustaste wahlen.

2. Den Loschbefehl mit einer der folgenden Methoden wahlen.
= Mit der rechten Maustaste klicken, um das Kontextmeni einzublenden.
= [Edit>Delete] (Bearbeiten>Ldschen) aus dem Hauptmeni wahlen.
= Die Taste ENTF drlcken.
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Verknipfungen

Mehrere Prozessorblocke des gleichen Typs konnen miteinander verknlpft werden, um sie gemeinsam zu
steuern. Anderungen, die im Prozessorparameter-Fenster eines beliebigen Blocks einer Verknupfungsgruppe
vorgenommen werden, andern gleichzeitig die Einstellungen jedes anderen Blocks in dieser Gruppe. Es gibt
jedoch einige Aktionen, die auch in verkniipften Blécken unabhangig funktionieren.

= Loschen, Kopieren, Ausschneiden und Einfigen

= Verschieben eines Blocks zu einem anderen Steckplatz oder Kanalstreifen

=  Benennen des Prozessorparameter-Fensters

Feste Prozessoren in der gleichen Stufe der Verstarkungsstruktur lassen sich auch zu einer Gruppe
zusammenfassen, wodurch die Pegelsteller der gruppierten Kanéle synchronisiert werden. Beispielsweise kbnnen
zwei Eingangskanal-Verstarkungsblécke zu einer Gruppe zusammengefasst werden, um sie als Stereopaar zu
steuern. Es ist auch moglich, alle Ausgangs-Verstarkungsblocke zu verknipfen, um die Pegel der
Ausgangskanéale zusammen von einem Steller zu steuern.

Hinweis: Nur Prozessoren des exakt gleichen Typs konnen miteinander verknupft werden.

Eine verknupfte Gruppe erstellen

Beim Erstellen einer Verknupfungsgruppe werden alle Prozessoren in der Gruppe auf die gleichen
Einstellungen synchronisiert. Wurden vor dem Erstellen der verkniipften Gruppe bereits Einstellungen fir
einen der Prozessoren spezifiziert, kann dieser Prozessor beim Verknupfen als Quelle vorgegeben werden,
sodass diese Einstellungen auf die anderen Prozessorblécke ,vererbt® werden. Sollen dagegen frihere
Prozessor-Einstellungen wegfallen, kdnnen die Werksvoreinstellungen als anfangliche Quelle gewahlt
werden. Nach dem Erstellen der Verkniipfungsgruppe wirken sich Anderungen der Einstellungen in einem
der verknipften Blocke auf alle anderen Blocke der gleichen Gruppe aus.

So wird eine verknupfte Gruppe erstellt: Create Link Group |

1. Durch Gedriickthalten der Taste STRG und Klicken ]
Lirtk. e |L1
mehrere Prozessorbldcke wahlen. i SIEKR EmE

. . Chi far initial settings :
2. [Processor >Link>New Link Group] F:;ZT Sg:fr:jlt;r e

(Prozessor>Verknupfen>Neue Verknupfungsgruppe) aus e e R LT
dem Hauptmeni oder [Link>New Link Group] Lirniter in Left Lo [1]
(Verknuipfen>Neue Verknipfungsgruppe) aus dem durch Limiter in Right Lo (1]
Klicken mit der rechten Maustaste eingeblendeten
Kontextmenu wahlen.

3. Das Dialogfeld ,Create Link Group*
(Verknupfungsgruppe erstellen) wird eingeblendet.

4. Einen aus zwei Zeichen bestehenden Namen fir die

VerknlUpfungsgruppe eingeben. oK I Cemecl Help
5. Eine Quelle fiir die anfanglichen Einstellung der
Verknupfungsgruppe wahlen. Abbildung 14 - Dialogfeld ,Link Group*
(Verknupfungsgruppe)

6. Auf [OK] klicken, um die Einstellungen zu bestéatigen.

Der aus zwei Zeichen bestehende Name der Verknipfungsgruppe erscheint sowohl im Prozessorblock im
Signalflussdiagramm als auch in der Verkniipfungsanzeige unten rechts im Prozessorparameter-Fenster, wie
in der nachstehenden Tabelle dargestellt.

Prozessorparameter-Fenster Signalflussdiagramm

rd E

Hinweis: Prozessoren kdnnen jeweils nur zu einer Verknipfungsgruppe gehoren.

SHURE® System-Prozessor P4800 Software-Bedienungsanleitung Seite 25 von 108



Erstellen einer Konfiguration

Zu einer VerknUpfungsgruppe hinzufigen

Prozessorblécke kdnnen einer bestehenden Verknupfungsgruppe hinzugefugt werden, wenn sie von genau
dem gleichen Typ und mit keiner anderen Gruppe verkniUpft sind. Jeder Prozessor, der einer
VerknlUpfungsgruppe hinzugefugt wird, erhalt die jeweiligen Einstellungen der Gruppe.

So werden Blocke einer bestehenden

Verkntpfungsgruppe hinzugefugt:

1. Durch Klicken einen Prozessorblock wahlen oder mit
STRG+KIlicken mehrere Blocke wahlen.

2. [Processor >Link>Add To]
(Prozessor>Verknipfen>Hinzufligen) aus dem
Hauptment oder [Link>Add To]
(Verknlipfen>Hinzufiigen) aus dem durch Klicken mit der
rechten Maustaste eingeblendeten Kontextmen( wahlen. ITI

3. Das Dialogfeld ,Add to Link group” (Zur
Verknupfungsgruppe hinzufiigen) wird eingeblendet. Dort
werden nur die Verkniipfungsgruppen aufgelistet, die den
gleichen Prozessortyp wie der gewabhlte Block enthalten.

Link. group names:

Cancel Help

Abbildung 15 - Dialogfeld ,Add to Link Group*“
(Zur Verknupfungsgruppe hinzuftigen)
4. Eine Verknipfungsgruppe wahlen.
Auf [OK] klicken.

Verknupfung von Prozessorblécken aufheben

Prozessorblocke koénnen ohne Auswirkungen auf die anderen verknupften Blécke aus einer
VerknlUpfungsgruppe entfernt werden. Es ist auch méglich, eine Verknipfungsgruppe aufzulésen, indem die
VerknUpfung aller Blocke in der Gruppe aufgehoben wird.

So werden Blocke aus einer bestehenden Verknupfungsgruppe entfernt:
1. Durch Klicken einen Prozessorblock wahlen oder mit STRG+Klicken mehrere Blocke wahlen.

2. [Processor>Link>Unlink] (Prozessor>Verknupfen>Verknupfung aufheben) aus dem Hauptmend
oder aus dem durch Klicken mit der rechten Maustaste eingeblendeten Kontextmeni wéhlen.

Hinweis: Eine Verknupfungsgruppe muss mindestens zwei Prozessorblécke enthalten. Wenn alle
Blocke bis auf einen aus einer VerknUpfungsgruppe entfernt werden, wird die Gruppe
dadurch vollstéandig aufgelost.

Umgehen

Jeder modulare Prozessorblock kann im Hauptfenster Umgangener Block

umgangen werden. Dadurch ist es moglich, den Signalweg
zu Uberprifen, wahrend ein bestimmter Prozessor

voribergehend herausgenommen wird. Umgangene W [ r
Blocke werden im Signalflussdiagramm durch ein gelbes 4 5
Zeichen markiert.

So wird die Umgehung ein- und ausgeschaltet: Abbildung 16 - Umgangener Prozessorblock

1. Durch Klicken einen Prozessorblock wahlen oder mit
STRG+KIlicken mehrere Blocke wahlen.

2. Die Umgehung mit einer der folgenden Methoden aktivieren:
=  STRG+B auf der Tastatur betétigen.

= [Processor>Bypass Selected] (Prozessor>Umgehung gewahlt) im Hauptmeni wahlen.
= Mit der rechten Maustaste klicken, um das Kontextmeni einzublenden.

Hinweis: Frequenzweichen und Verteiler kbnnen nicht umgangen werden.
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SPEICHERN EINER KONFIGURATION

Eine Konfiguration kann nach dem Erstellen im Computer als Szene-Datei oder im P4800, wenn er angeschlossen
ist, als Preset gespeichert werden. Im Live-Modus wird eine erstellte Konfiguration direkt in das jeweils getffnete
Preset geschrieben. Sie kann jederzeit durch Klicken auf die Schaltflache [Save As] (Speichern unter) in der
Steuerleiste des Hauptfensters im PC gespeichert werden.

Szene-Dateien

Es ist moglich, eine ganze Bibliothek von Signalfluss-Konfigurationen in der System-Prozessor-Software zu erstellen,
ohne am Gerét angeschlossen zu sein. Konfigurationen, die im PC als Szene-Dateien gespeichert werden, kénnen
spater abgerufen, Uberarbeitet und als Presets zum Gerat Ubertragen werden. Szene-Dateien werden mit der
Dateinamenerweiterung ,.scn” gespeichert.

Eine neue Szene speichern

Wenn kein Anschluss zum Geréat besteht, wird jede neue Signalfluss-Konfiguration als Szene-Datei im
Computer gespeichert.

So wird eine neue Szene-Datei gespeichert:

1. Im Hauptfenster [File>Save As Scene File] (Datei>Als Szene-Datei speichern) im Hauptmeni
wabhlen oder auf die Schaltflache [Save As] (Speichern unter) in der Steuerleiste klicken.

Das Dialogfeld ,Save Scene As* (Szene speichern unter) wird eingeblendet.
Zum Laufwerk und Verzeichnis fur die neue Datei gehen.

Einen Dateinamen und auf Wunsch eine Beschreibung eingeben.

ok~ DN

Auf [Save] (Speichern) Klicken.

Hinweis: Szene-Dateien fur andere Shure Digitalsignalprozessor-Gerate wie z.B. DFR11EQ
oder DP11 verwenden die gleiche Dateinamenerweiterung .SCN. Daher sollten Szene-
Dateien fUr verschiedene Geratetypen in separaten Verzeichnissen gespeichert werden.

Beschreibungsfeld verwenden

Der optionale Eintrag in das Beschreibungsfeld hilft bei der Identifizierung von Szene-Dateien beim Offnen.
Die Beschreibung der Szene-Datei wird beim Speichern der Szene-Datei als Preset im Gerét in die Preset-
Beschreibung kopiert.

Szene-Dateien Uberarbeiten

Wenn in einer bestehenden Szene-Datei Anderungen vorgenommen werden, kénnen diese unter einem
anderen Dateinamen oder durch Uberschreiben der vorherigen Version gespeichert werden.

So wird eine Szene-Datei Uiberarbeitet:

1. Im Hauptfenster [File>Open Scene File] (Datei>Szene-Datei &ffnen) im Hauptment wahlen oder
auf die Schaltflache [Open] (Offnen) in der Steuerleiste klicken.

Das Dialogfeld ,Open Scene” (Szene 6ffnen) wird eingeblendet.
Zum Laufwerk und Verzeichnis der Szene-Datei gehen, die getffnet werden soll.
Auf die Datei klicken, um sie zu wéhlen, und dann auf die Schaltflache [Open] klicken.

Die gewiinschten Anderungen vornehmen.

o a0k wbd

[File>Save As Scene] (Datei>Als Szene speichern) im Hauptmeni wahlen oder auf die
Schaltflache [Save As] (Speichern unter) in der Steuerleiste klicken.

Das Dialogfeld ,Save Scene As* (Szene speichern unter) wird eingeblendet.

Auf den urspriinglichen Dateinamen klicken, um ihn zu wahlen, und dann auf [Save] (Speichern)
klicken.

9. Ein eingeblendetes Dialogfeld fordert zur Bestatigung auf, dass die vorherige Szene-Datei
Uberschrieben werden soll.

10. Auf [Yes] (Ja) klicken, um die Datei zu Gberschreiben.
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Preset-Verwaltung

Der System-Prozessor kann mindestens 16 und, abhangig von ihrer Komplexitat, bis zu 128 Presets in seinem
Speicher unterbringen. Im Gerét gespeicherte Presets kdnnen umbenannt, geléscht oder zusammen gesichert
werden.

Ein Preset im Geréat speichern

Wenn der Anschluss zum Gerat besteht, kénnen im Design-Modus neue Signalfluss-Konfigurationen im
Geréat als Presets gespeichert oder vorhandene Szene-Dateien getffnet und im Geréat gespeichert werden.
So wird ein Preset im Geréat gespeichert: S elect Devices |
1. Im Hauptfenster [File>Store As Preset] (Datei>Als
Preset speichern) im Hauptmenii wéhlen oder im Available Devices:
Design-Modus auf die Schaltflache [Store Preset]
(Preset speichern) in der Steuerleiste klicken.

2. Das Dialogfeld ,Select Devices" (Gerate wéahlen) wird
eingeblendet.

3. Die Wahl aus der Liste der verfigbaren Geréate
vornehmen und auf [Connect] (Verbinden) klicken.

Connect I Cancel Help

Abbildung 17 - Dialogfeld ,Select Devices*
(Gerate wahlen)

Presset Name - [Lecture Preset Number : |3 4. Das Dialogfeld ,Store Preset"

Preset Mum... | Freset Mame | Date | Live Preset Mode | erd eingeblendet'

Preset 1 Auditarium 1 (054 ar-2001 Live i )

Preset 2 Auditarium 2 05 ar-2001 4. Einen Preset-Namen von bis zu
finfzehn Zeichen eingeben.

5. Eine Preset-Nummer eingeben
oder die Voreinstellung
verwenden.

6. Eine Beschreibung eingeben,
falls gewiinscht, um den Inhalt
des Presets bei
anschlieBenden Einstellungen
besser identifizieren zu kénnen.

Devies [ID 15, Paz0n — swe 7. Auf [Store] (Speichern) klicken.
Description: |5 oio Input Only ;I Cancel |
_ILI Help |
A 2

Abbildung 18 - Dialogfeld ,Store Preset”
(Preset speichern)
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Nachdem ein Preset im Gerét gespeichert wurde, kdnnen sein Name und seine Beschreibung im

Live-Modus geandert werden.

So wird ein Preset umbenannt:

1. Auf die Schaltflache [Live Mode] in der Steuerleiste klicken.

2. Das Preset, das umbenannt werden soll, aus dem
Pulldown-Meni im Informationsfeld in der Steuerleiste

wahlen.

3. Das Hauptfenster schaltet in den Vorschau-Modus fiir das

gewabhlte Preset.

4. Auf die Schaltflache [Load] (Laden) in der Steuerleiste
klicken, um das Preset in den Live-Modus zu holen.

5. Einmal irgendwo im Informationsfeld klicken.

6. Das Dialogfeld ,Rename Preset” (Preset umbenennen)

wird eingeblendet.

Preszet Information [ x| |

Auditorium 1

Marme:

Description: |Flayback with One Sala

Cancel Help

o]

Abbildung 19 - Dialogfeld ,Rename Preset”
(Preset umbenennen)

7. Den neuen Namen und/oder die neue Beschreibung eingeben.

8. Auf [OK] klicken.

Ein Preset l6schen

Im Design-Modus konnen Presets, die nicht
mehr benétigt werden, aus dem Gerat geloscht
werden.

So wird ein Preset geldscht:

1. Auf die Schaltflache [Design Mode] in der
Steuerleiste klicken.

2. [File>Delete Preset] (Datei>Preset I6schen)
wahlen.

3. Das Dialogfeld ,Select Devices" (Gerate
wabhlen) wird eingeblendet.

4. Die Wahl aus der Liste der verfligbaren
Gerate vornehmen und auf [Connect]
(Verbinden) klicken.

5. Das Dialogfeld ,Delete Preset” (Preset
I6schen) wird eingeblendet.

6. Das Preset wahlen, das geléscht werden
soll, oder mit UMSCHALTTASTE+KIicken
mehrere Presets wahlen.

7. Auf [Delete] (Loschen) klicken.

Select Preset to delete E3
Preset Murnber : |2

| SavedtoPC?
es

TET

Preset Mame : IAuditolium 2

| Preset Mum... * | Preset Mame | Date | Live Prezet Mode |
Preset 1 Auditorium 1 17-Oct-2000
! 2 i)

Pr Auditarium 2 2

< [
{ID# 15, P4a00 1 =l Delete |

;I Cancel |
o e |

e

Device:

Description: \jreo Plapback. with Autamix
A

Abbildung 20 - Dialogfeld ,Delete Preset* (Preset I6schen)

Hinweis:

Das jeweils gedffnete Preset kann nicht geldscht werden. Um dieses Preset zu l6schen,
muss vorher ein anderes Preset gedffnet werden.
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Alle im Gerat gespeicherten Presets kdnnen in einer einzelnen Archivierungsdatei gesichert und spater wieder
hergestellt werden. Datensicherung und Wiederherstellung sind nur im Design-Modus méglich.

So werden alle Presets im Geréat gesichert:

1. Auf die Schaltflache [Design Mode] in der
Steuerleiste klicken.

2. [File>Backup Device] (Datei>Geréate-
Datensicherung) aus dem Hauptmeni wahlen.

w

Das Dialogfeld ,Select Devices" (Gerate wahlen)
wird eingeblendet.

4. Die Wahl aus der Liste der verfugbaren Geréte
vornehmen und auf [Connect] (Verbinden) klicken.

5. Das Dialogfeld ,Backup Devices" (Geréate-
Datensicherung) wird eingeblendet.

6. Auf [Backup Device] (Gerate-Datensicherung)
klicken.

7. Das Dialogfeld ,Save Backup As" (Datensicherung
speichern unter) wird eingeblendet, wie unten
rechts in Abbildung 22 dargestellt.

8. Zum gewiinschten Verzeichnis gehen und einen
Dateinamen eingeben.

9. Auf [Save] (Speichern) klicken.

So werden gesicherte Daten im Gerat wiederhergestellt:

1. [File>Restore Device] (Datei>Gerate-Datensicherung

wiederherstellen) aus dem Hauptmen( wahlen.

2. Das Dialogfeld ,Open Backup* (Datensicherung 6ffnen)

ahnlich dem Dialogfeld ,Save Backup*, das rechts in
Abbildung 22 dargestellt ist, wird eingeblendet.

3. Zum entsprechenden Verzeichnis gehen und die
richtige Sicherungsdatei aus der Liste wéahlen.

4. Auf [Open] (Offnen) klicken.

5. Das Dialogfeld ,Select Devices* (Gerate wéahlen) wird

eingeblendet.

6. Die Wahl aus der Liste der verfigbaren Gerate

vornehmen und auf [Connect] (Verbinden) klicken. Die

gesicherten Daten werden zurlick zum Gerat
Ubertragen.

Description:

Save As Backup E
Preset Mame : I Preset Mumber : I
Preset Mum... | Preset Mame | [ate | Live Preset Mo... |
Preset 1 Auditorium 1 05-bd ar-2001
Preset 2 Auditariurn 2 05-bd ar-2001
Preset 3 Lecture (05-bar-2001 Live

Backup Entire Device

fID # 15, P4800 1 |

_I Backup Selected Fresets |
N

Cancel |
[ Help |

Abbildung 21 - Dialogfeld ,Backup Device"
(Gerate-Datensicherung)

Save Backup As [ x|

Bl A [FE

Lookjn: |23 P4600

)] 12tB aptistonBell. backup
@ CTAuditarium, backup
@ CTConference. backup
] DPLMusicHall backup
@ RFPAuditorium backup

File name: UMTITLED BACKUP Save I
Files of typer  [Backup fles (* backup) =l Cancel |
Description ;I

Help |
Product:

Abbildung 22 - Dialogfeld ,Save Backup As"
(Datensicherung speichern unter)
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Prozessorfunktionen

PROZESSORFUNKTIONEN

In diesem Abschnitt werden Softwarefunktionen beschrieben, die in vielen der Prozessorparameter-Fenster enthalten
sind. Fir die Funktionen von einzelnen Prozessoren siehe den Abschnitt Feste Prozessoren auf Seite 34 und den
Abschnitt Modulare Prozessoren auf Seite 40.

Fader

Fader sind in vielen Prozessor-Fenstern wie in dem Beispielsfenster in Abbildung 23 enthalten. Fader gestatten die
Verstarkungseinstellung durch eine Auf- oder Abwartsbewegung der Maus in der gleichen Weise, wie Fader an
einem wirklichen Mischer betatigt werden. Es ist auch moglich, den Pegel numerisch anzugeben, indem ein Wert in
das Feld eingegeben wird. Zuerst den Fader wahlen und dann den Pegel mit einer der nachstehend beschriebenen
Methoden einstellen.

Waéahlen

Ein Fader wird gewahlt, indem der Mauscursor tber den Faderknopf gebracht und darauf mit der linken
Maustaste geklickt oder indem im Wertefeld unter dem Faderstreifen geklickt wird. Der Faderknopf wird
markiert, um darauf hinzuweisen, dass er gewahlt wurde. Wenn das
Fenster mehrere Fader enthalt, kann mit TAB von links nach rechts
und mit UMSCHALTTASTE+TAB in entgegengesetzter Richtung
zwischen ihnen gewechselt werden.

Faderstreifen

Faderknopf
- *12
Faderknopf ahlt
—_'__—L'-E aderknopf gewa “
—%— Faderknopf nicht gewahlt 0
-4
Pegel einstellen 4
So wird der Pegel mit der Maus eingestellt: Drehpfeil-Schaltflachen [.__g 00 g

= Auf den Faderknopf klicken und die Maustaste
gedrickt halten, um ihn nach oben oder unten zu ziehen.

= Auf den Faderstreifen an dem Pegel klicken, der eingestellt
werden soll.

=  Mit der rechten Maustaste auf den Faderknopf klicken, um den
Pegel auf 0 dB einzustellen.

Wertefeld

Abbildung 23 - Standard-
. o . St I t
So wird der Pegel mit einzelnen Tasten eingestellt: euerelemente
1. Den Fader wahlen, der eingestellt werden soll.

2. Den Wert mit einer der folgenden Tasten einstellen.

Taste Ergebnis
Nach-Oben-Taste Erhéhung um 0,5 dB
Nach-Unten-Taste Absenkung um 0,5 dB
Bild-Auf-Taste Erhéhung um 3 dB
Bild-Ab-Taste Absenkung um 3 dB
Leerzeichentaste Stellt den Wert auf 0 dB

Wertefeld

Im Wertefeld kann der Wert auf Zehntel-Dezibel angegeben werden. Zu allen Fadern gehdrt ein Wertefeld. In
den meisten Prozessor-Fenstern sind die Wertefelder direkt unter den Fadern angeordnet. Die beiden
Ausnahmen sind die GEQ10- und GEQ30-Fenster, die nur ein Verstarkungswert-Feld fur die gesamte
Fadergruppe aufweisen. In diesen Fenstern zuerst den Knopf des Faders wahlen, der eingestellt werden
soll, und dann einen Wert in das Feld eingeben.
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Drehpfeil-Schaltflachen

An der linken Seite aller Wertefelder befinden sich Drehpfeil-Schaltflachen. Damit lassen sich die
Einstellungen auf einfache Weise andern, ohne dass ein Wert eingegeben werden muss.
So wird der Wert mit den Drehpfeil-Schaltflachen verandert:

=  Auf die Aufwarts- oder Abwarts-Drehpfeil-Schaltflache klicken, um den Pegel um +/-0,5 dB zu
andern.

= Auf eine Drehpfeil-Schaltflache klicken und die Maustaste gedriickt halten, um den Pegel
kontinuierlich zu erhéhen bzw. zu verringern. Wird die Schaltflache langer gehalten, erhght sich
die Geschwindigkeit der Anderung.

Einstellungen speichern und abrufen

Die Einstellungen in jedem Prozessorparameter-Fenster kdnnen in einer Computerdatei gespeichert und
wieder abgerufen werden, wenn irgendwann spéter eine ahnliche Einstellung fir den gleichen Prozessortyp
bendtigt wird. In dieser Weise lassen sich benutzerdefinierte oder installationsspezifische Voreinstellungen fur
haufig verwendete Prozessoren erstellen. Wenn viele Einstellungen im PC gespeichert werden sollen, wird
empfohlen, ein Verzeichnis ausschlie3lich fur Prozessor-Einstellungen oder fiir eine bestimmte Installation
einzurichten.

So werden Prozessor-Einstellungen gespeichert:
1. Auf einen Prozessorblock doppelklicken, um sein Prozessorparameter-Fenster einzublenden.

[File>Save Settings] (Datei>Einstellungen speichern) aus dem Meni wahlen oder STRG+S auf
der Tastatur driicken.

3. Einen Dateinamen eingeben.
Auf [Save] (Speichern) klicken.

5. Die Anwendung fligt eine Dateinamenerweiterung entsprechend dem erstellenden Prozessortyp
hinzu.

So werden die Prozessor-Einstellungen abgerufen:
Auf einen Prozessorblock doppelklicken, um sein Prozessorparameter-Fenster einzublenden.

[File>Recall Settings] (Datei>Einstellungen abrufen) aus dem Meni wéhlen oder STRG+R auf
der Tastatur dricken.

3. Die gewulinschte Datei mit Einstellungen wahlen.
4. Auf [Open] (Offnen) klicken.

Hinweis: Einstellungen kénnen nur fur einen Prozessor vom gleichen Typ wie der, von dem die
Datei mit Einstellungen erstellt wurde, abgerufen werden.

Prozessorfenster benennen

Das Parameterfenster jedes modularen Prozessorblocks im Signalflussdiagramm kann mit einem
eindeutigen Namen versehen werden. Dies ist praktisch, wenn mehrere Fenster gleichzeitig gedffnet sind.
Die Standardtitel von Prozessorfenstern enthalten sowohl den Namen des allgemeinen Prozessortyps als
auch die Kennzeichnung des Kanalstreifens, auf den sie gesetzt wurden.

Um zwischen ahnlichen Prozessoren unterscheiden zu koénnen, kann der Fenstername gemafl den
besonderen Funktionen oder Einstellungen des Prozessors angepasst werden. Der neue Fenstername
erscheint sowohl in der Titelleiste des Prozessorparameter-Fensters als auch in der Windows-Taskleiste,
wenn das Parameterfenster minimiert ist.

So wird ein Prozessorparameter-Fenster umbenannt:

Auf einen Block doppelklicken, um sein Prozessorparameter-Fenster einzublenden.
[Options>Name] (Optionen>Benennen) im Menu wahlen.

Den neuen Namen mit bis zu finfzehn Zeichen eingeben.

Auf [OK] klicken.

A w N E

Hinweis: Hierdurch wird nur der Name des Prozessorparameter-Fensters geandert. Der Titel des
Prozessorblocks im Signalflussdiagramm andert sich nicht.
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Momentaufnahmen

Die Funktion Momentaufnahme ist in jedem Prozessorparameter-Fenster verfiigbar, das eine Frequenzgang-
Kennlinie oder Ubertragungs-Kennlinie enthalt. Damit kann ein Bild der aktuellen Kennlinie erfasst und zur
Bezugnahme bei der Uberarbeitung der Prozessor-Einstellungen angezeigt werden. Der Prozessor behélt diese
Momentaufnahme, bis eine neue im gleichen Prozessor-Fenster gemacht oder die Anwendung beendet wird.

Die nachstehenden Beispiele von Frequenzgang-Kennlinien stammen aus dem Parameterfenster eines
parametrischen Equalizers mit funf Bandern und Filtern mit steilflankiger und Kuhschwanz-Charakteristik
(PEQ5+CS).

So wird die Momentaufnahme-Funktion verwendet:

1. Auf die Schaltflache [TAKE]
(Aufnehmen) klicken. Dadurch wird
die Frequenzgang-Kennlinie oder
Ubertragungs-Kennlinie
aufgenommen.

SNAPSHOT

2. Auf die Schaltflache [SHOW]
(Anzeigen) klicken.

Dadurch wird die
Momentaufnahme hinter

% der aktuellen Kennlinie Abbildung 24 - Erstellen einer Momentaufnahme

SMAPEHOT

angezeigt.

Die Schaltflache wird griin markiert, wenn die Momentaufnahme angezeigt wird.

3. Die Prozessor-Einstellungen

‘ andern. Wahrend die
: Kennlinie verandert wird,
= kann sie mit der

Momentaufnahme der
vorherigen Kennlinie, die im
Hintergrund angezeigt wird,
verglichen werden.

4. Erneut auf die
Schaltflache [SHOW]
klicken, um die
Momentaufnahme
aus- und einzublenden

ENAPTHOT

]

Abbildung 26 - Ausblenden der Momentaufnahme

Hinweis : Wenn die Momentaufnahme angezeigt wird, bevor Prozessor-Einstellungen geandert wurden,
ist sie hinter der aktuellen Kennlinie versteckt. Die Momentaufnahme wird sichtbar, sobald die
Kennlinie durch andere Einstellungen verandert wird.
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FESTE PROZESSOREN

Diese Prozessoren bilden die drei verschiedenen Stufen der Verstarkungsstruktur des System-Prozessors (siehe
Seite 16 fur weitere Informationen zu diesem Thema). Sie werden als feste Prozessoren bezeichnet, weil die
Verstarkungs- und Mischblécke im Signalflussdiagramm nicht verschoben oder geléscht werden kénnen.

Eingangsverstarkung

Der Eingangsverstarkungs-Prozessor enthélt einzelne Steller fur alle vier Eingangskanédle. Auf den
Verstarkungsblock am linken Ende eines Eingangskanalstreifens doppelklicken, um dieses Fenster zu 6ffnen.

Skalierung

Input Gain - UnLocked M= E3
Skalierung \ File Edit Options “Windows Help

\ INPUT 1 INPUT 2 INPUT 2 INPUT &

[[+40EU rfﬁéi-'

I- 40EU rﬁﬁﬁﬁ

P DoEU

Signalpolaritat —__ |

[
«30

("_ ¥

POLARIT V4

Pegelsteller ——m < -6

|

Kanalstummschaltung

[MUTE

/ |Automixer |CD Left |CD Right {Ambient D40
Kanal-Kennzeichnung —| o ¥ NotLinked N A ¢ rolinked
Verkniipfungsanzeige /Qm S Inorurorte) Z

Abbildung 27 - Fenster ,Input Gain“ (Eingangsverstarkung)
Diese Schaltflachen dienen zum Skalieren der einzelnen Eingangskanédle zur Anpassung an den

Ausgangspegel des Gerats vor dem System-Prozessor. Durch Klicken kann zwischen -10 dBV und +4 dBu
gewechselt werden. Die Voreinstellung ist +4 dBu.

+4 dBu gewahlt
-10 dBV gewahlt

Signalpolaritat

Auf diese Schaltflache klicken, um die Polaritdt des Signals, das am Eingangskanalstreifen anliegt,
umzukehren. Die Voreinstellung ist normale Polaritat.

Normale Polaritat

[Feltres= Umgekehrte Polaritat

Pegelsteller

Mit diesen Stellern wird der Signalpegel fur jeden Eingangskanal eingestellt. Zuerst den Faderknopf wéahlen,
dann den Pegel mit der Maus, den Pfeiltasten oder durch Eingabe eines Werts in das Wertefeld einstellen.
Fur umfassende Anweisungen fiir diese Bedienung siehe den Abschnitt Fader auf Seite 31. Der
Einstellbereich reicht von +30 dB bis -30 dB, und die Voreinstellung ist 0 dB oder Arbeitspegel.
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Hinweis: Die Eingangspegelsteller regeln den Pegel des Signals, nachdem es bereits im System-
Prozessor digital umgewandelt wurde. Signalpegel, die die Eingangsschwelle des
System-Prozessors uberschreiten, missen extern eingestellt werden.

Kanalstummschaltung

Auf diese Schaltflache klicken, um den Kanal stumm zu schalten. Die Voreinstellung ist inaktiv.

Stummschaltung aktiv
Stummschaltung inaktiv

Kanal-Kennzeichnung

Dieses Textfeld dient zur benutzerdefinierten Einstellung der Eingangskanalstreifen-Kennzeichnung im
Signalflussdiagramm. Die Voreinstellung ist ,Untitled In“ (Unbenannt Ein) fir jede Eingangskanalnummer.
Verknupfungsanzeige

Hier wird der Verknupfungszustand des Eingangskanals angezeigt. Jede Einstellung, die in einen
verknipften Kanal gedndert wird, wird fiir alle Kanale in der gleichen Verknupfungsgruppe geéndert. Fir eine
umfassende Erlauterung von Verknipfung und Verknipfungsgruppen siehe den Abschnitt Verknipfungen
auf Seite 25.

I | Kanal verknipft
[ ¥ MotLinked Kanal nicht verknupft
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Matrixmischer

Der Matrixmischer-Prozessor enthalt Bedienelemente fir Mischpunkt-Verbindungen im Signalflussdiagramm, die
unter separaten Registerkarten im Fenster fir jeden Ausgangsmischpunkt angeordnet sind. Auf einen beliebigen
Mischblock doppelklicken, um dieses Fenster einzublenden.

Fenster-Registerkarten

Matnx Mixer - Untocked (=] 3 Ausgangs-
File Edit Oplions/ Windows Help /Fensterabschnitt
. rd 4
Skalierung Output 1102 | Qutput 3to 4 | Duiput 5106 | Output 7 | Dutput8 | »
. . (T THAIT 7 THEIT 2 Output 1102 Titel des
Slgnalpolarltat______ - Fensterabschnitts
s E=ma
("‘- +10 B
5 "
a =
-5 L
-10
< -
Pegelsteller :
—_ a0 E
- 3
\_ %;Io_o 4B %lu.u 4B %il"“'“ 4B %"-w_o 4B =
Kanalstummschaltung = = . - =
[ Salo Il Auomixs [ swwocnt [[ sucocnz ] [ Lft Lo |
Kanal-Kennzeichnung /”I
@ 2001 Shure Incorporated = Not Linked ~d

~_ Verkniipfungs-
|7 Eingangssteller 4”- AUSQﬁ”QS' -I anzeige
steller

Abbildung 28 - Fenster ,Matrix Mixer* (Matrixmischer)

Fenster-Registerkarten

Das Fenster wird mit dem Ausgangs-Fensterabschnitt fiir den
Mischblock, auf den doppelgeklickt wurde, eingeblendet. Auf
eine andere Registerkarte klicken, um auf die Bedienelemente
fur einen anderen Ausgangsmischpunkt zuzugreifen.

Die Fenster-Registerkarten entsprechen den
Ausgangsmischpunkten im Signalflussdiagramm.
Wenn Frequenzweichen in der Konfiguration
verwendet werden, entsprechen die
Registerkarten-Titel dem Bereich der
Ausgangsstreifen, Uber die sich die

einzelnen Frequenzweichen erstrecken.

Matiix Mixr - UnLocked

r 1 [; 1 r 1T 1
Output 1103 | Dutput 4106 | Duput 7 | Outpua 8 |

B @ En En En Q)i
o N e B - T - B -

Abbildung 29 - Mixer-Registerkarten mit Frequenzweichen
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Eingangssteller

Auf diese Schaltflache klicken, um eine Verbindung fir den zugehdrigen Eingangskanal-Mischpunkt zu
aktivieren. Bedienelemente fiir inaktive Eingange werden abgeblendet angezeigt. Die Voreinstellung ist inaktiv.

Eingangswahler

Auf diese Schaltflache klicken, um eine Verbindung fir den zugehdrigen Eingangskanal-Mischpunkt zu
aktivieren. Bedienelemente fiir inaktive Eingange werden abgeblendet angezeigt. Die Voreinstellung ist inaktiv.

Verbindung aktiviert
Verbindung inaktiv

Signalpolaritat

Auf diese Schaltflache klicken, um die Polaritat des Signals umzukehren. Die Voreinstellung ist normale
Polaritat.

Normale Polaritét

Umgekehrte Polaritat

Pegelsteller

Mit diesen Stellern wird der Signalpegel fur jeden Kanal eingestellt. Zuerst den Faderknopf wéahlen, dann den
Pegel mit der Maus, den Pfeiltasten oder durch Eingabe eines Werts in das Wertefeld einstellen. Fur
umfassende Anweisungen fiir diese Bedienung siehe den Abschnitt Fader auf Seite 31. Der Einstellbereich
reicht von +10 dB bis - unendlich dB, und die Voreinstellung ist 0 dB oder Arbeitspegel.

Kanalstummschaltung

Auf diese Schaltflache klicken, um den Kanal stumm zu schalten. Die Voreinstellung ist inaktiv.

Stummschaltung aktiv

MUTE Stummschaltung inaktiv

Kanal-Kennzeichnung

Hier wird die Kanal-Kennzeichnung angezeigt, die im Eingangsverstarkungs- oder Ausgangsverstarkungs-
Fenster angegeben wurde.

Verknupfungsanzeige

Hier wird der Verknlpfungszustand des Ausgangsstellers der jeweiligen Fenster-Registerkarte angezeigt.
Jede Einstellung, die an einem verknlpften Ausgangssteller geandert wird, &ndert sich auch bei allen
anderen Mischerausgadngen in der gleichen Verknipfungsgruppe. Beim Wechseln der Fenster-
Registerkarten andert sich die Anzeige entsprechend dem Verknipfungszustand der jeweiligen
Registerkarte. Fur eine umfassende Erlauterung von Verknipfung und Verknipfungsgruppen siehe den
Abschnitt Verknipfungen auf Seite 25.

Hinweis: Wenn Mischblécke miteinander verknipft werden, werden lediglich die Ausgangssteller
vom Matrixmischer verknupft. Die Eingangssteller bleiben unabhéngig.
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Ausgangsverstarkung

Der Ausgangsverstarkungs-Prozessor enthdlt einzelne Steller fur alle acht Ausgangskanale. Auf den
Verstarkungsblock am rechten Ende eines Ausgangskanalstreifens doppelklicken, um dieses Fenster zu 6ffnen.

Output Gain - UnLocked =] E3

Skalierung
\ File Edt Options Windows Help

\ OUTPUT 1 OUTPUT 2 OouTPUT 3 OUTPUT4 OUTPUTS OUTPUTE OUTPUT7 OUTPUT 8

Signalpotaa
3 -- -

“t POLARIT Y+ POLARIT ¥+ POLARITY+ POLARIT ¥+ 3 ] POLARIT Y+
(--'-—.ao 5 5 5 0 g T T
28 H H = d = H

+18
12

Pegelsteller > < i

Ausgangs- \__,_ ;__Io.o a8 2'25 a8 ésloo 4B ﬂlas a8 S_JID.O a8 ﬂla.s 4B EJI‘LB 48 z_il—l.o a8

Pampfungsglied ™ [ e i
Kanalstummschaltung —— - [ ;
|y lLeft Lo |Leit Hi |CerterLo  [CenterHi  [Right Lo |Right Hi [Delay Fil  [Monitor

Kanal-Kennzeichnung —"| /Z?“i'é‘“?i?mllnio‘“L ¥/ NotLinked |, ¥/ NotLinked

Verkniipfungsanzeige © 2000 Shure Incorporated .

Abbildung 30 - Fenster ,,Output Gain“ (Ausgangsverstarkung)

Skalierung

Diese Schaltflachen dienen zum Skalieren der einzelnen Eingangskandle zur Anpassung an den
Ausgangspegel des Gerats vor dem System-Prozessor. Durch Klicken kann zwischen -10 dBV und +4 dBu
gewechselt werden. Die Voreinstellung ist +4 dBu.

+4 dBu gewahlt
-10 dBV gewahlt

Signalpolaritat

Auf diese Schaltflache klicken, um die Polaritat des Ausgangssignals umzukehren. Die Voreinstellung ist
normale Polaritat.

POLARIT v+ Normale Polaritat

FOLARITY - Umgekehrte Polaritat
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Pegelsteller

Mit diesen Stellern wird der Signalpegel fur jeden Ausgangskanal eingestellt. Zuerst den Faderknopf wahlen,
dann den Pegel mit der Maus, den Pfeiltasten oder durch Eingabe eines Werts in das Wertefeld einstellen.
Fur umfassende Anweisungen fir diese Bedienung siehe den Abschnitt Fader auf Seite 31. Der
Einstellbereich reicht von +30 dB bis -30 dB, und die Voreinstellung ist 0 dB oder Arbeitspegel.

Ausgangs-Dampfungsglied

Auf diese Schaltflache klicken, um den Signalausgang um -20 dB zu dampfen. Die Voreinstellung ist inaktiv.

Dampfungsglied aktiv

[FrRo-20de Dampfungsglied inaktiv

Kanalstummschaltung

Auf diese Schaltflache klicken, um den Kanal stumm zu schalten. Die Voreinstellung ist inaktiv.

- Stummschaltung aktiv
Stummschaltung inaktiv

Kanal-Kennzeichnung
Dieses Textfeld dient zur benutzerdefinierten Einstellung der Ausgangskanalstreifen-Kennzeichnung im
Signalflussdiagramm. Die Voreinstellung ist ,Untitled Out* (Unbenannt Aus) fur jede Ausgangskanalnummer.
Verknupfungsanzeige

Hier wird der Verknipfungszustand des Ausgangskanals angezeigt. Jede Einstellung, die in einen
verknipften Kanal geandert wird, wird fir alle Kanale in der gleichen Verknlpfungsgruppe geandert. Fir eine
umfassende Erlauterung von Verknipfung und Verkniipfungsgruppen siehe den Abschnitt Verknipfungen
auf Seite 25.

[ HIEE | Kanal verkniipft
[ ¥ Matlinked | Kanal nicht verkniipft

SHURE® System-Prozessor P4800 Software-Bedienungsanleitung Seite 39 von 108



Modulare Prozessoren

MODULARE PROZESSOREN

In diesem Abschnitt werden die Funktionen und Bedienelemente der einzelnen Prozessorblockparameter-Fenster
beschrieben. In einigen Féllen weisen mehrere Prozessorblécke fast gleiche Bedienelemente auf, zum Beispiel der
Abwarts-Expander und das Gate. In diesen Fallen werden die Prozessoren als Gruppe mit nur einem
Parameterfenster zur Veranschaulichung beschrieben. Bedienelement-Einstellungen, die nur bei einem der
Prozessoren in der Gruppe vorkommen, werden in der Beschreibung solcher Bedienelemente entsprechend
angemerkt.

Automatische Verstarkungsregelung/Leveler (AGC)

Der AGC/Leveler bewirkt einen mehr gleichbleibenden Lautstarkepegel fiir Programmmaterial, das lauter und leiser
wird. Er wirkt als Kombination aus Aufwarts-Expander und Kompressor, indem er die Verstarkung des
Eingangssignals erhoht, wenn der Pegel zu niedrig ist, und sie reduziert, wenn der Pegel zu hoch ist.
Blockname Beschreibung
= AGC Automatische Verstarkungsregelung

Verstarkungsreduzierungs-
Schwellwert-Schieberegler Kompressionsgrad-Schieberegler Anzeige

AGC in Podim (1) - UnLocked

GAIN CHANGE / INPUT

- ]
Ubertragungskennlinie 241842.9 8 310306012 || M i Pegelsteller
f— [l g
' THRESHOLD EXCEEDED ;
L
THRESHOLD ATTACK %
Linie der maximalen el e
Verstarkun RATIO DECAY i
g :;|'z.s_' 4 :_l?n_', :|°-° 48
e
: ITW ouTRUT
- - 11
SNAPSHOT DYNAMICS o
== :-
== ‘T
........ * :_
=11 :
:-IT-GB
10 o +10 +20 -
© 2000 Shure Incorporated \ b Not Linked | .2
) \ \
Ubertragungskennlinien-Anzeige Angelpunkt-Schieberegler
Abbildung 31 - AGC-Fenster
Funktion

Der Leveler kann in Situationen verwendet werden, in denen die Aufrechterhaltung eines konstanten
Lautstarkepegels erwiinscht ist, wie zum Beispiel fir Podium- und Lesepult-Mikrofone, bei denen sich der
Abstand des Sprechers zum Mikrofon &ndert. Der Leveler gleicht niedrige Pegel aus, indem er die
Verstarkung langsam erhoht. Wenn der Sprecher lauter in das Mikrofon spricht, verringert die AGC
allmahlich die Verstarkung.

Merkmale des Parameterfensters

Ubertragungskennlinie

Die Ubertragungskennlinie zeigt die Einstellungen fiir den Schwellwert und den Kompressionsgrad als
grafische Elemente an, die mit der Maus positioniert werden konnen. Die resultierende
Ubertragungskennlinie reprasentiert die Anderung im Signalausgangspegel.

SHURE® System-Prozessor P4800 Software-Bedienungsanleitung Seite 40 von 108



Modulare Prozessoren

Linie der maximalen Verstarkung

Der grof3te Betrag, um den die AGC das Signal anhebt, ist +12 dB, wie durch die Linie der maximalen
Verstarkung gekennzeichnet. Dadurch werden Probleme durch unerwiinschte Stérungsmodulationen und
akustische Ruckkopplung vermieden, die durch UbermafRige Anhebung von niedrigpegeligen Signalen
entstehen kdénnen. Die Linie der maximalen Verstarkung erscheint nur in der Ubertragungskennlinie, wenn
die Kombination von Schwellwert-, Angelpunkt- und Verhaltnis-Einstellungen in der AGC die +12-dB-Grenze
bedrangt.

Ubertragungskennlinien-Anzeige

Im Live-Modus stellt die Anzeige die Eingangspegel und relativen Ausgangspegel des Signals dar, sodass
die Auswirkungen des Prozessors auf das jeweilige Programmmaterial ersichtlich sind. Diese Funktion kann
mit der Meniioption [Options>Transfer Curve Meter] (Optionen>Ubertragungskennlinien-Anzeige) aus- und
eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet.

Hinweis: Wenn viele Anzeigen in der System-Prozessor-Software aktiv sind, kann die Leistung
der Software beeintrachtigt sein. Die Ubertragungskennlinien-Anzeige oder die
Verstarkungsreduzierungs-Anzeige kdnnen einzeln oder beide im Meni [Options]
ausgeschaltet werden.

Schwellwert-Schieberegler

Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser
Schieberegler am oberen Rand der Ubertragungskennlinie kann mit der Maus nach links und rechts gezogen
werden, um die Schwellwert-Einstellung zu &ndern.

Kompressionsgrad-Schieberegler

Die Position des Kompressionsgrad-Schiebereglers entspricht der Einstellung der Kompressionsgrad-
Steuerung. Dieser Schieberegler am rechten Rand der Ubertragungskennlinie kann mit der Maus nach oben
und unten gezogen werden, um die Kompressionsgrad-Einstellung zu andern.

Angelpunkt-Schieberegler

Die Position des Angelpunkt-Schiebereglers entspricht der Einstellung der Angelpunkt-Steuerung. Dieser
Schieberegler am unteren Rand der Ubertragungskennlinie kann mit der Maus nach links und rechts
gezogen werden, um die Angelpunkt-Einstellung zu &ndern.

Verstarkungsreduzierungs-Anzeige

Hier wird die gesamte Pegelanhebung oder -abschwachung angezeigt, die im Eingangssignal mit den
jeweiligen Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menioption [Options>Gain
Reduction Meter] (Optionen>Verstarkungsreduzierungs-Anzeige) aus- und eingeschaltet werden. In der
Voreinstellung ist sie eingeschaltet.

Pegelsteller

Mit den Pegelstellern werden die Ein- und Ausgangssignalpegel eingestellt. Der Bereich der verfligbaren
Verstarkungswerte liegt zwischen -12 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung. Der
Wert kann mit den Methoden verandert werden, die im Abschnitt Fader auf Seite 31 erklart werden.

Anzeige Schwellwert Uberschritten

Diese Anzeige leuchtet gelb, wenn das Eingangssignal zum Prozessorblock den vorgegebenen Schwellwert
Uberschreitet.

O Signalpegel hat den Schwellwert Gberschritten

@) Signalpegel hat den Schwellwert nicht erreicht
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Schwellwert

THRESHOLD Hier wird der Pegel angezeigt, den die Signalverstarkung erreichen muss, bevor der Prozessor
j‘l““-“ vt sie erhoht. Signalpegel unterhalb des Schwellwerts werden bei Arbeitspegel durch den

Prozessor gefuhrt. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflachen, Eingeben
eines Werts oder Betétigung des Schwellwert-Schiebereglers tiber der Ubertragungskennlinie geéndert
werden. Der verfligbare Wertebereich reicht von -60 VU bis +20 VU in Schritten von 0,5 VU mit einer
Voreinstellung von 0 VU.

Kompressionsgrad

Crate Hier wird der Betrag der Verstarkungsreduzierung angezeigt, der am Ausgang des Prozessors

i”T 4 relativ zum Eingangspegel, der den Angelpunkt Uberschreitet, erreicht wird. Eine Einstellung von

4:1 bedeutet zum Beispiel, dass eine Erhéhung von 4 dB im Pegel des Programmmaterials eine

Erhéhung des Ausgangspegels vom Prozessor von 1 dB bewirkt. Der Wert kann durch Klicken auf die

Drehpfeil-Schaltflachen, Eingeben eines Werts oder Betatigung des Kompressionsgrad-Schiebereglers an der

rechten Seite der Ubertragungskennlinie geéndert werden. Der verfiigbare Wertebereich reicht von 1:1 bis 10:1
in Schritten von 1/10 mit einer Voreinstellung von 2:1.

Einregelzeit

ATTACK Hier wird angegeben, wie lange der Prozessor wartet, bis er auf steigende oder fallende
j”“ s Eingangspegel reagiert, nachdem der Eingangspegel den Schwellwert erreicht hat. Die
verfiigbaren Werte reichen von 0,2 s bis 3 s mit einer Voreinstellung von 2 Sekunden.

Abklingzeit

Hier wird angegeben, wie lange der Prozessor wartet, bis er auf den Arbeitspegel zurtickkehrt,

DECAY nachdem der Eingangspegel néher zur Angelpunkt-Einstellung angestiegen oder abgefallen

j‘ = jst. Der verfiighare Wertebereich erstreckt sich von 0,5 s bis 5 s mit einer Voreinstellung von 5
Sekunden.

Angelpunkt

HINGE Die Angelpunkt-Einstellung ist der angestrebte Ausgangspegel der AGC. Das ist ein

i”ﬂ-" ww  Entscheidungspunkt, der bestimmt, ob der Eingangspegel angehoben oder abgesenkt wird.

Signalpegel unterhalb des Angelpunktes (aber oberhalb des Schwellwerts) werden

angehoben, wahrend Pegel oberhalb des Angelpunktes abgesenkt werden. Der Wert kann durch Klicken auf

die Drehpfeil-Schaltflachen, Eingeben eines Werts oder Betatigung des Angelpunkt-Schiebereglers unter der

Ubertragungskennlinie geandert werden. Der verfiigbare Wertebereich reicht von -60 VU bis +20 VU in
Schritten von 0,5 VU mit einer Voreinstellung von 0 VU.

Voreinstellung

Durch Klicken auf diese Schaltflache wird der Prozessor auf seine Systemvoreinstellungen
zuriickgesetzt.

Umgehung

Durch Klicken auf diese Schaltflache wird ein Signal unveréandert durch den Prozessor gefiihrt. Wenn die
Umgehung aktiv ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

Umgehung aktiv
Umgehung inaktiv

Momentaufnahme

Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltflache [Take] (Aufnehmen) geklickt wird. Durch Klicken auf
die Schaltflache [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund fur
Vergleichszwecke angezeigt. Die Schaltfliche [Show] wird grin markiert, wenn die
Momentaufnahme  angezeigt wird. FlUr eine ausfuhrliche Beschreibung der
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33.

EMAPEHOT
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Kompressor/Limiter

Kompressoren und Limiter reduzieren den Ausgangspegel des Signals relativ zum Eingangspegel, nachdem der
Eingangspegel einen bestimmten Schwellwert Gberschreitet. Der System-Prozessor bietet die folgenden Typen von
Kompressoren und Limitern:

Blockname Beschreibung
= COMP Kompressor
* SFT COMP Soft-Knee-Kompressor
= LIM Limiter
* SFTLIM Soft-Knee-Limiter
= ST COMP
" SFT ST COMP Gleich wie oben, fur Verwendung fir zwei Kandle,
" STLIM die ein Stereopaar bilden
= SFT ST LIM
= PEAKLIM Peak-Stop-(,Look-Ahead")-Limiter
. Kompressionsgrad- Verstarkungsreduzierungs-
Schwellwert-Schieberegler Schieberegler Anzeige
Soft Limiter in Automixer [4] - UnLocked / HEE
File Edt Options Window Help
- J
GAIN CHANGE I meur
Ubertragungs- M8 S A resen || 1 ;_\ Pegelsteller
kennlinie » THRESHOLD EXCEEDED *
THRESHOLD ATTACK ’
g w T om
KNEE
[sorr <] ouTPUT
. oy
SNAPSHOT ovnAMIcS | .
[T = :
| B
12
=
© 2000 Shure Incorporated lg © | WOTLNKED 1.7
Ubertragungskennlinien-Anzeige
Abbildung 32 - SFT LIM-Fenster
Funktion

Der Kompressor dient zum Skalieren des Ausgangs eines Signals, sodass es fur Gerate mit einem
schmaleren Dynamikbereich wie Verstarker, Bandgerate oder Lautsprecher geeignet ist. Der Limiter dient
zum Schutz des Systems vor plotzlichen Lautstarke-Spitzenpegeln, die die Lautsprecher mdglicherweise
beschadigen konnten. Durch Verzégerung des Signals um 1 ms hat der Peak-Stop-Limiter eine Ansprechzeit
von 0 ms, um noch mehr Kontrolle tber Signalspitzentdne zu erzielen. Der Kompressor und der Limiter
funktionieren auf &hnliche Weise, wobei der Limiter jedoch in der Regel fur eine kirzere Ansprechzeit und
einen hoheren Kompressionsgrad eingestellt ist. Die folgenden Arten von Prozessoren sind sowohl in
Limitern als auch in Kompressoren verfiigbar.

*  Soft-Knee - Diese Prozessoren bieten einen graduellen Ubergang vom nicht komprimierten zum
komprimierten Signal. Solche Prozessoren verbrauchen einen héheren Anteil der DSP-
Gesamtkapazitat als diejenigen ohne Soft-Knee-Option.

= Stereo - Diese Prozessoren gestatten die Aufrechterhaltung eines Stereoeindrucks, indem zwei
Blocke gesetzt werden, die in zwei verschiedenen Kanalen als ein einzelner Prozessor
fungieren. Beide Prozessorkandle reagieren mit der gleichen Pegelabsenkung, wenn der Eingang

SHURE® System-Prozessor P4800 Software-Bedienungsanleitung Seite 43 von 108



Modulare Prozessoren

eines der Kanéle die Schwellwert-Einstellung tiberschreitet. Diese Prozessoren verbrauchen einen
hoheren Anteil der DSP-Gesamtkapazitéat als Mono-Prozessoren.

Merkmale des Parameterfensters

Dieser Abschnitt erlautert die Funktionen und Parameter-Bedienelemente von Kompressoren und Limitern,
wobei der in Abbildung 32 dargestellte SFT LIM als Beispiel dient. Alle in diesem Abschnitt behandelten
Prozessoren sind sehr dhnlich in der Verwendung. Unterschiede in ihren Merkmalen und ihrer Funktionalitat
werden gegebenenfalls angefihrt.

Ubertragungskennlinie

Die Ubertragungskennlinie zeigt die Einstellungen fiir den Schwellwert und den Kompressionsgrad als
grafischne Elemente an, die mit der Maus positioniert werden konnen. Die resultierende
Ubertragungskennlinie reprasentiert die Anderung im Signalausgangspegel.

Ubertragungskennlinien-Anzeige

Im Live-Modus stellt die Anzeige die Eingangspegel und relativen Ausgangspegel des Signals dar, sodass
die Auswirkungen des Prozessors auf das jeweilige Programmmaterial ersichtlich sind. Diese Funktion kann
mit der Meniioption [Options>Transfer Curve Meter] (Optionen>Ubertragungskennlinien-Anzeige) aus- und
eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet.

Hinweis: Wenn viele Anzeigen in der System-Prozessor-Software aktiv sind, kann die Leistung
der Software beeintrachtigt sein. Die Ubertragungskennlinien-Anzeige oder die
Verstarkungsreduzierungs-Anzeige konnen einzeln oder beide im Meni [Options]
ausgeschaltet werden.

Schwellwert-Schieberegler

Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser
Schieberegler am oberen Rand der Ubertragungskennlinie kann mit der Maus nach links und rechts gezogen
werden, um die Schwellwert-Einstellung zu &ndern.

Kompressionsgrad-Schieberegler

Die Position des Kompressionsgrad-Schiebereglers entspricht der Einstellung der Kompressionsgrad-
Steuerung. Dieser Schieberegler am rechten Rand der Ubertragungskennlinie kann mit der Maus nach oben
und unten gezogen werden, um die Kompressionsgrad-Einstellung zu andern.

Verstarkungsreduzierungs-Anzeige

Hier wird die gesamte Pegelabschwachung angegeben, die im Eingangssignal mit den jeweiligen
Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menuoption [Options>Gain Reduction
Meter] (Optionen>Verstarkungsreduzierungs-Anzeige) aus- und eingeschaltet werden. In der Voreinstellung
ist sie eingeschaltet.

Pegelsteller

Mit den Pegelstellern werden die Ein- und Ausgangssignalpegel eingestellt. Der Bereich der verfligbaren
Verstarkungswerte liegt zwischen -12 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung. Der
Wert kann mit den Methoden verandert werden, die im Abschnitt Fader auf Seite 31 erklart werden.

Anzeige Schwellwert Uberschritten

Diese Anzeige leuchtet gelb, wenn das Eingangssignal zum Prozessorblock den vorgegebenen Schwellwert
Uberschreitet.

"3 | Signalpegel hat den Schwellwert tiberschritten

o Signalpegel hat den Schwellwert nicht erreicht
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Schwellwert

THRESHOLD Hier wird der Verstarkungspegel angegeben, den das Signal erreichen muss, bevor der
i”“-“ wu  Prozessor es komprimiert. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflachen,

Eingeben eines Werts oder Betatigung des Schwellwert-Schiebereglers Uber der
Ubertragungskennlinie geéndert werden. Der verfiighare Wertebereich reicht von -60 VU bis +20 VU in
Schritten von 0,5 VU mit einer Voreinstellung von 0 VU.

Kompressionsgrad

RATIO Hier wird der Betrag der Verstarkungsreduzierung angegeben, der am Ausgang des
2”4-0 1 Prozessors relativ zum Eingangspegel erreicht wird. Eine Einstellung von 4:1 bedeutet zum
Beispiel, dass eine Erhdhung von 4 dB im Pegel des Programmmaterials eine Erh6hung des
Ausgangspegels vom Prozessor von 1 dB bewirkt. Der Wert kann durch Klicken auf die Drehpfeil-
Schaltflachen, Eingeben eines Werts oder Betatigung des Kompressionsgrad-Schiebereglers an der rechten
Seite der Ubertragungskennlinie geandert werden. Der verfiigbare Wertebereich reicht von 1:1 bis INF:1 in
Schritten von 1/10 mit einer Voreinstellung von 2:1 fir Kompressoren und 10:1 fir Limiter. Der Peak-Stop-
Limiter weist einen konstanten Kompressionsgrad von Unendlich zu Eins (INF:1) auf.

Einregelzeit

ATTACK Hier wird angegeben, wie lange der Prozessor wartet, bis er anfangt, die Verstarkung zu
ills—m reduzieren, nachdem der Eingangssignalpegel den Schwellwert Uberschritten hat. Der
= verfligbare Wertebereich reicht von 1 ms bis 200 ms mit einer Voreinstellung von 5 ms fir

Kompressoren und 2 ms fir Limiter. Der Peak-Stop-Limiter weist eine konstante Ansprechzeit von 0 ms auf.

Abklingzeit

Hier wird angegeben, wie lange der Prozessor wartet, bis er zum Arbeitspegel zurtickkehrt,

N nachdem der Eingangssignalpegel unter den Schwellwert gefallen ist. Der verfligbare

EI ™ Wertebereich reicht von 50 ms bis 1000 ms mit einer Voreinstellung von 100 ms fiir
Kompressoren und 50 ms fiir Limiter.

DECAY

Knee

Bei ,Soft“-Prozessoren zeigt dieses Bedienelement eine Pulldown-Liste an, aus der Soft-Knee- oder Hard-
Knee-Kompression gewahlt werden kann. Die Voreinstellung ist Soft-Knee. Bei Standard-Kompressoren und
-Limitern ist dieses Bedienelement deaktiviert.

Soft-Knee- B . ) : N
Prozessor [sor =] | ,Soft oder ,Hard" aus der Pulldown-Liste wahlen.
Standard- KHEE . . .

Prozessor [nann -] Das Bedienelement ist deaktiviert.

Voreinstellung

Durch Klicken auf diese Schaltfliche wird der Prozessor auf seine Systemvoreinstellungen
zurlckgesetzt.

Umgehung

Durch Klicken auf diese Schaltflache wird ein Signal unveréandert durch den Prozessor gefiuihrt. Wenn die
Umgehung aktiv ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

Umgehung aktiv

[E¥FRSS Umgehung inaktiv
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Momentaufnahme

Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltflache [Take] (Aufnehmen) geklickt wird. Durch Klicken auf die
Schaltflache [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund far
Vergleichszwecke angezeigt. Die Schaltflache [Show] wird grin markiert, wenn die
— Momentaufnahme  angezeigt wird. Fur eine ausfuhrliche Beschreibung der
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33.

ENAPEHOT

Soft-Knee-Prozessoren

Die folgenden Beispiele veranschaulichen den Unterschied zwischen Hard-Knee- und Soft-Knee-
Kompression. Alle anderen Einstellungen in diesen Beispielen werden unveréndert beibehalten.

Eine Soft-Knee-Einstellung ist beim Arbeiten mit hohen Kompressionsgraden
praktisch. Die Soft-Knee-Einstellung erhdht den Kompressionsgrad von 1:1 bei etwa
12 dB unter dem Schwellwert langsam auf den vorgegebenen Kompressionsgrad bei
etwa 20 dB uber dem Schwellwert. Durch die langsame
Erhéhung des Kompressionsgrads ist die Kompression
weniger aufféllig als bei der Hard-Knee-Einstellung.

Die Hard-Knee-Einstellung aktiviert die Kompression
unvermittelt mit dem vorgegebenen Kompressionsgrad,
sobald der Signalpegel den Schwellwert Gberschreitet. Diese

Abbildung 33 - Soft- Einstellung ist besonders praktisch in einem Limiter, weil

Knee-Kompression dadurch plétzliche Spitzen daran gehindert werden, den m':fg';ﬁ
Schwellwert zu Uberschreiten, ohne dass das Signal I i&
unterhalb des Schwellwerts geandert wird. Abbildung 34 - Hard-

Knee-Kompression

Stereo-Prozessoren

Die Stereo-Prozessoren weisen die gleichen Merkmale und die gleiche Funktionalitdt wie ihre Mono-
Gegensticke auf und umfassen einige zusatzliche Funktionen.

Anderungen der Einstellungen von einem der beiden Prozessorkanile werden auch auf den
anderen Kanal angewandt.

Beide Prozessorkanale reagieren mit der gleichen Pegelabsenkung, wenn der Eingang eines der
Kanale die Schwellwert-Einstellung Giberschreitet.

In den beiden Ubertragungskennlinien-Anzeigen wird der Eingangspegel von Kanal A rot und der
von Kanal B blau angezeigt.

Anzeigen-Wahler gestatten die Ansicht der Ubertragungskennlinien-Anzeige fir Kanal A, Kanal B,
beide Kanale oder keinen Kanal.

Die Anzeige ,,Schwellwert Uberschritten® ist fur Kanal A und Kanal B vorhanden.
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Frequenzweichen/Verteiler

Frequenzweichen und Verteiler teilen ein Eingangssignal in mehrere Ausgangskanale auf. Frequenzweichen teilen
das Frequenzspektrum des Eingangssignals in mehrere Bénder auf und geben jedes Band in einen separaten Kanal
aus. Durch Verteiler wird das Eingangssignal einfach auf mehrere Ausgangskanale verteilt.

Blockname Beschreibung Blockname Beschreibung

=  XOVER 2 2-Wege-Frequenzweiche = SPLIT2 2-Wege-Verteiler
= XOVER3 3-Wege-Frequenzweiche = SPLIT3 3-Wege-Verteiler
= XOVER4 4-Wege-Frequenzweiche = SPLIT4 4-Wege-Verteiler
= XOVERS 5-Wege-Frequenzweiche = SPLITS 5-Wege-Verteiler

Frequenzweichen- Passband Ecken- Verstarkungs-
Ziehpunkt Ziehpunkte 'Ziehpunkt

Frequenzgang-PIotter Crossover in SW-Main Cluste (3) - Unl ocked

X_Fde Edt Options Window Help

25 315 40 50 63 80 100 |25 160 200 250 35

Ausgangskanal-
Kennzeichnungen—______| = -
e E—Mah Chuste] #-Miain Cluste H-Msin Cluster
'd [AUTE [FioTE [T

LOW CORMER FRE@ S| o 2([150 e A[50 e <([500 e
v.I = | - --I
Passband- _< LOW FILTER TYPE | [eBer <] e o] 24LR .

Steuerelemente
UPPER CORNER FRER@ ;!I 150 4o ;l 150 Lye ;I 500 4y _:_;lom KHz
UPPER FILTER TYPE |6 Batt - I |ea L-R - I |12 L-R - I 24 L-R -

L_ GAIN ::IT 48 _:_-[T a8 :JI[T 4B :[T a5

@ 2000 Shure Incorporated :‘ | NOT LinkED o

Abbildung 35 - XOVER4-Fenster
Funktion

Eine Frequenzweiche dient dazu, den Frequenzbereich des Eingangssignals mit mehreren Bandpassfiltern
zu unterteilen und dann jedes Frequenzband zu einem separaten Ausgang flr verschiedene
Lautsprechertypen zu leiten. Verteiler dienen dazu, das gleiche Signal zu mehreren verschiedenen
Ausgéngen zu leiten. Fur Verteiler-Prozessoren gibt es kein Parameterfenster, da sie das Signal einfach bei
Arbeitspegel ohne zusatzliche Verarbeitung verteilen. Frequenzweichen und Verteiler sind ausschlieRlich fir
Ausgangsverarbeitung vorgesehen und kdnnen nicht in Eingangskanalstreifen positioniert werden. Siehe
den Abschnitt Prozessoren hinzufigen: Frequenzweichen und Verteiler auf Seite 22 fir weitere
Informationen zum Positionieren von Frequenzweichen und Verteilern im Signalflussdiagramm.

Merkmale des Parameterfensters

Dieser Abschnitt erlautert die Funktionen und Parameter-Bedienelemente von Frequenzweichen, wobei der
oben in Abbildung 35 dargestellte XOVER 4 als Beispiel dient. Die Merkmale der anderen Frequenzweichen
mit Ausnahme der Anzahl der Bandpassfilter sind identisch.

Frequenzgang-Plotter

Dieser Bereich des Fensters stellt die Bandpassfilter und Ubergangspunkte, die durch Klicken und Ziehen
mit der Maus verandert werden kénnen, grafisch dar.
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Passbander

Jedes Band verflgt tUber Ziehpunkte an beiden Seiten, die nach links und rechts gezogen
werden kdnnen, um die obere und untere Eckfrequenz individuell einzustellen. Auf3erdem
befindet sich ein Verstarkungs-Ziehpunkt in der Mitte jedes Bands, das nach oben und unten
gezogen werden kann, um den Ausgangspegel des Passbands einzustellen. Wenn ein Ziehpunkt gewahit wird,
wird er mit einem farbigen Kreis gefillt, um darauf hinzuweisen, dass er das aktive Steuerelement ist. Die obere
und untere Filterflanke werden mit den Passband-Bedienelementen im unteren Abschnitt des Fensters
eingestellt.

Frequenzweichen-Ziehpunkt

Dieser Ziehpunkt gibt die Frequenz des Ubergangspunktes zwischen zwei
Passbandern an. Er kann nach links und rechts gezogen werden, um gleichzeitig die
Eckfrequenzen der sich schneidenden Filterflanken einzustellen. Wenn ein
Frequenzweichen-Ziehpunkt gewahlt wird, wird er griin, um darauf hinzuweisen,
dass er das aktive Steuerelement ist, und die zugehérigen Ecken-Ziehpunkte werden
geflllt, um darauf hinzuweisen, dass sie gewahlt sind. Beim Verschieben des
Frequenzweichen-Ziehpunktes behalten die Ecken-Ziehpunkte ihre Positionen relativ
zueinander bei.

Ausgangskanal-Kennzeichnungen

Diese Kennzeichnungen Uber den Spalten mit den Passband-Bedienelementen haben die gleichen Farben
wie die zugehorigen Bandpasskurven im Frequenzgang-Plotter. Sie geben an, zu welchen Ausgangskanal
jedes Passband gefiihrt ist.

Verstarkungen einstellen und anzeigen/Plot normalisieren

Mit diesen Schaltflachen werden die

Passbander abwechselnd mit ihren
tatsachlichen Verstarkungspegeln und SHOk GRS
normalisiert angezeigt. Die Voreinstellung ist '
[Set and Show Gains on Plot] (Verstarkungen
in Plot einstellen und anzeigen).

SET AND |

HORMALIZE
PLOT

Wenn die Verstarkungspegel von Passbandern
sich betréachtlich unterscheiden, erscheint der
Ubergangspunkt von seiner tatséchlichen
Position versetzt, wie in Abbildung 36 an der
rechten Seite dargestellt. Der Anzeigemodus
fir den normalisierten Plot dient dazu, die

Abbildung 36 - Anzeige der Passband-Verstarkungspegel

genaue Position des Ubergangspunktes zu
sehen, wie in Abbildung 37 unten rechts

dargestellt.

e Auf die Schaltflache [Set and Show Gains
on Plot] klicken, um die Passband- LEErAnD
Verstarkungspegel anzuzeigen und on PLOT

einzustellen. Bei dieser Einstellung
werden Filterpegel im Frequenzgang-
Plotter beriicksichtigt, und die '.MFF.:L‘:;.EI'
Verstarkungs-Ziehpunkte sind auf den
Passbandern zu sehen.

e Auf die Schaltflache [Normalize Plot] (Plot

no_rma"Si(_aren) k”d_(en' um die Passhéander Abbildung 37 - Anzeige des normalisierten Plots
bei Arbeitspegel im Frequenzgang-Plotter
anzuzeigen. Die tatséchlichen

Verstarkungswerte werden durch diese
Einstellung nicht verandert.
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Voreinstellung

Durch Klicken auf diese Schaltflache wird der Prozessor auf seine Systemvoreinstellungen
zurlickgesetzt.

Stummschaltung

Auf diese Schaltflache klicken, um den Ausgangskanal stumm zu schalten. Wenn die Stummschaltung aktiv
ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

Stummschaltung

aktiv

[FTE Stummschaltung
MUTE
inaktiv

Polaritat

Auf diese Schaltflache klicken, um die Polaritat des Signals, das am Ausgangskanalstreifen anliegt,
umzukehren. Die Voreinstellung ist normale Polaritat.

Normale Polaritét

Umgekehrte Polaritat

Untere Eckfrequenz

< [0 Hier wird die Frequenzeinstellung der unteren Ecke des Passbands angegeben. Der
E” H= verfligbare Wertebereich ist abhangig von der Einstellung der oberen Eckfrequenz, da sich

Eckfrequenzen nicht Uberlappen kénnen. Der Wert kann durch Klicken auf die Drehpfeil-
Schaltflachen, Verwendung der Tastatur-Bedienelemente oder Eingeben eines Werts geandert werden. Die
Voreinstellungen fir die verschiedenen Passbander sind nachstehend fir jeden Frequenzweichentyp

angefihrt.
Typ_ der 2 Wege 3 Wege 4 Wege 5 Wege
Frequenzweiche
Band 1 AUS AUS AUS AUS
Band 2 2,0 kHz 200 Hz 150 Hz 60 Hz
Band 3 - 2,0 kHz 1,5 kHz 150 Hz
Band 4 - - 5,0 kHz 1,0 kHz
Band 5 - - - 6,0 kHz

Unterer Filtertyp/oberer Filtertyp

|z4 L-R vI Hier wird die Flanke der zugehorigen Passbandecke angegeben. Einen Wert aus dem
nachstehenden Pulldown-Men( wahlen. Die Voreinstellung ist 24 dB/Okt. Linkwitz-Riley.

Abkurzung Beschreibung
6 Butt 6 dB/Okt. Butterworth
12 Buitt 12 dB/OKkt. Butterworth
12 Bess 12 dB/Okt. Bessel
12 L-R 12 dB/OKkt. Linkwitz-Riley
18 Butt 18 dB/OKkt. Butterworth
24 Butt 24 dB/Okt. Butterworth
24 Bess 24 dB/Okt. Bessel
24 L-R 24 dB/OKkt. Linkwitz-Riley
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Hinweis: Die Verwendung eines 12-dB/Okt.-Filters in benachbarten Bandern ergibt eine Kerbe an
der Ubergangsfrequenz, wenn die Ausgange addiert werden. Bei der Ausrichtung von
Lautsprechern muss darauf geachtet werden, dass diese Kerbe im akustischen
Frequenzgang nicht wahrnehmbar ist. Erforderlichenfalls die Polaritat von einem der
Béander mit der Schaltflache ,Polaritat* umkehren.

Obere Eckfrequenz

iIIT w= Hier wird die Frequenzeinstellung der oberen Ecke des Passbands angegeben. Der
= verfigbare Wertebereich ist abhangig von der Einstellung der unteren Eckfrequenz, da sich
Eckfrequenzen nicht Uberlappen kdnnen. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflachen,
Verwendung der Tastatur-Bedienelemente oder Eingeben eines Werts geandert werden. Die
Voreinstellungen fir die verschiedenen Passbander sind nachstehend fir jeden Frequenzweichentyp

angefihrt.
DL 2 Wege 3 Wege 4 Wege 5 Wege
Frequenzweiche
Band 1 2,0 kHz 200 Hz 150 Hz 60 Hz
Band 2 AUS 2,0 kHz 1,5 kHz 150 Hz
Band 3 - AUS 5,0 kHz 1,0 kHz
Band 4 - - AUS 6,0 kHz
Band 5 - - - AUS
Verstarkung

Hier wird die aktuelle Verstarkungseinstellung des Passbandfilters angegeben. Der Bereich der verfligbaren
Verstarkungswerte liegt zwischen -18 dB und +12 dB in Schritten von 0,5 dB mit einer Voreinstellung von 0
dB. Der Wert kann mit den Methoden verandert werden, die im Abschnitt Fader auf Seite 31 beschrieben
werden.

Tasten der Tastatur

Mit Tasten der Tastatur kénnen Feineinstellungen der Ziehpunkt-Positionen im Frequenzgang-Plotter
vorgenommen werden. Einen Ziehpunkt durch Klicken wéhlen und dann die folgenden Tasten verwenden.

Frequenzweichen- und

VG Ecken-Ziehpunkte

Verstarkungs-Ziehpunkt

Verringert die Frequenz

— um einen Bildschirm- -
Bildpunkt
Erhoht die Frequenz um
RN einen Bildschirm- -
Bildpunkt
T - Erhoht die Verstarkung um 0,5 dB
\ - Verringert die Verstarkung um 0,5 dB

Verringert die Frequenz -

UMSCHALTTASTE mit ¢—
um 1/3 Oktave

Erhéht die Frequenz um -

UMSCHALTTASTE mit —
1/3 Oktave

UMSCHALTTASTE mit T

oder BIlD-AUETASTE - Erhoht die Verstéarkung um 3 dB

UMSCHALTTASTE mit |
oder BILD-AB-TASTE
LEERZEICHENTASTE

oder Klicken mit der - Stellt die Verstéarkung auf 0 dB ein
rechten Maustaste

Verringert die Verstarkung um 3 dB

Hinweis: Durch Andern der Frequenz um einen Bildschirm-Bildpunkt &ndert sich der Wert um
etwa 1/100 einer Oktave oder 1 %.
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Filter mit steilflankiger und Kuhschwanz-Charakteristik

Die Filter mit steilflankiger und Kuhschwanz-Charakteristik sind eine Art von parametrischem Equalizer, die die
Frequenzcharakteristika eines Systems im oberen und unteren Bereich insgesamt anheben oder absenken sowie
das obere und untere Ende des Frequenzspektrums dampfen.

Blockname Beschreibung

= CUT/SHELF Hoch- und Niederfrequenz-Filter mit steilflankiger Charakteristik/Hoch- und
Niederfrequenz-Filter mit Kuhschwanz-Charakteristik

Cut and Shelf in Mono Sub (3] - UnLocked
File Edit Options ‘window Help
25 315 40 50 63 80 100 125 160200 250 15 400 500 6305001.0k 125k 16k 2.0k 2.5k 315k 4k 5k 6.3k Sk 10k 12.5k 16k 20k
FRER = I“m H=  TYPE Ial dBILinkwit=-Riley -I GAIN = ICUT 4B
:l :l SHAPTHOT
e |
IW
— AZCIl FILE
==
QFFSETIR)
e
[~ mvert
e |
Copyright 2000-2002 Shure Ine. | Mot Linked i

Abbildung 38 - Fenster fur Filter mit steilflankiger/Kuhschwanz-Charakteristik

Funktion

Diesen Prozessor verwenden, wenn ein Filter mit steilflankiger Charakteristik mit Equalization Uber ein
breites Spektrum mit hohem und tiefem Endbereich kombiniert werden soll. Die Hoch- und Niederfrequenz-
Filter mit steilflankiger Charakteristik bieten eine Vielzahl von Flanken-Optionen zwischen -6 dB/Okt. und -24
dB/Okt. AuBRerdem ist es mdoglich, die Eckflanke der Filter mit Kuhschwanz-Charakteristik entweder als 6
dB/Okt. oder als 12 dB/Okt. vorzugeben.

Merkmale des Parameterfensters

Frequenzgang-Plotter

Dieser Bereich des Parameterfensters stellt die Ziehpunkte der Filter mit steilflankiger und mit Kuhschwanz-
Charakteristik, die durch Klicken und Ziehen mit der Maus verandert werden kénnen, grafisch dar. Beim
ersten  Offnen des  Parameterfensters befinden sich die  Filter-Ziehpunkte an ihren
Systemvoreinstellpositionen am ganz oben und unteren Rand des Frequenzspektrums. Durch Klicken auf
einen Ziehpunkt wird seine Frequenzgang-Kennlinie angezeigt und es kdnnen Einstellungen vorgenommen
werden.

Frequenzgang-Diagramm

Diese Kennlinie ist eine grafische Darstellung der kombinierten Ergebnisse der Filter-Ziehpunkte im
Frequenzgang-Plotter.

Hinweis: Die Kurve enthélt nicht die summierten Wirkungen der verschiedenen Prozessorblécke
im Signalflussdiagramm.
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Filter mit steilflankiger Charakteristik

Filter mit steilflankiger Charakteristik erscheinen als Ziehpunkte am unteren Rand des Frequenzgang-
Plotters, ihre Mittenfrequenzen sind durch gestrichelte senkrechte Linien gekennzeichnet. lhre Frequenz-
Voreinstellung ist ,AUS* und ihre Typ-Voreinstellung ist 6 dB/Butterworth.

Filter mit Kuhschwanz-Charakteristik

Die Hoch- und Niederfrequenz-Filter mit steilflankiger/Kuhschwanz-Charakteristik erscheinen entlang einer
horizontalen Achse in der Mitte des Frequenzgang-Plotters. Ihre Frequenz-Voreinstellung ist ,AUS* und ihre
Typ-Voreinstellung ist 6 dB/Okt.

Frequenz

FRE® 2”853 Hz Hier wird die Frequenz des gewahlten Filterpunktes angezeigt. Der Wert kann durch

Klicken auf die Drehpfeil-Schaltflachen, Verwendung von Tasten der Tastatur oder

Eingeben eines Werts geédndert werden. Der Frequenzbereich erstreckt sich von 25 Hz bis 20 kHz mit ,AUS* als
Voreinstellung.

Typ

TYPE |12 dBIDctare = Hier wird der Flankentyp des gewahlten Filters angezeigt. Die im Pulldown-
Menl verfugbaren Werte fur Filter mit steilflankiger und Kuhschwanz-
Charakteristik unterscheiden sich, wie nachstehend angefihrt.

Kuhschwanz- Steilflankige Charakteristik
Charakteristik
6 dB/Oktave* 6 dB/Butterworth* 18 dB/Butterworth
12 dB/Oktave 12 dB/Butterworth 24 dB/Butterworth
12 dB/Bessel 24 dB/Bessel
12 dB/Linkwitz-Riley 24 dB/Linkwitz-Riley

* Kennzeichnet die Voreinstellung
Verstarkung

CAIN iIIT 4B Hier wird die aktuelle Verstarkungseinstellung des gewahlten Filters mit Kuhschwanz-

hd Charakteristik angegeben. Der Bereich der verfugbaren Verstarkungswerte liegt
zwischen -18 dB und +18 dB in Schritten von 0,5 dB mit einer Voreinstellung von 0 dB. Der Wert kann mit
den Methoden verandert werden, die im Abschnitt Fader auf Seite 31 beschrieben werden. Beim Arbeiten
mit einem Filter mit steilflankiger Charakteristik ist dieses Steuerelement deaktiviert, dann wird das Wort
,CUT" angezeigt.

Ldschen
Durch Klicken auf diese Schaltflache werden die Filtereinstellungen auf ihre Voreinstellungen
— zuriickgesetzt. Dann wird das Dialogfeld ,Clear Options* (Optionen fiir Léschen, Abbildung 48 auf
Seite 68) eingeblendet, das die Option bietet, alle oder nur ausgewahlte Filtereinstellungen zu léschen.

Umgehung

Durch Klicken auf diese Schaltflache wird ein Signal unveréandert durch den Prozessor gefiihrt. Wenn die
Umgehung aktiv ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

Umgehung aktiv

Umgehung inaktiv
Momentaufnahme

SNAPSHOT Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltflache [Take] (Aufnehmen) geklickt wird. Durch Klicken auf
die Schaltflache [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund fur
Vergleichszwecke angezeigt. Die Schaltflache [Show] wird griin markiert, wenn die
Momentaufnahme  angezeigt wird. FUr eine ausfuhrliche Beschreibung der
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33.
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Importieren von ASCII-Dateien

D GG Auf Seite 76 wird beschrieben, wie Daten mit Hilfe von SIA Smaart und Gold Line TEF in
—‘ das Frequenzgang-Diagramm importiert werden.

Feinregelung von Parametern
Die Parameter fur die gewdahlten Filter kbnnen mit den nachstehend beschriebenen Methoden prazise
eingestellt werden.

= Eingabe von Werten in die Parameterfelder

=  Betéatigung der Drehpfeil-Tasten (oder des Dropdown-Feldes) neben den Parameterfeldern

= Verwendung der Tastatur-Tasten

Tasten der Tastatur

Mit den folgenden Tasten der Tastatur kdnnen Feineinstellungen fir den jeweils gewahlten Filter
vorgenommen werden.

Taste Ergebnis

Verringert die Frequenz um einen Bildschirm-Bildpunkt

Erhoht die Frequenz um einen Bildschirm-Bildpunkt

Erhoht die Verstarkung um 0,5 dB

=L |7

Verringert die Verstarkung um 0,5 dB

UMSCHALTTASTE mit <= | Verringert die Frequenz um 1/3 Oktave

UMSCHALTTASTE mit = | Erhoht die Frequenz um 1/3 Oktave

UMSCHALTTASTE mit T
oder BILD-AUF-TASTE

Erhéht die Verstarkung um 3 dB

UMSCHALTTASTE mit ~L
oder BILD-AB-TASTE

LEERZEICHENTASTE

oder Klicken mit der | ste|it die Verstarkung auf 0 dB ein
rechten Maustaste

Verringert die Verstarkung um 3 dB

ENTF | Stellt den oder die gewahlten Filter auf die Voreinstellungen zuriick.

Hinweis: Durch Andern der Frequenz um einen Bildschirm-Bildpunkt &ndert sich der Wert um
etwa 1/100 einer Oktave oder 1 %.

Kopieren und Einfligen

Die Einstellungen von Filter-Ziehpunkten kénnen zwischen Prozessorfenstern fir Filter mit steilflankiger
und Kuhschwanz-Charakteristik kopiert und eingefiigt werden.

So werden Filter kopiert und eingefugt:
1. Durch Klicken einen Filter wéahlen oder mit einer der nachstehenden Methoden mehrere Filter
wabhlen:
=  STtrG+Klicken
=  MenuUoption [Edit>Select All] (Bearbeiten>Alles auswahlen)
2. Die Menuoption [Edit>Copy] (Bearbeiten>Kopieren) wéahlen.

3. Das Prozessorfenster des Filters mit steilflankiger/Kuhschwanz-Charakteristik 6ffnen, in das die
Filtereinstellungen eingefligt werden sollen.

4. Die Meniioption [Edit>Paste] (Bearbeiten>Einfligen) wahlen.

Hinweis: Wenn Filter Bestandteil einer Mehrfach-Auswahl sind, werden sie rosa markiert und ihre
Parametereinstellungen gesperrt. Um die Wahl einer Mehrfach-Auswahl riickgangig zu
machen, auf ein beliebiges Steuerelement im Parameterfenster oder auf einen Filter
aullerhalb des Auswahlbereichs klicken.
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Delay

Der Delay-Prozessor speichert das Signal voriibergehend im Verzdgerungsspeicher und leitet es dann nach Ablauf
der vorgegebenen Zeitdauer weiter. Der System-Prozessor bietet die folgenden Delay-Typen:

Blockname Beschreibung
= DLY5ms Maximale Verzégerung von 5 Millisekunden
= DLY150ms Maximale Verzégerung von 150 Millisekunden
= DLY500ms Maximale Verzégerung von 500 Millisekunden
= DLY2s Maximale Verzégerung von 2 Sekunden

elay 150ms Max in Untitled Out 4 (4] ... W=l E3

File Edit Options ‘wWindow Help

UNITS (% English " Metric

o
pisarce [000  2fin T
Copwight 2000-2002 Shure Inc. [, ©|  Motlinked 2

Abbildung 39 — Delay-Fenster
Funktion

Der Delay dient zum Abgleichen der Sound-Ausgange von verschiedenen Lautsprechern, sodass sie
gleichzeitig im Publikum ankommen. Der Delay kann au3erdem eingesetzt werden, um Probleme mit der
Phasenaufhebung zwischen installierten Lautsprechern zu korrigieren. Die Berechnung der Verzégerung
erfolgt mit den Einheiten Zeit, Entfernung und Lufttemperatur.

Hinweis: Jeder Delay-Prozessorblock verbraucht die maximale Menge des Verzogerungsspeichers,
der aus dem Blocknamen hervorgeht, unabhéngig von der tatsachlichen Verwendung. Um
die Ressourcen des System-Prozessors zu schonen, sollte der Delay-Prozessor gewahit
werden, dessen Maximum der tatsachlich benétigten Verzégerungszeit am nachsten liegt.

Merkmale des Parameterfensters

Dieser Abschnitt erlautert die Funktionen von Delay-Prozessoren, wobei der oben in Abbildung 39
dargestellte DLY150 als Beispiel dient. Die Merkmale der anderen Verzdgerungsglieder mit Ausnahme
ihrer maximalen Verzdgerungszeiten sind identisch.

Units (Einheiten)

‘ o o ) Mit diesem Steuerelement wird angegeben, ob die Parameter in
s Metric englischen oder metrischen Einheiten angezeigt werden. Die

Voreinstellung ist ,Englisch”.

Zeit

EELA Mit diesem Steuerelement wird die Verzégerungszeit in Millisekunden angegeben.
Tirne |1=m-ﬂ'm 2m=  Der Wertebereich liegt zwischen 0 ms und der maximalen Verzogerungszeit des
Prozessorblocks, in diesem Fall 150 ms. Die Voreinstellung ist 0 ms.

Entfernung

I—msm .. &'m Mit diesem Steuerelement wird die Verzégerung nach der Entfernung
fisianes EI "k angegeben. Der Wertebereich ist abhangig von der maximalen

Verzdgerungszeit, aber die Voreinstellung ist immer null. Die gewiinschte
MalReinheit mit den Optionsfeldern rechts neben dem Steuerelement wahlen. Zur Auswahl stehen Zoll, Ful
und Meter. Die Voreinstellung ist Zoll. Wenn englische Einheiten gewéahlt sind, kénnen Sie zwischen Inch
und Full wahlen. Wenn metrische Einheiten gewahlt sind, wird der Abstand in Metern angegeben. Die
Voreinstellung ist ,Inch*.
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Lufttemperatur
Dieses Steuerelement ist zu verwenden, wenn die Verzdgerung
TEMP [ =
AR I ik nach der Entfernung eingestellt wird, da die

Schallgeschwindigkeit durch die Lufttemperatur beeinflusst wird.
Der Wertebereich reicht von -13 °F bis 122 °F oder -25 °C bis 50 °C. Die gewiinschte MaReinheit mit den
Optionsfeldern rechts neben dem Steuerelement wéahlen. Die Voreinstellung ist Grad Fahrenheit. Wenn
englische Einheiten gewahlt sind, wird die Lufttemperatur in Fahrenheit angegeben. Wenn metrische
Einheiten gewahlt sind, wird die Lufttemperatur in Celsius angegeben. Die Voreinstellung ist ,Fahrenheit”.

Umgehung

Durch Klicken auf diese Schaltflache wird ein Signal unveréandert durch den Prozessor gefiuihrt. Wenn die
Umgehung aktiv ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

Umgehung aktiv
Umgehung inaktiv

Loschen

Durch Klicken auf diese Schaltflaiche wird der Prozessor auf seine Systemvoreinstellungen
zurlckgesetzt.
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Digitale Ruckkopplungsreduzier-Stufe (DFR)

Modulare Prozessoren

Die DFR verwendet den patentierten Adaptive-Notch-Filter-Algorithmus von Shure fur die automatische
Erkennung von Rickkopplung und Anwendung von Schmalband-Sperrfiltern. Der System-Prozessor bietet die

folgenden DFR-Typen:

Blockname Beschreibung
= DFR5 Digitale Ruckkopplungsreduzier-Stufe mit 5 Bandern
= DFR10 Digitale Ruckkopplungsreduzier-Stufe mit 10 Bandern

2+ DFR 10 in Ambient D/0 (2] - UnLocked [_ | O] x|
File Edit Options Window Help
SELECT FEEDBACK FILTERS
FREQ Q'Im_ kHz y DYNAMIC
...
- - v [
DEPTH 7||* B S5O0 000000
S
| BES— |
TYPE |HIGH @ - FIXED

25 31540 50 €3 80 100125 160 200250 315400 500 630 800 1.0 12516 20 25 316 4 § €3 6 10 12516 20

SNAPSHOT

Frequenzgang- /920‘30 Shure Incorporated s © | mOTLNKED 7

Diagramm —-

Abbildung 40 - DFR10-Fenster

Funktion

Die DFR sollte als erster Prozessor in jedem Eingangskanal, der Signale von einem Mikrofon mit
Ruckkopplungsproblemen empfangt, verwendet werden. Wenn die DFR Rickkopplungen feststellt, aktiviert
sie einen dynamischen Filter. Sie beginnt damit, dass sie einen Bandsperrfilter von -3 dB, 1/10 Oktave an
der Rickkopplungsfrequenz einfigt. Dann wird die Filterbandtiefe in 3-dB-Schritten auf bis zu -18 dB
gesteigert, bis die Rickkopplung aufhort. Es ist auch moglich, feste Filter an bestimmten
Raumknotenpunkten zuzuweisen. Wenn die DFR Rickkopplung an der Frequenz eines festen Filters
erkennt, vertieft sie diese Kerbe mit einem dynamischen Filter.

Merkmale des Parameterfensters

Dieser Abschnitt erlautert die Funktionen und Parameter-Bedienelemente der digitalen
Ruckkopplungsreduzier-Stufe, wobei die oben in Abbildung 40 dargestellte DFR10 als Beispiel dient. Die
Merkmale der DFR5 mit Ausnahme der Anzahl der verfiigbaren Bandsperrfilter sind identisch.
Frequenzgang-Diagramm

Diese Kennlinie ist eine grafische Darstellung der kombinierten Ergebnisse der aktiven Bandsperrfilter des
Prozessors (gelb markiert).

Hinweis: Die Kurve enthélt nicht die summierten Wirkungen der verschiedenen Prozessorblécke
im Signalflussdiagramm.

Frequenz

Hier wird die Frequenz des gewahlten Filters angezeigt. Der Wert kann durch
Klicken auf die Drehpfeil-Schaltflachen, Verwendung von Tasten der Tastatur oder
Eingeben eines Werts gedndert werden. Der Frequenzbereich erstreckt sich von 25 Hz bis 20 kHz mit ,AUS*
als Voreinstellung.

FREQ ={[™*°  kHz
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Tiefe

DEPTH il 5% 48 Hier wird die Pegelreduzierung des gewahlten Filters angezeigt. Der Bereich der
verfligbaren Verstarkungswerte liegt zwischen 0 dB und -18 dB in Schritten von 0,5
dB mit einer Voreinstellung von 0 dB.

Typ

TYPE ||“.;“ ) ,I Hier wird der Bandbreiten-Typ des gewahlten Filters angezeigt. ,High Q" oder ,Low
Q" aus dem Pulldown-Meni wéhlen. Die Voreinstellung ist ,Low Q".

Ruckkopplungsfilter

Die Steuerelemente der Riickkopplungsfilter werden als LED-Reihe angezeigt. Die
- Anzahl der festen und der dynamischen Filter wird durch Verschieben der roten
DOOOeesSS Klammern mit der Maus nach links und rechts eingestellt. Aktive Filter werden gelb
FIXED angezeigt und erscheinen im Frequenzgang-Diagramm. Fir weitere Erlauterungen
siehe den Abschnitt Filterzuweisung auf Seite 59.

DYNAMIC

Diese festen Filter bleiben auf ihren jeweiligen Frequenzen
unabhéngig von neu festgestellten Rickkopplungen.

FIXED

oynamic | Diese dynamischen Filter werden automatisch von der DFR
eingesetzt, wenn sie Ruckkopplungen feststellt.

Sperren

Auf diese Schaltflache Klicken, um den Einsatz neuer Filter und die Vertiefung von bestehenden Filtern zu verhindern. Mit
dieser Option wird die DFR daran gehindert, Filter fir Programmmaterial anzuwenden, das erwiinschte Riickkopplungen
oder Klange, die Rickkopplungen sehr &hnlich sind (wie z.B. Gitarreneffekte, Synthesizerklénge oder Pfeifenorgel), enthéalt.

Sperre aktiv
Sperre inaktiv

Ldéschen

Durch Klicken auf diese Schaltflache werden die Filtereinstellungen auf ihre Voreinstellungen

zurtickgesetzt. Dann wird das Dialogfeld ,Clear Options* (Optionen fur Léschen, Abbildung 44
auf Seite 60) eingeblendet, das die Option bietet, alle oder nur ausgewahlte Filtereinstellungen
zu loschen.

Umgehung

Durch Klicken auf diese Schaltflache wird ein Signal unveréandert durch den Prozessor gefiuihrt. Wenn die
Umgehung aktiv ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

Umgehung aktiv
Umgehung inaktiv

Momentaufnahme

SNAPSHOT Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltflache [Take] (Aufnehmen) geklickt wird. Durch Klicken auf
. die Schaltflache [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund fir
Vergleichszwecke angezeigt. Die Schaltflache [Show] wird grin markiert, wenn die
— Momentaufnahme  angezeigt wird. Fir eine ausfuhrliche Beschreibung der
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33.
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Grundlegende DFR-Einrichtung

Es gibt zwei grundlegende Einrichtungsverfahren fir den DFR zum Reduzieren von Rickkopplungen: die
Methode ,Erregen von Rickkopplungen® und die Methode ,Versicherungspolize®, wie nachstehend
beschrieben. Jede eignet sich fur eine unterschiedliche Situation.

Hinweis:

Die DFR (wie jedes andere Bandsperrfiltersystem) trédgt zur Reduzierung von
Rickkopplungen bei, kann sie aber nicht vollstandig beseitigen. In einer typischen
Anlage wird ein Zustand des ,abnehmenden Nutzens® erreicht, nachdem 4 bis 8
Bandsperrfilter eingestellt wurden. Eine Anhebung der Verstarkung vor Ruckkopplung
von 6 bis 9 dB kann in einem typischen System erwartet werden. Um eine h@here
Leistung des Klangsystems zu erreichen, kann es erforderlich sein, die Signalumgebung
zu verbessern.

= Methode ,Erregen von Ruckkopplungen® - Mit dieser Methode wird die DFR als
vorbeugendes Mittel gegen Riickkopplungen fiir Eingangskanéle eingesetzt, die nahe dem
Ruckkopplungspunkt arbeiten und eine zusétzliche Stabilitatsspanne erfordern. Daflr wird die
Verstarkung des Eingangskanals tber die normale Einstellung angehoben, um absichtlich
Ruckkopplungen des Systems herbeizufihren. Die DFR stellt dann die erforderlichen Filter ein.
Wenn anschliel3end die Eingangsverstarkung auf den normalen Pegel abgesenkt wird, ist das
System stabil und einsatzbereit.

= Methode ,Versicherungspolize” - Bei dieser Methode wird die DFR als zusatzliche
Versicherung gegen unerwarteten Riickkopplungen in einem ansonsten stabilen System
eingesetzt. Dafur wird der DFR-Prozessor einfach in den Signalweg eingeflgt, ohne
irgendwelche Einstellungen zu definieren. Dieses Verfahren wird fir Anlagen verwendet, die
bereits eine hinreichende Verstarkung vor Riickkopplung aufweisen, aber Schutz vor
gelegentlichen Rickkopplungen bendétigen, die aufgrund von ortsverénderlichen Mikrofonen
oder vom Benutzer verstellbaren Pegelstellern auftreten kann.

So wird die Methode , Erregen von Rickkopplungen“ angewandt:

1. Aktive Filter durch Klicken auf die Schaltflache [Clear] (Léschen) entfernen.
2. Alle Mikrofone hochfahren.

Das DFR-Fenster beobachten und dabei die Systemverstarkung langsam erhéhen. Wenn die
DFR akustische Riickkopplung feststellt, setzt sie neue Filter ein, die im DFR-Fenster als gelbe
Punkte angezeigt werden.

Diesen Vorgang fortsetzen, um die Verstarkung um 3 bis 6 dB Uber den Verstarkungspegel zu

erhéhen, mit dem das System arbeiten soll, oder bis 4 bis 8 Filter zugeschaltet wurden. Die
Verstarkung um 3 bis 6 dB auf die gewiinschte Einstellung verringern, um das System zu
stabilisieren.

5. Die zugeschalteten Filter als ,fixed" (fest) zuweisen (siehe unten Zuweisung fester und
dynamischer Filter). Die restlichen dynamischen Filter kommen wahrend der Verwendung des
Systems nach Bedarf zum Einsatz.

Hinweis:

Die festen Filter kdnnen in einen PEQ-Block kopiert werden, um mehr dynamische Filter
im DFR-Fenster zu haben.

Halte-Modus

Als Voreinstellung speichert der digitale Riickkopplungsunterdriicker (DFR) den Zustand aller seiner Filter
wahrend einer Preset-Umschaltung oder eines Ein-/Ausschaltvorgangs. Allerdings kann der DFR so
konfiguriert werden, dass bestimmte Filter geléscht werden, wenn ein Ein-/Ausschaltvorgang oder eine
Preset-Umschaltung erfolgt. Nach Festlegung aller Filter, die permanent sein sollen, aktivieren Sie den
Halte-Modus. Samtliche Filter, die nach Aktivierung des Halte-Modus eingesetzt werden, werden nach einer
Preset-Umschaltung oder einem Ein-/Ausschaltvorgang geléscht.

So wird der Halte-Modus aktiviert:

1. Absichtlich Riickkopplungen im System erregen, wie im vorherigen Abschnitt beschrieben.

2. Die Menuoption [Options>Hold Mode] (Optionen>Halte-Modus) wahlen.
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Filterzuweisung

Modulare Prozessoren

Die DFR verwendet die beiden nachstehend beschriebenen Methoden der Filterzuweisung.
= Feste Filter - Die Sperrpositionen kdnnen manuell vorgegeben werden oder als fest bestimmt
werden, nachdem die DFR automatisch einen dynamischen Filter eingesetzt hat. Dann bleiben
sie unabhangig von neu festgestellten Riickkopplungsfrequenzen stationar. Wenn die DFR jedoch
zusatzliche Rickkopplungen an ihrer Position erkennt, wird ein dynamischer Filter zur Vertiefung der

Sperrtiefe eingesetzt.

= Dynamische Filter - Die Sperrposition und -tiefe werden vollstandig automatisch bestimmt. Ein
dynamischer Bandsperrfilter wird bei erhdhter Riickkopplung vertieft, und wenn neue
Ruckkopplungsfrequenzen festgestellt werden, setzt die DFR die dynamischen Filter in der

Reihenfolge von den éltesten zu den neuesten neu ein.

Die DFR gestattet die Wahl, wie viele der Gesamtzahl der Bandsperrfilter fest bleiben und wie viele bei
Erkennen von Rickkopplung dynamisch zugewiesen werden. In Eingangskanélen fur stationédre Mikrofone
sollte eine gréRere Anzahl von festen Filtern verwendet werden. In diesem Fall bestimmt die Raumakustik
die dominanten Ruckkopplungsfrequenzen, die sich nicht merklich veradndern. In Eingangskanalen fur
drahtlose oder Hand-Mikrofone sollte eine gréRere Anzahl von dynamischen Filtern verwendet werden. In
dieser Situation veréndern sich die Rickkopplungsfrequenzen drastisch, wenn der Benutzer des Mikrofons

sich im Raum oder auf der Bihne bewegt.

Das zahlenméaRige Verhaltnis der festen zu den dynamischen
Filtern lasst sich mit einer der beiden nachstehend beschriebenen
Techniken bestimmen:

So wird das Dialogfeld , Fixed/Dynamic Filter Options*
(Optionen fur feste/dynamische Filter) verwendet:

1. [Options>Fixed filters allocation] (Optionen>Feste Filter
zuweisen) im Menl des DFR-Fensters wéhlen.

2. Das Dialogfeld ,Fixed/Dynamic Filter Options* (Optionen fur
feste/dynamische Filter) wird eingeblendet.

3. Die Anzahl der festen Filter eingeben, die zugewiesen werden
sollen. Die Anzahl der dynamischen Filter &ndert sich
entsprechend.

4. Auf [OK] klicken.

So wird die Filterzuweisung mit der Maus geéndert:

1. Den Cursor zwischen die roten Klammern anordnen, wie in
Abbildung 42 dargestellt.

2. Der Cursor andert seine Form zum Symbol fur horizontale
GroRenanderung: +—

3. Klicken und nach links ziehen, um die Anzahl der dynamischen

Filter zu erhdhen, oder nach rechts, um die Anzahl der
festen Filter zu erhdhen.

Filter mit hohem bzw. niedrigem Q-Faktor

Die DFR bietet zwei Breitenoptionen fur Bandsperrfilter, wie
unten in Abbildung 43 dargestellt. Filter mit hohem Q-Faktor
bleiben schmal, wenn die Filtertiefe zunimmt, sodass nur ein
minimaler Signalanteil gedampft wird. Hierdurch wird eine hohe
Klangqualitdt erhalten, die fur die meisten Anwendungen
einschlie3lich Musik geeignet ist.

Bei der Einstellung eines niedrigen Q-Faktors behélt die
Filterkerbe bei der Vertiefung ihre Form bei, wodurch der Bereich
der Frequenzdampfung grofRer wird. Diese Einstellung ergibt
eine bessere Systemstabilitdt auf Kosten einer geringflgig

Fixed/Dynamics Filter Dptions E3 |
Murmber of fixed filters IE
Mumber of dynamic filkers 7
’TI Cancel | Help |

Abbildung 41 - Optionen fir
feste/dynamische Filter

Cursor hier positionieren ...

\ DYNAMIC
| —

b
200000000
.

D |
nxzn‘\

... oder hier

Abbildung 42 - Andern der
Filterzuweisung mit der Maus

Hoher Q-Faktor
N

NI

\I[ /
A I/

\l/

\l/ ™

AN

Niedriger Q-Faktor

Abbildung 43 - Breitenoptionen
fur Bandsperrfilter

beeintrachtigten Klangqualitat. Diese Einstellung ist fir Anwendungen ausschlieflich fir Sprache geeignet.

*=  Zum Andern der Einstellungen fiir einen vorhandenen Filter den Filter durch Klicken wahlen und

dann das Pulldown-Menu [Type] (Typ) verwenden.

= Im Meni [Options] wéahlen, ob alle neu eingesetzten dynamischen Filter den hohen oder

niedrigen Q-Faktor erhalten sollen.
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Filter hinzufliigen, &ndern und entfernen

So wird ein fester Bandsperrfilter manuell eingesetzt oder geandert:

1. Einen aktiven festen Filter (gelb markiert) durch Klicken wahlen oder, um einen neuen Filter zu
aktivieren, den Filter unmittelbar rechts neben dem letzten aktiven Filter wahlen.

2. Die Frequenz, die Tiefe und den Typ nach Erfordernis einstellen.
3. Die Anderungen wirken sich im Frequenzgang-Diagramm aus.

Hinweis: Nur ein aktiver Filter oder der nachste inaktive Filter von links nach rechts kann gewahit werden.

So werden alle aktiven Bandsperrfilter entfernt:

. . Clear Options

1. Auf die Schaltflache [Clear] (Léschen) klicken.

Das Dialogfeld ,Clear Options” (Optionen fir Loschen) wird _

eingeblendet. £~ Clear One Filter
3. [Clear All Filters] (Alle Filter I6schen) wahlen und auf [OK] :

klicken.
4. Dadurch werden alle Bandsperrfilter entfernt, sodass das I—I

Frequenzgang-Diagramm linear wird. ok Cancel Help

- ODER - Abbildung 44 - Dialogfeld ,Clear Options*

(Optionen fur Loschen)
1. Die Menloption [Edit>Select All] (Bearbeiten>Alles auswéahlen)

wahlen.
2. Alle eingesetzten Filter werden rosa markiert, um anzuzeigen, dass sie gewahlt sind.
3. Die Taste ENTF drticken.

So werden einzelne Bandsperrfilter entfernt:
1. Auf einen Filter klicken, um ihn zu wahlen, oder mit STRG+Klicken mehrere Filter wahlen.
Die Taste ENTF driicken. - ODER -

Auf die Schaltflache [Clear] (L&schen) klicken, um das Dialogfeld ,Clear Options* (Optionen fiir Loschen)
einzublenden, und die Option [Clear One Filter] (Einen Filter 16schen) wahlen, die auch fir mehrere
gewahlte Filter wirksam ist.

Kopieren und Einflgen
Die Einstellungen fur Bandsperrfilter kbnnen zwischen DFR-Prozessorfenstern kopiert und eingeftigt werden.

So werden Filter kopiert und eingefigt:

1. Durch Klicken einen Filter wahlen oder mit einer der nachstehenden Methoden mehrere Filter wahlen:
=  STRG+Klicken
=  MenuUoption [Edit>Select All] (Bearbeiten>Alles auswahlen)

2. Die Menuoption [Edit>Copy] (Bearbeiten>Kopieren) wahlen.

Das DFR-Prozessorfenster 6ffnen, in das die Filtereinstellungen eingefligt werden sollen.

4. Die Meniioption [Edit>Paste] (Bearbeiten>Einfligen) wahlen.

w

Hinweis: Wenn Filter Bestandteil einer Mehrfach-Auswahl sind, werden sie rosa markiert und ihre
Parametereinstellungen gesperrt. Um die Wahl einer Mehrfach-Auswahl riickgangig zu
machen, auf ein beliebiges Steuerelement im Parameterfenster oder auf einen Filter
aullerhalb des Auswahlbereichs klicken.

Die System-Prozessor-Software bietet auRerdem die besondere Mdoglichkeit, aktive Filter aus dem DFR-
Fenster in das Fenster eines parametrischen Equalizers (PEQ oder PEQ + CS) zu kopieren. Indem feste Filter
in ein PEQ-Fenster verschoben werden, kénnen mehr dynamische Filter im DFR-Block zugewiesen werden.

Hinweis: DFR-Filter, die in einen PEQ-Block kopiert wurden, stimmen unter Umstanden nicht
genau mit dem urspriinglichen Filter Gberein, sondern verwenden eine Bandbreite, die
der des urspriinglichen Filters am néchsten liegt.
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Gate/Abwarts-Expander

Gates und Abwarts-Expander reduzieren den Ausgangspegel des Signals relativ zum Eingangspegel, nachdem der
Eingangspegel unter einen bestimmten Schwellwert abfallt.

Blockname Beschreibung
= DOWN EXP Abwarts-Expander

=  GATE Gate
Verstarkungsreduzierungs-
Schwellwert-Schieberegler Anzeige
Down Exp in Podium (1) - /. nLocked
ovu /
GAIN CHANGE INPUT
Ubertragungs- ':f o o e L BAR b o | Pegelsteller
kennlinie o b
- ) THRESHOLD EXCEEDED
1]
THRESHOLD ATTACK -
30 :.I—SS.O uu :.I?O ms
Az ¢
RATIO DECAY
- :fll.o “ i IT.“' ::Jo-“ 4B
HOLD
=|° ms ouTPUT
50 = |
: | T
SHAPSHOT DYNAMICS o
“ e :-
- o ° [
. = ’ g
12
S0 ~/lo0 48
B0 -
@ 2000 Shure Incpznlated '- L Mot Linked
Kompressionsgrad-Schieberegler Ubertragungskennlinien-Anzeige
Abbildung 45 - DOWN EXP-Fenster
Funktion

Diese Prozessoren dienen zum Reduzieren oder Beseitigen von unerwiinschten Hintergrundgerauschen.
Das Gate schaltet das Eingangssignal stumm, wenn es unter einen bestimmten Schwellwert abfallt. Der
Abwarts-Expander verringert die Verstarkung langsam, nachdem das Eingangssignal unter einen
bestimmten Schwellwert abgefallen ist, und bewirkt damit eine unauffalligere Pegelreduzierung als das Gate.
Das Gate ist ideal, wenn niedrigpegelige Gerdusche beseitigt werden missen, die sonst vom
Programmmaterial ablenken wiirden. Der Abwarts-Expander bietet sich in Situationen an, um das
Hintergrundgerédusch etwas zu reduzieren, in denen eine vollstdndige Beseitigung des Signals als
Unterbrechung des Programms auffallen wiirde.

Merkmale des Parameterfensters

Dieser Abschnitt erlautert die Funktionen und Parameter-Bedienelemente des Abwarts-Expanders und
Gates, wobei der oben in Abbildung 45 dargestellte DOWN EXP als Beispiel dient. Diese beiden
Prozessoren sind sich sehr ahnlich in der Verwendung. Unterschiede in ihren Merkmalen und ihrer
Funktionalitat werden gegebenenfalls erwahnt.

Ubertragungskennlinie

Die Ubertragungskennlinie zeigt die Einstellungen fiir den Schwellwert und den Kompressionsgrad als
g_rafische Elemente an, die mit ._der Maus positioniert werden konnen. Die resultierende
Ubertragungskennlinie représentiert die Anderung im Signalausgangspegel.
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Ubertragungskennlinien-Anzeige

Im Live-Modus stellt die Anzeige die Eingangspegel und relativen Ausgangspegel des Signals dar, sodass
die Auswirkungen des Prozessors auf das jeweilige Programmmaterial ersichtlich sind. Diese Funktion kann
mit der Meniioption [Options>Transfer Curve Meter] (Optionen>Ubertragungskennlinien-Anzeige) aus- und
eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet.

Hinweis: Wenn viele Anzeigen in der System-Prozessor-Software aktiv sind, kann die Leistung
der Software beeintrachtigt sein. Die Ubertragungskennlinien-Anzeige oder die
Verstarkungsreduzierungs-Anzeige konnen einzeln oder beide im Meni [Options]
ausgeschaltet werden.

Schwellwert-Schieberegler

Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser
Schieberegler am oberen Rand der Ubertragungskennlinie kann mit der Maus nach links und rechts gezogen
werden, um die Schwellwert-Einstellung zu &ndern.

Kompressionsgrad-Schieberegler

Die Position des Kompressionsgrad-Schiebereglers entspricht der Einstellung der Kompressionsgrad-
Steuerung. Dieser Schieberegler am unteren Rand der Ubertragungskennlinie kann mit der Maus nach links
und rechts gezogen werden, um die Kompressionsgrad-Einstellung zu andern.

Verstarkungsreduzierungs-Anzeige

Hier wird die gesamte Pegelanhebung oder -abschwachung angezeigt, die im Eingangssignal mit den
jeweiligen Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menuoption [Options>Gain
Reduction Meter] (Optionen>Verstarkungsreduzierungs-Anzeige) aus- und eingeschaltet werden. In der
Voreinstellung ist sie eingeschaltet.

Pegelsteller

Mit den Pegelstellern werden die Ein- und Ausgangssignalpegel eingestellt. Der Bereich der verfligbaren
Verstarkungswerte liegt zwischen -12 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung. Der
Wert kann mit den Methoden verandert werden, die im Abschnitt Fader auf Seite 31 erklart werden.

Anzeige Schwellwert Uberschritten

£ Signalpegel hat den Schwellwert Gberschritten | Diese Anzeige leuchtet gelb, wenn das
Eingangssignal zum Prozessorblock den
o Signalpegel hat den Schwellwert nicht erreicht | vorgegebenen Schwellwert (iberschreitet.

Schwellwert
Hier wird der Pegel angezeigt, unter den die Eingangssignalverstarkung fallen muss, bevor der Prozessor sie
THRESHOLD verringert. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflachen, Eingeben eines Werts
j"-sm vu oder Betdtigung des Schwellwernt-Schiebereglers am oberen Rand der Ubertragungskennlinie
geandert werden. Der verfligbare Wertebereich reicht von -80,0 VU bis 0 VU in Schritten von 0,5
VU mit einer Voreinstellung von -65,0 VU fur das Gate und -40,0 VU fiir den Abwarts-Expander.

Kompressionsgrad

Hier wird der Betrag der Verstarkungsreduzierung angegeben, der am Ausgang des Prozessors relativ zum
Eingangspegel erreicht wird. Eine Einstellung von 4:1 bedeutet zum Beispiel, dass eine
RATIO . . . . .
f”T 4 Verringerung von 1 dB im Pegel des Prqgrammmaterlals eine Verrmgerung dgs
i Ausgangspegels vom Prozessor von 4 dB bewirkt. Der Wert kann durch Klicken auf die
Drehpfeil-Schaltflachen, Eingeben eines Werts oder Betatigung des Kompressionsgrad-
Schiebereglers am unteren Rand der Ubertragungskennlinie geandert werden. Der verfiigbare Wertebereich
reicht von 1:1 bis INF:1 in Schritten von 1/10 mit einer Voreinstellung von INF:1 fir das Gate und 4:1 fur den
Abwarts-Expander.
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Einregelzeit

Parm— Hier wird angegeben, wie lange der Prozessor wartet, bis er zum Arbeitspegel zuriickkehrt,
f”zn—"“ nachdem der Eingangssignalpegel den Schwellwert tiberschritten hat. Die verfiigbaren Werte
= reichen von 1 ms bis 200 ms mit einer Voreinstellung von 2 ms fir das Gate und 20 ms fur

den Abwarts-Expander.

Abklingzeit

DECAY Hier wird angegeben, wie lange der Prozessor bendtigt, um die vorgegebene
j"s““ ms  Pegelreduzierung zu erreichen. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflachen
oder Eingeben eines Werts geéndert werden. Der verfigbare Wertebereich reicht von 50 ms

bis 1000 s mit einer Voreinstellung von 100 ms fur das Gate und 50 ms fiir den Abwarts-Expander.

Halten

HOLD Hier wird angeggben, wi(_a lange der Prozessor wartet, bis er anfangt_ den Pegel zu verringern,
f”"—"“ nachdem der Eingangssignalpegel unter den Schwellwert gefallen ist. Der Wert kann durch
— Klicken auf die Drehpfeil-Schaltflachen oder Eingeben eines Werts gedndert werden. Der

verfluigbare Wertebereich erstreckt sich von 0 ms bis 500 ms mit einer Voreinstellung von 0 ms.

Voreinstellung

Durch Klicken auf diese Schaltflache wird der Prozessor auf seine Systemvoreinstellungen
zurlckgesetzt.

Umgehung

Durch Klicken auf diese Schaltflache wird ein Signal unveréandert durch den Prozessor gefiuihrt. Wenn die
Umgehung aktiv ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

Umgehung aktiv
Umgehung inaktiv

Momentaufnahme

SNAPSHOT Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-

Kennlinie, indem auf die Schaltflache [Take] (Aufnehmen) geklickt wird. Durch Klicken auf die

- Schaltflache [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund far

Vergleichszwecke angezeigt. Die Schaltflache [Show] wird grin markiert, wenn die

— Momentaufnahme angezeigt wird. Fur eine ausfuhrliche Beschreibung der Momentaufnahme-
Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33.

SHURE® System-Prozessor P4800 Software-Bedienungsanleitung Seite 63 von 108



Modulare Prozessoren

Grafischer Equalizer

Grafische Equalizer verfligen tber einen festen Satz von Breitband-Filter mit konstantem Q-Faktor, die Uber das
Frequenzspektrum verteilt sind und jeweils individuelle Regler fur Anhebung/Absenkung aufweisen. Der System-
Prozessor bietet die folgenden Typen von grafischen Equalizern:
Blockname Beschreibung
= GEQ10 Grafischer Equalizer mit 10 Béandern
= GEQ30 Grafischer Equalizer mit 30 Bandern

Graphic EQ in Main L (3] - UnLocked
File Edit Ophtons Windows Help
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Abbildung46 — GEQ10-Fenster
Funktion

Dieser Prozessor dient fur praktische Breitband-Entzerrung in Raumen. Die Gesamt-Bandbreite und die
Bandbreite der einzelnen Filter ist vom Typ des gewdahlten grafischen Equalizers abhéngig. Der GEQ10
verfugt Uber zehn 1-Oktave-Filter zwischen 31,5 Hz und 16 kHz, wahrend der GEQ30 drei8ig 1/3-Oktave-
Filter zwischen 25 Hz und 20 kHz aufweist.

Merkmale des Parameterfensters

Dieser Abschnitt erlautert die Funktionen und Parameter-Bedienelemente der grafischen Equalizer, wobei
der oben in Abbildung 46 dargestellte GEQ10 als Beispiel dient. Die Merkmale des GEQ30 sind mit
Ausnahme der Anzahl der Bander und des Gesamt-Frequenzbereichs identisch.

Frequenzband-Fader

Die Frequenzbereich-Fader werden eingestellt, indem der Knopf mit der Maus nach oben und unten gezogen
oder indem am gewinschten Pegel auf die Skala geklickt wird. Jedes Frequenzband kann zwischen -18 dB und
+12 dB in Schritten von 0,5 dB abgesenkt oder angehoben werden. Fir weitere Informationen zum Einstellen
der Fader siehe den Abschnitt Fader auf Seite 31.

Frequenzgang-Diagramm

Diese Kennlinie ist eine grafische Darstellung der Ergebnisse der Frequenzband-Einstellungen und des
gewahlten Typs des Filter-Q-Faktors.

Hinweis: Die Kurve enthélt nicht die summierten Wirkungen der verschiedenen Prozessorblécke
im Signalflussdiagramm.
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Frequenz

Hier wird das Frequenzband angegeben, das eingestellt wird. Durch Klicken auf die
FRE® 3”3"5 [ Drehpfeil-Tasten kann ein anderes Frequenzband gewahlt werden. Die Voreinstellung
ist das unterste Frequenzband.

Verstarkung

Hier wird die aktuelle Verstarkungseinstellung des gewahlten Frequenzbands

AT ﬁ”T i angegeben. Der Bereich der verfligbaren Verstarkungswerte liegt zwischen -18 dB
und +12 dB in Schritten von 0,5 dB mit einer Voreinstellung von 0 dB. Der Wert kann
mit den Methoden verandert werden, die im Abschnitt Fader auf Seite 31 erklart
werden.

Typ des Filter-Q-Faktors

Hier wird der Typ des Filter-Q-Faktors angegeben, der fir alle
FEREN| COMBINING =l Frequenzbander eingestellt ist. Der Wert wird Uber die Pulldown-Liste
geandert. Die Voreinstellung ist ,Combining“.

Die Flanken zwischen den Frequenzbandern werden gemittelt, sodass eine

Combinin
g insgesamt glatte Entzerrungskurve entsteht.

Die Ergebnisse der einzelnen Frequenzbandsteller werden voneinander

Non-Combining S . . . h
isoliert, wodurch die Verstarkungsregelung unabhangiger wird.

Umgehung

Durch Klicken auf diese Schaltflache wird die Umgehung abwechselnd ein- und ausgeschaltet. Wenn die
Umgehung aktiv ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

Umgehung aktiv
Umgehung inaktiv

Linear
Auf diese Schaltflache klicken, um die Verstarkung aller Frequenzbander auf null zu stellen.

Momentaufnahme

Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
SNAPSHOT  Kennlinie, indem auf die Schaltflache [Take] (Aufnehmen) geklickt wird. Durch Klicken auf
die Schaltflache [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund fir

Vergleichszwecke angezeigt. Die Schaltflache [Show] wird grin markiert, wenn die
Momentaufnahme angezeigt wird. Fir eine ausfiihrliche Beschreibung der

Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33.

ASCII-Dateien

Auf Seite 76 wird beschrieben, wie Daten mit Hilfe von SIA Smaart und Gold Line TEF in
das Frequenzgang-Diagramm importiert werden.

Kopieren und Einfligen

Mit dem Meni [Edit] (Bearbeiten) kénnen Frequenzband-Einstellungen zwischen grafischen Equalizer des
gleichen Typs kopiert und eingefligt werden.

Hinweis: Es ist nicht moglich, Einstellungen zwischen den Prozessoren GEQ10 und GEQ30
zu kopieren.
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Parametrischer Equalizer

Modulare Prozessoren

Parametrische Equalizer gestatten es, die Anordnung, den Typ und die Bandbreite von mehreren Filtern an
beliebigen Positionen im Frequenzspektrum zwischen 25 Hz und 20 kHz vorzugeben. Der System-Prozessor bietet

die folgenden Typen von parametrischen Equalizern:

Blockname Beschreibung
* PEQ3 M
= PEQ5 . y y . )
- PEQ7 > Diese Prozessoren verfligen nur Giber Spitzenwert-/Bandsperrfilter.
= PEQ10 D,
" PEQ3+CS Diese Prozessoren verfligen Uber Spitzenwert-/Bandsperrfilter sowie
" PEQS+CS \ einen Niederfrequenz-Filter mit steilflankiger oder Kuhschwanz-
* PEQ7+CS Charakteristik oder einen Hochfrequenz-Filter mit steilflankiger oder
* PEQ10+CS Kuhschwanz-Charakteristik.
Schwellwert-Schieberegler Filterpunkt
PEQ with CS in Automixer [2) - UnLocked =1 E3
File Edit Options Window Help
25 315 40 50 63 &0 W00 125 160 200 250 315 400 500 637
a8 FILTERS
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Frequenzgang- @ 2000 Shute Incorporated [,® [nNoTinkeD
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Diagramm

Abbildung 47 - PEQ3+CS-Fenster

Spitzenwert-/Bandsperrfilter an.

Hinweis: Die Zahl im Blocknamen gibt die maximale Anzahl der fiur diesen Prozessor verfligharen

Funktion

Dieser Prozessor dient fur prazise Entzerrung des Raum-Frequenzgangs ohne unndétige Beeintrachtigung
der benachbarten Frequenzen. Einen parametrischen Equalizer danach wahlen, wie viele Frequenzbander
eingestellt werden missen und ob der Prozessor Filter mit steilflankiger oder Kuhschwanz-Charakteristik
enthalten soll. Wenn nur so wenig Filter eingesetzt werden, wie wirklich gebraucht werden, lasst sich DSP-

Kapazitat einsparen.

Merkmale des Parameterfensters

Dieser Abschnitt erlautert die Funktionen und Parameter-Bedienelemente der parametrischen Equalizer,
wobei der in Abbildung 47 auf der vorherigen Seite dargestellte PEQ3+CS als Beispiel dient. Die Merkmale
der anderen parametrischen Equalizer unterscheiden sich hiervon nur in der Anzahl der Béander und der

Verfligbarkeit von Filtern mit steilflankiger/Kuhschwanz-Charakteristik.
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Frequenzgang-Plotter

Dies ist der Bereich des Parameterfensters, in dem parametrische Filter angeordnet und eingestellt werden. Die
Spitzenwert-/Bandsperrfilter werden grafisch als Punkte und die Filter mit steilflankiger/Kuhschwanz-
Charakteristik als quadratische Ziehpunkte dargestellt. Beim ersten Offnen des Prozessorfensters enthélt der
Frequenzgang-Plotter keine Filterpunkte, und die Filter mit steilflankiger/Kuhschwanz-Charakteristik, falls
verfiigbar, erscheinen in ihren Voreinstellpositionen. Durch Klicken auf einen Filterpunkt oder Ziehpunkt wird
seine Frequenzgang-Kennlinie angezeigt und es konnen Einstellungen vorgenommen werden. Fir
Anweisungen zum Hinzufiigen von Filterpunkten siehe den Abschnitt auf Seite 68.

Frequenzgang-Diagramm

Diese Kennlinie ist eine grafische Darstellung der kombinierten Ergebnisse der Filterpunkte und Ziehpunkte
im Frequenzgang-Plotter.

Hinweis: Die Kurve enthalt nicht die summierten Wirkungen der verschiedenen Prozessorblocke
im Signalflussdiagramm.

Filterpunkte

Spitzenwert-/Bandsperrfilter werden im Frequenzgang-Plotter als Filterpunkte mit einstellbaren Bandbreiten-
Steuerelementen an beiden Seiten dargestellt. Einmal auf einen Filterpunkt klicken, um ihn zu wahlen, und
dann seine Einstellungen mit der Maus, den Tastatur-Tasten oder den Wertefeldern &ndern. Wenn ein
Filterpunkt gewahlt wird, wird seine Frequenzgang-Kennlinie grin im Frequenzgang-Plotter relativ zu null
angezeigt.

Filter mit steilflankiger/Kuhschwanz-Charakteristik

Die Hoch- und Niederfrequenz-Filter mit steilflankiger/Kuhschwanz-Charakteristik werden als quadratische
Ziehpunkte angezeigt. Jeder Ziehpunkt lasst sich abhangig von seiner vertikalen Position im Frequenzgang-
Plotter als Filter mit steilflankiger oder Kuhschwanz-Charakteristik einsetzen. Beim ersten Offnen des
Parameterfensters fungieren die Ziehpunkte als Hoch- und Niederfrequenz-Filter mit Kuhschwanz-
Charakteristik mit einer Voreinstellung von 0 dB bei 20 kHz bzw. 25 Hz. Sie verwandeln sich in Filter mit
steilflankiger Charakteristik, wenn sie zum unteren Rand des Frequenzgang-Plotters gezogen werden.

Frequenz

Hier wird die Frequenz des gewahlten Filterpunktes angezeigt. Der Wert kann durch
FRE® §||3‘-5 Hz Klicken auf die Drehpfeil-Schaltflachen, Verwendung von Tasten der Tastatur oder

Eingeben eines Werts geandert werden. Der Frequenzbereich reicht von 25 Hz bis 20

kHz mit einer Voreinstellung von 1 kHz, wenn ein neuer Filterpunkt hinzugefiigt wird.

Breite/Flanke/Typ

Dieser Regelbereich andert sich in Abhéngigkeit vom Typ des gewahlten Filters, wie unten angefuhrt. Fur
einen Filter mit steilflankiger Charakteristik bietet das Pulldown-Menl zwei Flanken zur Auswahl. Wenn ein
Spitzenwert-/Bandsperrfilter gewahlt ist, kann das Pulldown-Menu mit voreingestellten Werten verwendet
oder die Breite innerhalb einer tausendstel Oktave eingegeben werden. Dieses Steuerelement enthalt keine
Einstellungen fur Filter mit Kuhschwanz-Charakteristik.

Filtertyp Darstellung Wertebereich

Spitzenwert- wintH [Tece ] ) i
/Bandsperrfilter Von 1/70 Okt. bis 4 Okt., Voreinstellung: 2/3 Okt.

|2.u 2 ﬁ, Von 100,99 Q bhis 0,27 Q, Voreinstellung: 2,14 Q
Steilflankige sLopE [6 dBloct -] | -6 dB/OKt. und -12 dB/Okt., Voreinstellung: -6 dB/OKt.
Charakteristik
Kuhschwanz- teee [SiEE ] | Keine
Charakteristik
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Verstarkung

<=0 Hier wird die aktuelle Verstarkungseinstellung des gewahlten Filters angegeben. Der

GAIN EII 48 Bereich der verfligbaren Verstarkungswerte liegt zwischen -18 dB und +18 dB in

Schritten von 0,5 dB mit einer Voreinstellung von 0 dB. Beim Arbeiten mit einem

Filter mit steilflankiger Charakteristik ist dieses Steuerelement deaktiviert, dann wird das Wort ,CUT"
angezeigt.

Neu

FILTERS Auf diese Schaltflache klicken, um dem Frequenzgang-Plotter einen neuen Spitzenwert-
HEW /Bandsperrfilter hinzuzufiigen. Beim ersten Offnen des Fensters gibt die Zahl unter dieser
JLEFT Schaltflache die Anzahl der Filterpunkte an, die fir den gewahlten parametrischen rens
Equalizer verfigbar sind. Sie verringert sich, wenn dem Frequenzgang-Plotter Filterpunkte
hinzugefuigt werden. Beim Erreichen der maximalen Anzahl von Filtern fir den Prozessor wird die D LEFT
Schaltflache deaktiviert.

Ldéschen

Auf diese Schaltflache klicken, um die Filtereinstellungen zu I6schen. Dann wird das Dialogfeld
.Clear Options* (Optionen fur Ldéschen) eingeblendet, das die Option bietet, alle oder nur
ausgewabhlte Filterpunkte aus dem Frequenzgang-Plotter zu lI6schen. Siehe den Abschnitt Mit
Filtern arbeiten auf der folgenden Seite fir mehr Informationen.

Umgehung

Durch Klicken auf diese Schaltflache wird die Umgehung abwechselnd ein- und ausgeschaltet. Wenn die
Umgehung aktiv ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

Umgehung aktiv
Umgehung inaktiv

Momentaufnahme

Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltflache [Take] (Aufnehmen) geklickt wird. Durch Klicken auf
die Schaltflache [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund fur
—— Vergleichszwecke angezeigt. Die Schaltflache [Show] wird grin markiert, wenn die
Momentaufnahme  angezeigt wird. Fur eine ausfuhrliche Beschreibung der
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33.

ASCII-Dateien

EMAPEHOT

e EG Auf Seite 76 wird beschrieben, wie Daten mit Hilfe von SIA Smaart und Gold Line TEF in
’7 —‘ das Frequenzgang-Diagramm importiert werden.

Mit Filtern arbeiten

Beim ersten Offnen des Parameterfensters eines
parametrischen Equalizers befinden sich keine Spitzenwert-
/Bandsperrfilter im  Frequenzgang-Plotter.  Filterpunkte
kénnen nach Bedarf hinzugefiigt werden, bis die fir den  Clear One Filter
gewahlten Prozessorblock verfliigbare maximale Anzahl
erreicht ist.

Clear Options |

So wird ein neuer Filterpunkt hinzugefugt:

1. Auf die Schaltflache [New] (Neu) klicken. 0K I Cancel | Help
2. Ein Filterpunkt erscheint bei 0 dB mit einem Frequenz-

Voreinstellwert von 1 kHz und einer Bandbreite von 2/3
Oktave. Abbildung 48 - Dialogfeld ,Clear Options*

(Optionen fiir Léschen)

SHURE® System-Prozessor P4800 Software-Bedienungsanleitung Seite 68 von 108



Modulare Prozessoren

So werden alle Filterpunkte entfernt:

1. Aufdie Schaltflache [Clear] (L6schen) klicken oder [Edit>Clear Filters] (Bearbeiten>Filter
I6schen) aus der Menizeile des Parameterfensters wahlen.

2. Das Dialogfeld ,Clear Options* (Optionen fuir Loschen) wird eingeblendet.

3. [Clear All Filters] (Alle Filter I6schen) wéahlen und auf [OK] klicken.

4. Dadurch werden alle Filterpunkte aus dem Frequenzgang-Plotter entfernt und die Filter mit
steilflankiger/Kuhschwanz-Charakteristik auf ihre Voreinstellungen zuriickgesetzt.
So werden ausgewahlte Filterpunkte entfernt:

1. Auf einen Filterpunkt klicken, um ihn zu wahlen, oder mit STRG+Klicken mehrere Filter wahlen.

Die Taste ENTF driicken. - ODER - Auf die Schaltflache [Clear] (L6schen) klicken, um das
Dialogfeld ,,Clear Options* (Optionen fiir L6schen) einzublenden, und die Option [Clear One
Filter] (Einen Filter I6schen) wéhlen, die auch fur mehrere gewabhlte Filter wirksam ist.

Hinweis: Es ist nicht moglich, die Ziehpunkte von Filtern mit steilflankiger/Kuhschwanz-
Charakteristik zu entfernen, sie konnen aber mit [Clear] oder ENTF auf ihre
Voreinstellungen zuriickgesetzt werden.

Filter im Frequenzgang-Plotter einstellen
Filtereinstellungen kdnnen durch Ziehen der Filterpunkte und Ziehpunkte mit der Maus geandert werden.

So werden Verstarkung und Frequenz eingestellt:
1. Den Cursor uber die Mitte des Filterpunktes oder Ziehpunktes bringen.
Der Cursor éndert seine Form zum Symbol fiir Verschieben: 4%»

3. Klicken und den Filter nach links oder rechts ziehen, um die Frequenz einzustellen, oder nach
oben oder unten, um die Verstarkung einzustellen.

Hinweis: Der Frequenzgang-Plotter zeigt nur fiir den gewahlten Filter eine Kennlinie an. Die
kombinierte Kennlinie wird im Frequenzgang-Diagramm angezeigt.

So wird die Filterpunkt-Bandbreite eingestellt:
1. Den Cursor Uber einen der Bandbreiten-Steuerpunkte des Filters bringen.
Der Cursor @ndert seine Form zum Symbol fir horizontale GréRenéanderung: +—
3. Klicken und den Steuerpunkt nach links oder rechts ziehen, um die Bandbreite einzustellen.

Feinregelung von Parametern

Die Parameter fir den gewahlten Filterpunkt kdnnen mit den nachstehend beschriebenen Methoden prazise
eingestellt werden.

= Eingabe von Werten in die Parameterfelder

= Betatigung der Drehpfeil-Tasten (oder des Dropdown-Feldes) neben den Parameterfeldern

=  Verwendung der Tastatur-Tasten
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Tasten der Tastatur

Mit den folgenden Tasten der Tastatur kdnnen Feineinstellungen fir den jeweils gewaéhlten Filter
vorgenommen werden.

Taste Ergebnis

Verringert die Frequenz um einen Bildschirm-Bildpunkt

Erhéht die Frequenz um einen Bildschirm-Bildpunkt

Erhoht die Verstarkung um 0,5 dB

—|-[ T

Verringert die Verstarkung um 0,5 dB

UMSCHALTTASTE Mmit <— Verringert die Frequenz um 1/3 Oktave

UMSCHALTTASTE mit —> Erhoht die Frequenz um 1/3 Oktave

STRG mit <— Verringert die Bandbreite eines Filterpunktes in kleinen Schritten

STRG mit — VergroRRert die Bandbreite eines Filterpunktes in kleinen Schritten

UMSCHALTTASTE mit T

ST BB AURTAS T Erhoht die Verstarkung um 3 dB

UMSCHALTTASTE mit ~L
oder BILD-AB-TASTE

LEERZEICHENTASTE oder Klicken . . .
mit der rechten Maustaste Stellt die Verstéarkung auf 0 dB ein

Verringert die Verstarkung um 3 dB

Hinweis: Durch Andern der Frequenz um einen Bildschirm-Bildpunkt &ndert sich der Wert um
etwa 1/100 einer Oktave oder 1 %.

Kopieren, Ausschneiden und Einfiigen

Filterpunkte kénnen zwischen Fenstern von parametrischen Equalizern kopiert, ausgeschnitten und
eingefligt werden, wobei folgendes zu bertcksichtigen ist:

= Im Parameterfenster, in das eingefiigt werden soll, muss eine ausreichende Anzahl von
verfugbaren Filterpunkten vorhanden sein.

= Die Einstellungen von Filtern mit steilflankiger/Kuhschwanz-Charakteristik kbnnen nur zwischen
PEQ+CS-Prozessoren kopiert und eingefiigt werden.

Hinweis: Der Befehl ,Cut* (Ausschneiden) ist nicht fir die Ziehpunkte von Filtern mit
steilflankiger/Kuhschwanz-Charakteristik verflgbar.

So werden Filter kopiert und eingefigt:

1. Durch Klicken einen Filter wahlen oder mit einer der nachstehenden Methoden mehrere Filter
wahlen:

=  STRG+Klicken
=  MenUoption [Edit>Select All] (Bearbeiten>Alles auswahlen)

2. Die Menuoption [Edit>Copy] (Bearbeiten>Kopieren) wéahlen.

3. Das Parameterfenster des parametrischen Equalizers 6ffnen, in das die Filtereinstellungen
eingeflgt werden sollen.

4. Die Menlioption [Edit>Paste] (Bearbeiten>Einfligen) wahlen.

Hinweis: Wenn Filter Bestandteil einer Mehrfach-Auswabhl sind, werden sie rosa markiert und ihre
Parametereinstellungen gesperrt. Um die Wahl einer Mehrfach-Auswabhl rickgéngig zu
machen, auf ein beliebiges Steuerelement im Parameterfenster oder auf einen Filter
aullerhalb des Auswahlbereichs klicken.

any control in the parameter window, or on a filter outside the selection area.
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Ducker

Der Ducker bietet ein einfaches Verfahren zur Verwendung des P4800 in einem Audiosystem, das
Durchsagefunktionen erfordert. Wenn ein Durchsagesignal vorhanden ist, werden andere Signale vom Ducker
abgeschwacht bzw. ,untergetaucht".

Blockname

Beschreibung

DUCK

Ducker

ucker in Paging Mic [3] - UnLocked

File Edit Options *window Help

+20

+10

owvu

=10

OUTPUT
Fa
&

GAIN CHANGE

o0 -48 -36 -30 241612 -8 -6 -3

@ THRESHOLD EXCEEDED

THRESHOLD ATTACK

I-m.n il Uy II i‘ -

ATTEN LA TION HOLD

I-m.u il 4B |2nuu i‘ =
RELEASE

el

D ==

Paging | Output 1 [~ Output 5
Channels ™ ggpt 2 [~ Ouwput 6
¥ cutput 3 W output 7
M ouwput 4 T owput 8

-60

-60 -50 -40 -30 -20 +20

INPUT

-10 ovu

+10

Rlat Linked

b "l

Copyright 2000-2002 Shure Inc.

Funktion

Ziehen Sie den Ducker und legen Sie ihn auf einem Eingangsstreifen ab, um diesen Eingang als Durchsagesignal zu
kennzeichnen. Wenn das Durchsagesignal die Schwelle Uberschreitet, dampft der Ducker alle anderen Signale, die
an jedem Matrixmischpunkt vorhanden sind, zu dem es gefiihrt wird. Das Durchsagesignal wird mit Hilfe des
Matrixmischers oder der Kontrollkdstchen ,Paging Channels (Durchsagekandle) im Parameterfenster des Duckers
geflhrt.

Hinweis: Der Ducker kann nur auf einem Eingangskanalstreifen abgelegt werden. Nicht mehr als

einen Ducker auf jedem Eingangskanalstreifen ablegen.

Um zu verhindern, dass Nebengerausche vom Durchsageeingang hérbar werden, platzieren Sie vor dem Ducker ein
Gate in das Signalflussdiagramm.

Merkmale des Parameterfensters

Ubertragungskennlinie

Die Ubertragungskennlinie zeigt den Schwellwert als grafisches Element an, das mit der Maus positioniert
werden kann.

Ubertragungskennlinien-Anzeige

Im Live-Modus stellt diese Anzeige den Eingangspegel das Durchsagesignals dar, damit der Schwellwert
Uber den Umgebungsgerauschen eingestellt werden kann. Diese Funktion kann mit der Menioption
[Options>Transfer Curve] (Optionen>Ubertragungskennlinie) aus- und eingeschaltet werden. In der
Voreinstellung ist sie eingeschaltet.
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Hinweis: Die Softwareleistung kann beeintrachtigt werden, wenn viele Messanzeigen aktiv sind.
Die Schwellwertanzeige oder die Pegelabschwachungsanzeige kdnnen einzeln oder
beide im Menu [Options] (Optionen) ausgeschaltet werden.

Schieberegler Threshold (Schwellwert)

Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser
Schieberegler kann mit der Maus am oberen Rand des Schwellwertdiagramms nach links oder rechts
gezogen werden. Der Schwellwert &ndert sich entsprechend.

Anzeige Gain Change (Pegelabschwéachungsanzeige)

Diese Anzeige gibt die gesamte Pegelabschwéachung an, die fur die durch den Ducker bedampften Signale
mit den aktuellen Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menuoption
[Options>Gain Reduction Meter] (Optionen>Pegelabschwéchungsanzeige) aus- und eingeschaltet werden.
In der Voreinstellung ist sie eingeschaltet.

Anzeige Threshold Exceeded (Schwellwert Gberschritten)

£ Signalpegel hat den Schwellwert Gberschritten | Diese Anzeige leuchtet gelb, wenn das
Eingangssignal zum Prozessorblock den
o Signalpegel hat den Schwellwert nicht erreicht | vorgegebenen Schwellwert (iberschreitet.

Attenuation (Bedampfung)

Hierdurch wird die Pegelabschwéachung geregelt, die auf die vom Ducker bedampften Signale angewendet
wird, wenn das Durchsagesignal den Schwellwert tUberschreitet. Dieser Wert kann durch Klicken auf die
Drehpfeil-Schaltflachen oder Eingeben eines bestimmten Werts zwischen 1 dB und -INF geéandert werden.

Threshold (Schwellwert)

THRESHOLD Hierdurch wird der Verstarkungspegel geregelt, den das Durchsagesignal erreichen muss,
i”T"” bevor der Prozessor die vom Ducker bedampften Signale abschwéacht. Der Wert kann durch
Klicken auf die Drehpfeil-Schaltflachen oder Eingeben eines bestimmten Werts zwischen +20

dB und —60 dB geéandert werden.

Attack (Ansprechzeit)

ATTACK Hierdurch wird die Zeit geregelt, die der Prozessor benétigt, um den Verstarkungspegel der vom

2”20 ms Ducker bedampften Signale véllig abzuschwéachen, nachdem das Durchsagesignal den

Schwellwert Uberschreitet. Die Ansprechzeit kann durch Klicken auf die Drehpfeil-Schaltflachen

oder Eingeben eines bestimmten Werts gedndert werden. Der Bereich verfiigbarer Werte erstreckt sich von 1 bis
5000 ms.
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Hold (Halten)

— Hierdurch wird die Zeit geregelt, wahrend der der Prozessor die vom Ducker bedampften

ﬁlln_'“' Signale weiterhin abschwacht, nachdem das Durchsagesignal wieder unter den Schwellwert

abgefallen ist. Dieser Wert kann durch Klicken auf die Drehpfeil-Schaltflachen oder Eingeben

eines bestimmten Werts geédndert werden. Der Bereich verfligbarer Werte erstreckt sich von 1 ms bis 10.000
ms.

Release (Freigabe)

RELEASE Hierdurch wird die Zeit geregelt, die der Prozessor benétigt, um den vorherigen Pegel der
|2m =™ | vom Ducker bedampften Signale wiederherzustellen, nachdem die Haltezeit verstrichen ist.
Dieser Wert kann durch Klicken auf die Drehpfeil-Schaltflachen oder Eingeben eines

bestimmten Werts geandert werden. Der Bereich verfligbarer Werte erstreckt sich von 1 ms bis 10.000 ms.

Default (Voreinstellung)

Durch Klicken auf diese Schaltflaiche wird der Prozessor auf seine Systemvoreinstellungen
zurlickgesetzt.

Bypass (Umgehung)

Durch Klicken auf diese Schaltflache passiert das Signal den Prozessorblock ohne Veranderung. Wenn die
Umgehungsfunktion aktiv ist, wird die Schaltflache rot angezeigt. Die Voreinstellung ist inaktiv.

AR Umgehung aktiv

Umgehung inaktiv

Paging Channels (Durchsagekanéle)

Pagng  f7 Oupt1 | Oup 5 Markieren .Sie das" Kastchen neben J:edem Au§gang, zu dem das

Channels [~ ouaz [ owputs | DUrchsagesignal gefiihrt werden soll. Dies entspricht der Fihrung des
Mouwputs Wouwpt7 | Eingangs mit dem Ducker zu Ausgangsmischpunkten im
“ouput 4 "owpws | Signalflussdiagramm.
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Importieren von ASCIl-Dateien aus Smaart® oder Gold Line TEF™
Software

Fenster fur graphische Equalizer, parametrische Equalizer und Filter mit steilflankiger/Kuhschwanz-Charakteristik
Kﬁnnen Daten anzeigen, die in einer ASCII-Datei enthalten sind, die entweder aus einer SIA-Smaart-
Ubertragungsfunktionsmessung oder einer Gold Line TEF TDS-Messung exportiert wurden.

Main Cluster EQ in Main Three Way (4) - UnLocked n = IEIIﬂ

File Edit Options Window Help
25 315 40 50 63 50 100 125 150 200 250 H5 400 500 530500 1.0k 1.25k L6k20k2.5k 315k 4k 5k 5.3k 5k 10k 12.5k 16k 20k

Copyright 2000-2002 Shure Inc. B3R hiat Linked 4

Funktion

Die ASCII-Dateiimportfunktion kann zur Anzeige von Frequenz/Amplituden-Informationen, die in Smaart
oder TEF gemessen werden, verwendet werden. Durch Umkehrung der Daten kann die Anzeige als
visuelle Hilfe bei der Einstellung der Equalizer-Parameter verwendet werden. Die Anzeige stellt nur die
Amplitudenwerte fur Frequenzen, die in der Datei enthalten sind, dar; sie interpoliert keine Linie
zwischen tatséachlich gemessenen Punkten. Folglich kann Leerraum in der Anzeige auftreten,
insbesondere bei niedrigen Frequenzen.

Die ASCIl-Importfunktion ist kompatibel mit Dateien, die aus folgenden Messungen erzeugt
wurden:
»  Ubertragungsfunktionsmessungen in SIA-Smaart® Pro (Versionen 2/x und 3.x) und SIA
SmaartLive™.
= TDS-Messungen in allen Versionen von TEF™ TDS-Software fir Windows und DOS.

Speichern von Smaart-Dateien im ASCII-Format

Zum Exportieren einer Messung mit Hilfe der Smaart-Software messen Sie im Ubertragungsfunktions-
Modus. Dann wahlen Sie [File>ASCII Save] (Datei>Speichern als ASCII) in der Smaart-Anwendung aus.

Speichern von TEF-Dateien im ASCII-Format
Zum Exportieren einer Messung mit Hilfe der TEF TDS-Software gehen Sie folgendermaf3en vor:
1. Wabhlen Sie [File>Save] (Datei>Speichern) innerhalb der TEF TDS-Anwendung.

2. Geben Sie die Dateiinformationen ein, und klicken Sie auf ,Save“ (Speichern). Im Fenster
.Save TDS File" (TDS-Datei speichern) wahlen Sie ,ASCII* als Dateityp aus.
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Merkmale des Parameterfensters

Import

Klicken Sie auf diese Schaltflache, um ASCII-Dateien entweder aus Smaart oder TEF zu
importieren. Wenn das Fenster [Open File] (Datei 6ffnen) erscheint, wahlen Sie die zu
importierende Datei aus. Die Daten aus der importierten Datei werden im Frequenzgang-
Diagramm angezeigt. Wird eine TEF TDS-Datei importiert, so wird die Durchschnittsamplitude bei 0 dB
geplottet und alle anderen Amplitudenwerte sind entsprechend vorgespannt. Als Voreinstellung sind Smaart-
Ubertragungsfunktionsdateien nicht versetzt. Die Amplituden werden um die 0-dB-Achse zentriert, ebenso
wie in Smaart.

Refresh (Aktualisieren)
| Klicken Sie auf diese Schaltflaiche, um die zuletzt importierte Datei nochmals zu importieren.
Wenn eine neue Messung in Smaart oder TEF gemacht und mit demselben Dateinamen
gespeichert wird, wodurch die vorherige Datei Giberschrieben wird, kdbnnen Sie auf die Schaltflache [Refresh]
(Aktualisieren) klicken, um die neue Messung zu importieren, ohne den Dialog [Open File] (Datei 6ffnen)
aufrufen zu missen.

Hinweis: Die Schaltflache [Refresh] (Aktualisieren) &ndert die Vorspannung der urspriinglichen
Datei NICHT. Wenn sich die Durchschnittsamplitude einer TEF TDS-Datei andert, ist die
aktualisierte Datei immer noch um den urspringlichen Durchschnittswert vorgespannt.
AuRBerdem wird kein Offset, der der Datei mit Hilfe des Textfelds [Offset] hinzugefligt
wird, geandert, wenn Sie auf [Refresh] (Aktualisieren) klicken.

Show (Anzeigen)

‘ ‘ Klicken Sie auf diese Schaltflache, um die importierte Datei anzuzeigen oder zu verbergen. Die
— Schaltflache [Show] (Anzeigen) ist griin, wenn eine Datei angezeigt wird.

Offset

orrsevas 1 Hierdurch wird der Offset angegeben, um den die Anzeige von den in der ASCIl-Datei

-3 . enthaltenen tatsachlichen Amplitudenwerten versetzt ist. Als Voreinstellung wird eine TEF

— TDS-Messung um ihre Durchschnittsamplitude versetzt, damit sie um die 0-dB-Achse im
Frequenzgang-Diagramm zentriert ist.

Invert (Umkehren)

Klicken Sie auf dieses Kastchen, um die angezeigten Daten um die X-Achse umzukehren. Sie
kénnen dann die umgekehrte Anzeige als visuelle Hilfe fir die Equalizer-Parameter verwenden.
[Invert] (Umkehren) ist als Voreinstellung ausgewabhilt.

‘anm

Help (Hilfe)

Klicken Sie auf diese Schaltflache, um auf die Online-Hilfe flir das Importieren von Smaart-
und TEF ASCII-Dateien zuzugreifen.
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STEUERPINS

Die Pin-Anschlisse an der Rickseite des System-Prozessors erméglichen die externe Steuerung des Gerats und die
Ausgabe von Logiksignalen. Externe Steuergerdte wie ein AMX, ein Crestron oder eine vom Benutzer hergestellte
Steuervorrichtung kénnen an die Steuereingéange angeschlossen werden. Diese Art von einfacher Gerate-Schnittstelle
bietet den Endbenutzern die Mdglichkeit, ohne den Einsatz eines Computers zwischen Presets umzuschalten, Kanéle
stumm zu schalten oder die Verstarkung einzustellen. Der Logik-Ausgang kann mit LEDs, Relais oder Logik-Geraten
von Drittanbieten verbunden werden, wenn die Installation externe Geréte oder Zustandsanzeigen zum Reagieren auf
die aktiven Presets und Stummschaltung des System-Prozessors benétigt.

Ubersicht tiber die externe Steuerung

Die externe Geratesteuerung erfolgt auf drei verschiedenen Ebenen, wie unten in Abbildung 49 dargestellt. In diesem
Beispiel ist der externe Steuereingang fur Umschalten zwischen drei Presets, Einstellen der System-
Gesamtausgangsverstarkung mit einem Potentiometer und Stummschalten eines Eingangskanals mit einem
einrastenden Schalter konfiguriert. Der Logik-Ausgang ist so konfiguriert, dass er externe Gerate in Abhangigkeit vom
aktiven Preset aktiviert und den Stummschaltstatus eines Eingangskanals Uber eine LED anzeigt.

STEUER-EINGANG LOGIK-AUSGANG

S
(0}
Presetebene
4 Prozessor-Zuordnung
' | Gerateebene
Installationsebene
! Externe Anschlisse
e Abbildung 49 - Drei Ebenen der externen Geratesteuerung
S

teuerung eingerichtet:

1. Externe Anschlisse

Bei der Erstinstallation des Gerats sollte entschieden werden, welche Art von Steuereingang und
Logikausgang die Installation erfordert, dann werden die Blockstecker-Anschlussklemmen entsprechend
verdrahtet. Fir Anweisungen und Verdrahtungspléne siehe den Abschnitt ,Steuerpin-anschlisse” der
Gerate-Installationsanleitung.

2. Pin-Konfiguration

Im Fenster ,Control Pins“ (Steuerpins) der Software-Schnittstelle den System-Prozessor so
konfigurieren, dass er die Gerate-Steueranschlisse einwandfrei erfasst. Diese Konfiguration wird als
globale Einstellung im Gerat gespeichert und kann auch als Computerdatei gespeichert werden. Siehe
die Anweisungen dafir im Abschnitt Pin-Konfiguration auf Seite 80.
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3. Prozessor-Zuordnung
Nachdem das Gerat zum Erkennen der externen Steuerung konfiguriert wurde, im Abschnitt fir
Prozessor-Zuordnung des Fensters ,Control Pins" den Steuerverbindungen Ein- und Ausgangskanéle
zuordnen. Jedes Preset und jede Szene-Datei speichert eine eigene Prozessor-Zuordnungstabelle.
Siehe die Anweisungen dafur im Abschnitt Prozessor-Zuordnung auf Seite 83.

Das Fenster , Control Pins* (Steuerpins)

Das Fenster ,Control Pins® bildet eine Schnittstelle fur die globale Konfiguration von Steuerpins auf der Gerateebene
und fur die Zuordnung von Prozessoren zu Steuervorrichtungen speziell fur jedes Preset. Mit der Menuoption
[Devices>Control Pins Configuration] (Gerate>Steuerpins konfigurieren) vom Hauptfenster auf dieses Fenster
zugreifen.

Konfigurationsansichten

Das Fenster ,Control Pins“ verfugt Uber zwei verschiedene Konfigurationsansichten: Steuerungs-Eingang
und Logik-Ausgang. Auf [Control In] (Steuerungs-Eingang) oder [Control Out] (Steuerungs-Ausgang) oder
auf die entsprechenden Pin-Steckverbinder klicken, um abhangig von den Pins, die konfiguriert werden
sollen, zwischen den Ansichten umzuschalten.

Pin-Anschlisse

Control Pins HEE

Konfigurations- Locic ouT- N |

ansichten<] #P Enc

. CCCTCTTTTT

| EETTTTTTTT Pin-
Konfiguration

Preset-~
Steuerblock

@ Solo

O Sco O Automis ]
Cteachi| D 2emO

80
O sweacnz| rens Prozessor-
M Letlo O LektHi Zuordnung
I Eelth [ Center Lo

d E’“’L'_’ [ Center Hi
"] E_ln'.qu O Fight Lo
WRihilo |0 pight i
WRHH | O pdyre

Verbindungs- @ Delay Fil
b|ogck/ Mueln‘nl & Montar [0 Moritor _J

Verbindungsblock-Menu/

Abbildung 50 - Fenster ,,Control Pins" (Steuerpins): Ansicht ,Control In“ (Steuer-Eingang)

CONTROL IN

Diese Ansicht dient zum Konfigurieren und Zuordnen der Steuerungs-Eingangsstifte, um die folgenden
Funktionen Uber externe Gerate durchzufihren:

= Umschalten zwischen den im Gerét gespeicherten Presets
= Kanale stumm schalten und ihre Stummschaltung aufheben
= Verstarkungspegel einstellen

LOGIC OUT

Diese Ansicht dient zum Konfigurieren und Zuordnen der Logik-Ausgangsstifte, um die folgenden Zustande
an externe Anzeigen oder Geréate zu Ubertragen:

=  Preset-Nummer des aktiven Presets
=  Stummschaltungszustand eines Ein- oder Ausgangskanals
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Parametereinstellungen fur Preset-Codierung

Diese Parameterfelder werden neben [Control In] und [Logic Out] im oberen Bereich des Fensters ,Control
Pins“ eingeblendet. Die kombinierten Einstellungen in diesen Feldern bestimmen die Konfiguration des
Preset-Steuerblocks. Zuerst die Anzahl der Presets eingeben und dann einen Codierungstyp wéhlen.

Hinweis: Es bestehen Einschrankungen hinsichtlich der Verwendung von Codierungstypen in
Kombination mit der angegebenen Anzahl der Presets. Fur weitere Informationen siehe
den Abschnitt Preset-Codierungstypen auf Seite 81.

# Presets

2eets Hier wird die Anzahl der Presets im Gerat angegeben, auf die mit externen Geraten in der
_ gegebenen Konfigurationsansicht zugegriffen werden soll. Der Wertebereich reicht von 0 bis 128
mit einer Voreinstellung von null.

Codierungstyp

Hier wird der Codierungstyp angegeben, der fir die Preset-Steuerung verwendet werden
soll. Die verfiigbaren Werte unterscheiden sich in Abhangigkeit von der Anzahl, die in das
BINARY [125) ~|8 Wertefeld [# Presets] (Anzahl der Presets) eingegeben wurde, wie unten im Abschnitt

~Codierungstypen“ weiter erlautert wird. Die Voreinstellung ist ,keiner".

Schaltflache ,More Info* (Weitere Informationen)
Durch Klicken auf diese Schaltflache wird auf die Hilfethemen des Fensters ,Control Pins* zugegriffen.

Pin-Konfigurationsabschnitt

Dieser Fensterabschnitt dient zum Konfigurieren des System-Prozessors fur einwandfreies Erkennen von
Steuerpin-Verbindungen mit externen Geraten. Beim ersten Offnen des Fensters sind alle Verbindungen
deaktiviert und gibt es keine Unterscheidung zwischen den Funktionen der Pins. Nach der Festlegung, wie
viele Pins gegebenenfalls fir Preset-Steuerung verwendet werden sollen, werden diese Verbindungen in der
Anzeige einem Preset-Steuerblock zugeteilt, und etwaige restliche Pins kénnen der Prozessorsteuerung
zugeordnet werden.

Hinweis: Im Live-Modus kénnen keine Anderungen der Pin-Konfiguration mit Ausnahme von
Deaktivierung und Aktivierung von Verbindungen vorgenommen werden. Einrichten und
Anderung der Pin-Konfiguration sind nur im Design-Modus méglich.

Diese Einstellungen werden auf der Gerateebene gespeichert. Sie werden nicht zusammen mit Presets oder
Szene-Dateien gespeichert und &andern sich beim Umschalten zwischen Presets im Gerét nicht. Diese
Konfiguration kann als Computerdatei gespeichert werden, wenn der System-Prozessor beim Arbeiten nicht
angeschlossen ist, oder fur Datensicherung und Archivierungszwecke.

Preset-Steuerblock

Anfanglich wird kein Preset-Steuerblock im Fenster angezeigt. Nach der Eingabe von Einstellungen in den
Parameterfeldern [# Presets] und [Encoding Type] wird er links vom Steuerpin-Abschnitt des Fensters
eingeblendet. Die Pin-Verbindungen kénnen abwechselnd aktiviert und deaktiviert werden, indem mit der
linken Maustaste auf den Block geklickt oder [Disable] (Deaktivieren) aus dem Pulldown-Menl an der
rechten Seite des Blocks gewahlt wird. Fiir weitere Informationen tber Preset-Codierung siehe den Abschnitt
Preset-Codierungstypen auf Seite 81.

Hinweis: Nachdem das Gerat fir externe Preset-Steuerung konfiguriert wurde, kénnen Presets
erst wieder vom Computer geandert werden, nachdem die Presetsteuerungs-
Verbindung im Fenster ,Control Pins* deaktiviert wurde.
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Verbindungsbldcke

Die Anzahl der Verbindungsblocke, die im Fenster erscheinen, hangt davon ab, wie viele Pins nach der
Einstellung der Preset-Steuerung noch verfligbar sind. Einer Pin-Verbindung kdnnen verschiedene
Steuereinheiten oder Logik-Ausgange zugewiesen werden, indem eine Wahl aus dem Pulldown-Meni an
der rechten Seite des Blocks vorgenommen wird. Die Pin-Verbindungen kdnnen abwechselnd aktiviert und
deaktiviert werden, indem mit der linken Maustaste auf den Block geklickt oder [Disable] (Deaktivieren) aus dem
Pulldown-Menu gewabhlt wird.

LOGIC OUT e Deaktivierte

S / Verbindung
Aktivierte /

Verbindung

Deaktivierte

/ Verbindung

Typen von . ) Nicht einrastender
A i 100-kOhm-Potentiometer
Steuereinheiten: Keine Einrastender Schalter Schalter

Abbildung 51 - Verbindungsblocke

Prozessor-Zuordnungsabschnitt

In diesem Fensterabschnitt wird fir jedes Preset bestimmt, welche Prozessoren die externen Gerate
ansprechen. Die Ein- und Ausgangskanédle des Presets erscheinen in einer Spalte unter jedem Pin-
Zuweisungsblock, der einer Steuereinheit oder einem Logik-Ausgang zugeordnet wurde. Die Prozessor-
Zuordnung kann im Live- oder Design-Modus erfolgen. Im Live-Modus ist die Titelleiste dieses
Fensterabschnitts blau und im Design-Modus schwarz.

Hinweis: Eine Prozessor-Zuordnung wird zusammen mit dem Preset oder der Szene-Datei
gespeichert, daher muss eine Prozessor-Zuordnung erstellt werden, die mit der Pin-
Konfiguration des Geréts fur jedes im Gerat gespeicherte Preset Ubereinstimmt.

Auf ein Kontrollkastchen klicken, um den entsprechenden Ein- oder Ausgangskanal dem
Zuweisungsblock zuzuordnen. Das Kontrollkastchen wird blau gefullt, wenn es gewahlt
ist. Den Eingangs-Steuereinheiten kdnnen mehrere Prozessoren zugeordnet werden,
dem Logik-Ausgang aber nur einer. Durch Klicken auf das Kontrollkédstchen wird es
abwechselnd in die Auswahl aufgenommen und daraus entfernt.

Kontrollkastchen fir Prozessor-Zuordnung }

O Ashomue
(=R =
Solo Prozessor-Kontrollkéstchen fir Zuordnung gewahlt gmuz
DLk

0 Canter Lo
O Conier K4
Qo
Stummschaltungen S
00 Morbor

O Salo Kontrollkastchen nicht gewahlt

Die Kanal-Stummschaltung kann durch einen einrastenden Schalter oder einen nicht
einrastenden Schalter gesteuert werden, sie kann aul3erdem an den Logik-Ausgangspins Abbildung 52 -

angegeben werden. Stummschaltungs-
Zuordnung

SHURE® System-Prozessor P4800 Software-Bedienungsanleitung Seite 79 von 108



Steuerpins

Verstarkungen (nur Steuereingang)

Die Verstarkung kann extern durch ein 100-kOhm-Potentiometer gesteuert werden. Direkt unter jedem
Verbindungsblock, der einem Potentiometer zugeordnet ist, befindet sich eine Verstarkungsskala in der Form
einer blauen Leiste. Der Bereich, in dem das Potentiometer den Pegel einstellt, kann von maximal -30 dB bis +30
dB angegeben werden. Der Voreinstellbereich ist -30 dB bis 0 dB.

mJ So wird der vom Potentiometer eingestellte
Verstarkungsbereich bearbeitet:
1. Den Cursor irgendwo entlang der Skala = i R
— Lt anordnen und mit der linken Maustaste ?
Osse klicken.
O At . ) . From |30 ta [10 dB
g:::g:', 2. Das Dialogfeld ,Range Edit" (Bereich
O LeaLs bearbeiten) wird eingeblendet.
O Lt
T 3. Den Bereich der Verstarkungseinstellung oK Cancel |
O Rkt Lo fur das angeschlossene Potentiometer 2
2ol eingeben.
O o ) Abbildung 54 - Dialogfeld ,Range Edit"
] 4. Auf [OK] klicken. (Bereich bearbeiten)
Abbildung 53 - . . L
Verstarkungs- 5. Der neue Bereich wird durch die Lange
Zuordnung der blauen Leiste angegeben.

Hinweis: Verwenden Sie ein logarithmisches 100-kOhm-Potentiometer mit 5 % Toleranz. Die
meisten Potentiometer weisen 10 % oder 20 % Toleranz auf. Wenn der
Leerlaufwiderstand des Potentiometers weniger als 95 kOhm (mehr als -5 % Toleranz)
betragt, hebt es den Signalverstarkungspegel nicht hinreichend an. Allerdings kénnen
Sie ein 10 % oder 20 % Potentiometer verwenden, sofern der tatsachliche
Widerstandswert mehr als 95 kOhm betragt.

Pin-Konfiguration

Die Pin-Konfiguration bildet die zweite Ebene der externen Steuerung und muss eingerichtet werden, bevor die
Prozessor-Zuordnung festgelegt werden kann. Der Pin-Konfigurationsabschnitt des Fensters ,Control Pins“ ist ein
Software-Modell der Verdrahtung zur Hardware, die das Gerat erfordert, um diese Verbindungen einwandfrei zu
erkennen. Die Konfiguration kann direkt im Geréat gespeichert werden, sie kann auch im PC gespeichert und spater
zum System-Prozessor Ubertragen werden.

Hinweis: Einrichten und Anderung der Pin-Konfiguration sind nur im Design-Modus méglich.

Eine neue Pin-Konfiguration erstellen
In den Design-Modus schalten.

2. Die Option [Devices>Control Pin Configuration] (Geréate>Steuerpin-Konfiguration) im
Hauptmeni wahlen.

3. Das Fenster ,Control Pins* (Steuerpins) wird eingeblendet.
Die Ansicht [Control In] (Steuerungs-Eingang) oder [Logic Out] (Logik-Ausgang) wahlen.
Die Preset-Steuerung konfigurieren.
a) Die Anzahl der Presets in das Wertefeld [# Presets] eingeben.
b) Einen Codierungstyp aus dem Pulldown-Meni [Encoding Type] wéhlen.
c) Der Preset-Steuerpinblock erscheint im Pin-Konfigurationsabschnitt des Fensters.

d) Wenn Prioritatscodierung fiir den Steuereingang verwendet wird, die entsprechenden Preset-
Nummern unter dem Preset-Steuerblock eingeben (siehe Abbildung 55 auf der folgenden Seite).

6. Verbliebene Pins fiir externe Steuereinheiten oder einen Logik-Ausgang konfigurieren, indem
eine Wahl aus dem Pulldown-Meni an der rechten Seite des Blocks vorgenommen wird.

SHURE® System-Prozessor P4800 Software-Bedienungsanleitung Seite 80 von 108



Steuerpins

Die Menuoption [Configuration>Store to Device] (Konfiguration>Im Gerét speichern) wahlen.
Das Dialogfeld ,Select Devices* (Gerate wahlen) wird eingeblendet.
Ein Gerat wahlen und auf [OK] klicken.

10. Die Pin-Konfiguration wird im Gerét gespeichert.
Eine Konfiguration im PC speichern

1. Die obigen Schritte 1 bis 6 ausfiihren.

2. Die Menuoption [Configuration>Store to PC] (Konfiguration>Im PC speichern) wahlen.

3. Das Dialogfeld ,Save Config As* (Konfiguration speichern unter) wird eingeblendet.

4. Zum gewinschten Verzeichnis gehen, einen Dateinamen eingeben und auf [OK] Kklicken.
5

Die Konfiguration wird im Computer als Datei mit der Dateinamenerweiterung ,,.PIN“
gespeichert.

Eine vorhandene Pin-Konfiguration bearbeiten
1. Inden Design-Modus schalten.

2. Die Option [Devices>Control Pin Configuration] (Gerate>Steuerpin-Konfiguration) im
Hauptmeni wahlen.

Das Fenster ,Control Pins" (Steuerpins) wird eingeblendet.

E

Die Menuoption [Configuration>Recall From Device] (Konfiguration>Vom Gerat abrufen)
wabhlen.

5. Das Dialogfeld ,Select Devices* (Gerate wahlen) wird eingeblendet.

6. Ein Gerat wahlen und auf [OK] klicken.

7. Das Fenster ,Control Pins“ wird mit der aktuellen Pin-Konfiguration gesetzt.

8. Die gewiinschten Anderungen vornehmen.

9. Die Menuoption [Configuration>Store To Device] (Konfiguration>Im Gerét speichern) wahlen.
10. Das Dialogfeld ,Select Devices" (Gerate wahlen) wird eingeblendet.

11. Ein Gerat wahlen und auf [OK] klicken.

12. Die Pin-Konfiguration wird im Gerat gespeichert.

Preset-Codierungstypen

Gegenwartig sind drei verschiedene Typen von Preset-Codierung fir Steuereingang und zwei fir
Steuerausgang verfugbar. Einen Codierungstyp gemafd der Art der Hardware, die an die Steuerpins
angeschlossen werden soll, der Anzahl der Presets, zwischen denen im Gerat umgeschaltet werden soll,
und der Anzahl der Pins, die fir andere Funktionen bendétigt werden, wahlen.

Prioritats- oder Eins-zu-Eins-Codierung

Maximale Anzahl der Presets: 8

Anzahl der erforderlichen Pins: 1 bis 8, einen flr jedes Preset

Durch Prioritats-Codierung fur Steuereingang und Eins-zu-Eins-Codierung %
fur Logik-Ausgang wird jede Pin-Verbindung einer eindeutigen Preset- i i r//
Nummer zugewiesen. Dies ist die Voreinstellung fur den Codierungstyp, l‘l
wenn bis zu 8 Presets in das Wertefeld [# Presets] eingegeben werden. ' '

Fir Steuereingang zeigt der Preset-Steuerblock unter jedem Pin ein

Wertefeld fur die Eingabe der Preset-Nummern an. Bei der ersten Anzeige L2 3 ] 4
des Blocks beginnen die Voreinstellungen bei 1 und erhdhen sich von Highest Lowest
links nach rechts. Diese Werte kdnnen geandert werden, indem in jedes Py Piiory
Feld geklickt und eine Nummer von 1 bis 128 eingegeben wird. Falls der Abbildung 55 -
Benutzer versehentlich eine Kombination der externen Steuerschalter Prioritats-Codierung

driickt, wechselt das Gerat zum Preset mit der héchsten Prioritét.
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Binare Codierung

Maximale Anzahl der Presets: 128
Anzahl der erforderlichen Pins: Siehe die rechts stehende Tabelle

Die bindre Codierung setzt eine Binarzahl einer Preset-Nummer des
System-Prozessors fur sowohl Steuereingang als auch Logikausgang Nr. der Presets Nr.der
. . . . - . . erforderlichen Pins
gleich. Dies ist die Voreinstellung fur den Codierungstyp, wenn 9 oder
mehr Presets in das Wertefeld [# Presets] eingegeben werden. 1
Der Binarcode entspricht den Spannungszustanden an den Steuerpins 4 2
an der Riickseite des System-Prozessors. 3
*  Logisch 0 = Pin spannungsfiihrend 16 4
= Logisch 1 = Pin massegeschlossen 32 5
Der Binarcode, den der System-Prozessor zum Codieren von Presets 64 6
verwendet, kann mit den nachstehenden Anweisungen berechnet 128 7

werden, oder siehe unter Anhang A auf Seite 94 fir vollstandige
Binarcodierungstabellen fir einen bis sieben Pins.

So wird die Preset-Nummer in einen Binarcode umgewandelt:
1. Von der Preset-Nummer den Wert 1 abziehen.
2. Das Ergebnis unter Beachtung der folgenden Regel in sein binares Aquivalent umwandeln:

Das hdchstwertigste Bit entspricht immer dem Pin 1 und das niedrigstwertigste Bit entspricht immer dem Pin
mit der héchsten Nummer unter denjenigen, die fir Preset-Steuerung verdrahtet wurden, wie unten in
Abbildung 56 dargestellt.

Beispiel - Preset Nr. 7:
= 7-1=6
® 6 in Binarform = 110

Bit 2 Bit1 BrO Bit3 B2 Bit1 B0 Bit 4 Bit 3 Bit 2 Bit 1 B0
(rsh) [lzb] sk [isb)

PIN PIN PIN PIN PIN PIN PIN PIN PIN PIN PIN PIN
1 2 3 1 2 3 4 i 2 3 4 5
1 1 0 [o 1 1 o [0 0o 1 1 o

Abbildung 56 - Binéare Codierung von Preset Nr. 7 fur drei, vier und funf Pins

Hinweis: Fur genaue Preset-Umschaltung am Steuereingang muss die binare Codierung fur jedes Preset
die gleiche Anzahl Bits enthalten, wie Steuerpins flr Preset-Codierung verdrahtet wurden. Links
vom Binarwert Nullen hinzufligen, bis die gleiche Anzahl von Ziffern wie verdrahtete Steuerpins
fur Preset-Codierung vorhanden sind, wie oben in Abbildung 56 dargestellt.

Benutzerdefinierte Schalter-Codierung (nur Steuereingang)

Maximale Anzahl der Presets: 10
Anzahl der erforderlichen Pins: 1

Die benutzerdefinierte Schalter-Codierung fur den Steuereingang setzt die Custom
Widerstandswerte den Preset-Nummern eins bis zehn gleich. Dieser Fézf:;‘;’l'
Codierungstyp ist nur verfugbar, wenn ein Wert von 10 oder niedriger in das

Wertefeld [# Presets] eingegeben wird. Aus der Tabelle 3 im Abschnitt Abbildung 57 —
»control Pins Connections der Gerate-Installationsanleitung sind weitere Benutzerdefinierte
Informationen dartiber ersichtlich, welcher Widerstandswert welchen Preset- Schalter-Codierung

Nummern entspricht.
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Verbindungstypen

Pins, die nicht fur Preset-Steuerung verwendet werden, kdnnen fir Prozessor-Steuerung und Logik-Ausgang
zugewiesen werden. Die folgende Tabelle veranschaulicht die verfiigbaren Optionen fur diese Verbindungen.
Auf das Pulldown-Menu klicken, das durch den gelben Pfeil an der rechten Seite des Zuweisungsblocks
gekennzeichnet ist, um einen Steuereinheitstyp zu wahlen.

Pinzuweisung Beschreibung EIN-/AUS ANG | Verwendungszweck

Zum Stummschalten von Ein- und Ausgangskanélen. Vorgesehen
fur Verwendung mit einer externen Steuereinheit, die zwischen zwei
Positionen wechselt. Kann auch mit einem nicht einrastenden
Einrastender Schalter EINGANG Schalter verwendet werden. In diesem Fall wird der Kanal bei
Driicken des Schalters stumm geschaltet, bei Loslassen des
Schalters wird die Stummschaltung aufgehoben.

Zum Stummschalten von Ein- und Ausgangskanélen. Vorgesehen
fur Verwendung mit einem externen nicht einrastenden Schalter.
Nicht einrastender Schalter EINGANG Bei jedem Driicken des Schalters wird die Stummschaltung
abwechselnd ein- und ausgeschaltet.

Dient zum Einstellen der Verstarkung in einem vom Benutzer

AN 100-kOhm-Potentiometer EINGANG definierten Bereich von maximal -30 dB bis +30 dB.
R _ Ubermittelt den Status der Stummschaltung an externe
| Logikausgang AUS GANG Vorrichtungen wie LEDs, Relais oder binére Logik-Hardware.

Prozessor-Zuordnung

Die Prozessor-Zuordnung ist die dritte und letzte Ebene der externen Steuerung. Damit externe Vorrichtungen die
Verstarkung und Kanal-Stummschaltung des System-Prozessors steuern bzw. den Stummschaltungs-Status
erkennen konnen, muss jedes Preset im Gerat den Steuerungsverbindungen zugeordnet werden. Prozessor-
Zuordnungstabellen werden mit den einzelnen Presets oder Szene-Dateien gespeichert. Die einzelnen Presets nach
einer der folgenden Methoden zuordnen.

= Eine Vorlage erstellen, die fiir die einzelnen Presets als Ausgangsbasis dienen soll.
= Die einzelnen Presets vom Gerat abrufen und eine Prozessor-Zuordnungstabelle hinzufiigen.
= Die einzelnen Szene-Dateien im PC 6ffnen und eine Prozessor-Zuordnungstabelle hinzufugen.

Hinweis: Vor der Erstellung einer Prozessor-Zuordnungstabelle miissen die Steuerpins
konfiguriert werden.

Eine Prozessor-Zuordnungstabellen-Vorlage erstellen

Wenn mehrere Presets im Gerat gespeichert werden sollen, kann beim Erstellen der Prozessor-
Zuordnungen Zeit gespart werden, indem eine Preset- oder Szene-Datei-Vorlage als Ausgangspunkt erstellt
wird. Diese Vorlage kann die Kanalnamen, die Prozessor-Zuordnungstabelle und andere allgemeine
Signalflusskonfigurationsdaten enthalten, die fiir jedes im jeweiligen Gerat gespeichertes Preset zutreffen.

So wird eine Preset-Vorlage, die eine Prozessor-Zuordnungstabelle enthélt, erstellt:

1. Im Design-Modus die Ein- und Ausgangskanale nach dem jeweiligen Geréat benennen.
(Siehe die Anweisungen dafur im Abschnitt Ein- und Ausgénge kennzeichnen auf Seite 17.)

2. Die Option [Devices>Control Pin Configuration] (Gerate>Steuerpin-Konfiguration) im
Hauptmeni wahlen.

Das Fenster ,Control Pins" (Steuerpins) wird eingeblendet.

4. Die gewtnschte Pin-Konfiguration mit einer der folgenden Methoden laden:
= Die Menuoption [Configuration>Open From PC] (Konfiguration>Vom PC 6ffnen) wahlen.

=  Bei Anschluss am System-Prozessor die Menuoption [Configuration>Recall From Device]
(Konfiguration>Vom Gerat abrufen) wéahlen.

5. Die Ein- und Ausgangskandle erscheinen im Fensterabschnitt mit der Prozessor-
Zuordnungstabelle unter den Verbindungsbldcken, die Steuereinheiten oder Logikausgangen
zugeordnet wurden.
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9.

Steuerpins

Fur jeden zugewiesenen Verbindungsblock auf die Prozessor-Zuordnungstabellen-
Kontrollkastchen neben den Kanélen klicken, auf die die Verbindung zugreift.

Das Fenster ,,Control Pins“ schlieRen.

Die Szene-Datei im PC speichern. (Siehe die Anweisungen dafir im Abschnitt Szene-Dateien
auf Seite 27.)

Diese Vorlage als Ausgangspunkt fur alle Presets verwenden, die fir das Gerat erstellt werden.

Ein vorhandenes Preset oder eine vorhandene Szene-Datei zuordnen

Vorhandene Presets kénnen zugeordnet werden, nachdem sie im Gerét gespeichert wurden, und Szene-
Dateien kénnen zugeordnet werden, nachdem sie im PC gespeichert wurden.

ook~ wbhPe

10.

o gk wbd e

10.

11.

12.

So wird ein vorhandenes Preset im Live-Modus zugeordnet:

Das Gerét in den Live-Modus schalten.

Das Preset wahlen, das zugeordnet werden soll.

Das Hauptfenster schaltet in den Vorschau-Modus.

Sicherstellen, dass das richtige Preset gewahlt wurde, und auf [Load] (Laden) klicken.
Das gewahlte Preset wird aktiv.

Die Option [Devices>Control Pin Configuration] (Gerate>Steuerpin-Konfiguration) im
Hauptmeni wahlen.

Das Fenster ,Control Pins* wird eingeblendet, wobei die Ein- und Ausgangskanéale unter den
zugewiesenen Pin-Verbindungen aufgelistet sind.

Fur jeden zugewiesenen Verbindungsblock auf die Prozessor-Zuordnungstabellen-
Kontrollkastchen neben den Kanalen klicken, auf die die Verbindung zugreift.

Die Zuordnung wird zusammen mit dem Preset im Gerét gespeichert.

Ein anderes Preset wahlen, das zugeordnet werden soll (es ist nicht erforderlich, das Fenster
~control Pins* zu schlieBen).

So wird eine vorhandene Szene-Datei im Design-Modus zugeordnet:
Sicherstellen, dass der Design-Modus aktiv ist.

Auf die Schaltflache [Open] (Offnen) in der Steuerleiste des Hauptfensters klicken.
Das Dialogfeld ,Open Scene” (Szene 6ffnen) wird eingeblendet.

Die Szene wahlen, die zugeordnet werden soll, und auf [OK] klicken.

Das gewahlte Preset wird im Signalflussdiagramm angezeigt.

Die Option [Devices>Control Pin Configuration] (Gerate>Steuerpin-Konfiguration) im
Hauptmeni wahlen.

Das Fenster ,Control Pins” (Steuerpins) wird eingeblendet.

Die gewlnschte Pin-Konfiguration mit einer der folgenden Methoden laden:

= Die Menioption [Configuration>Open From PC] (Konfiguration>Vom PC 6ffnen) wahlen.

=  Bei Anschluss am System-Prozessor die Menioption [Configuration>Recall From Device]
(Konfiguration>Vom Gerat abrufen) wahlen.

Fur jeden zugewiesenen Verbindungsblock auf die Prozessor-Zuordnungstabellen-
Kontrollkastchen neben den Kanélen klicken, auf die die Verbindung zugreift.

Zurtick zum Hauptfenster gehen (es ist nicht erforderlich, das Fenster ,Control Pins* zu
schlieRen).

Die Szene-Datei im PC speichern. (Siehe die Anweisungen dafur im Abschnitt Szene-Dateien auf
Seite 27.)

Eine andere Szene-Datei 6ffnen, die zugeordnet werden soll.
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Sicherheit

SICHERHEIT

Sicherheit ist ein optionales Merkmal, mit dem die installierende Person oder ein Sicherheits-Administrator den Zugriff
des Endbenutzers auf die Einstellungen des System-Prozessors Uber einen Computer einschranken kann. Der
Administrator ist die Person, die das Geratekennwort und die Zugangsstufe, mit dem das Gerét nach der Installation
arbeitet, einstellt. Es bestehen drei verschiedene Zugangsstufen fur das Gerét.

Stufe 1

Wenn das Geréat auf die Stufe 1 einstellt ist, hat der Benutzer uneingeschrankten Zugang zu den Funktionen
des System-Prozessors mit der Ausnahme von zwei Funktionen, die immer durch das Administrator-
Kennwort geschiitzt sind:

1. Einstellen der Sicherheitsstufe fur das Gerat

2. Andern des Administrator-Kennworts

Stufe 2

Bei Einstellung des Gerats auf die Stufe 2 hat der Benutzer eingeschréankten Zugang, der durch den
Sicherheits-Administrator definiert wird. Der nachstehende Zugang zum System-Prozessor kann fir die Stufe
2 zugelassen werden:

* Andern von Presets uber einen PC
= Andern der Matrixmischer-Signalfiihrung

»  Zugang zum Andern von Prozessor-Einstellungen fir alle Blécke, die nicht durch den
Administrator gesperrt wurden (siehe den Abschnitt Sicherheit individueller Prozessoren auf
Seite 87 fur weitere Informationen)

Stufe 3

Diese Stufe gestattet schreibgeschiitzten Zugang zu den Einstellungen des System-Prozessors fur das jeweils
aktive Preset.

Hinweis: Die Sicherheit betrifft nur den Zugang uber die Software-Schnittstelle. Sie schrankt die
Steuerung durch externe Gerate Uber die Steuerpins oder MIDI nicht ein.

Geratesicherheit einrichten

Die Einrichtung der Sicherheit ist der letzte Schritt bei der Einrichtung des Gerats. Fir die Einstellung der
Geréatesicherheit sind zwei hauptsachliche Schritte auszufiihren, wie nachstehend beschrieben.

Ein Kennwort einrichten

Bevor die Benutzer-Zugangsstufe im Gerat eingestellt werden
kann, muss das Kennwort eingerichtet Werden, mit dem der The administrater password allows setting and changing
Zugang als Sicherheits-Administrator geschiitzt wird. e e (oesiizlamees

So wird ein Kennwort eingerichtet:

Das Gerat in den Live-Modus schalten. Administrator Password:

Confirm Password:

2. [Security>Set Password] (Sicherheit>Kennwort einstellen) aus
dem Hauptmeni wahlen.

|
|
Administrator Marne: I
|

Phane or Contact infa:

3. Das Dialogfeld ,Create Password“ (Kennwort einrichten) wird

eingeblendet. Hel | Cancel | oK |
4. Ein Kennwort in das Feld [Administrator Password] Abbildung 58 - Dialogfeld ,Create
(Administrator-Kennwort) eingeben. Password* (Kennwort einrichten)

5. Durch Betatigung der Taste Tab zum Feld [Confirm Password]
(Kennwort bestatigen) gehen und das Kennwort erneut eingeben.

6. Die Felder [Administrator Name] (Administratorname) und [Phone or Contact info] (Telefon oder
Kontakt-Informationen) ausfullen.

Hinweis: Alle Eintrage im Dialogfeld ,Create Password“ sind auf eine Lange von flinfzehn
Zeichen beschrankt.
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Sicherheit

Benutzer-Zugangsstufe einstellen

Nach dem Einrichten eines Kennworts wird das Gerat
automatisch auf die Benutzer-Zugangsstufe 1 eingestellt. Wenn
der Zugang zum Gerat weiter eingeschrankt werden muss, das protected.

Gerat auf die gewlinschte Zugangsstufe einstellen. Enter a password below to gain access.

So wird die Benutzer-Zugangsstufe eingestellt: I

Password Required

The feature you attempted to access is password

1. Das Gerét in den Live-Modus schalten. Help | Cancel | [ oK |
2. [Security>Level] (Sicherheit>Stufe) aus dem Hauptmeni Abbildung 59 - Dialogfeld ,Password
wahlen. Required” (Kennwort erforderlich)

3. Das Dialogfeld ,Password Required” (Kennwort erforderlich)
wird eingeblendet.

. ) Set Security B
Das Kennwort eingeben und auf [OK] klicken. TPy v———
: K. |
Das Dialogfeld ,Set Security* (Sicherheit einstellen) wird " Level 1 - Full Access
eingeb|endet_ & Level 2 - Partial Access [ Custom Cancel |
¥ &llow preset switching via PC Help |
6. Auf das Optionsfeld links neben der gewilinschten Stufe I Allow changes in signal routing
klicken.  Level 3 - View Mode Only
7. Gegebenenfalls benutzerdefinierte Optionen fur die Stufe 2 Pz ol (o prasessss (et e fEl
Vorgeben lacked under Level 2 individual processor
) securiby.

8. Auf [OK] klicken.

Abbildung 60 - Dialogfeld ,Set Security*

(Sicherheit einstellen)

Geratesicherheit andern

Falls Anderungen an der Geréatekonfiguration oder den Sicherheitseinstellungen notwendig werden, nachdem der Zugang

eingeschrankt wurde, muss zuerst die Geratesicherheit zurtick auf die Stufe 1 zurtickgestellt werden.

Hinweis: Fur diese Funktionen wird das Kennwort des Sicherheits-Administrators benotigt.

Zugangsstufe andern

Die obigen Anweisungen zum Einstellen der Zugangsstufe ausfuihren.

Das Kennwort andern

So wird ein vorhandenes Kennwort geandert:

Set Password

click help for more options.

1. Das Gerat in den Live-Modus schalten.

If pou fogot the old password, contact the Administrator or

2. [Security>Set Password] (Sicherheit>Kennwort einstellen) 0ld Password: [
aus dem Hauptmeni wéhlen. Adinistrator Password: [~

3. Das Dialogfeld ,Set Password” (Kennwort einstellen) wird Confim Password: [
eingeblendet. Der Cursor befindet sich im Feld [Old Administratar Mame: [<oncpka
Password] (Altes Kennwort). Phone or Contact info:  [585-6262

4. Das aktuelle Kennwort eingeben.
Help | Cancel |

Durch Betatigung der Taste Tab zum Feld [Administrator
Password] (Administrator-Kennwort) gehen und das neue
Kennwort eingeben.

6. Durch Betatigung der Taste Tab zum Feld [Confirm Password] (Kennwort bestétigen) gehen
und das neue Kennwort erneut eingeben.

7. Gegebenenfalls die Felder [Administrator Name] (Administratorname) und [Phone or Contact
info] (Telefon oder Kontakt-Informationen) andern.

8. Auf [OK] klicken.

Hinweis: Alle Eintrage im Dialogfeld ,Set Password“ sind auf eine Lange von fiinfzehn
Zeichen beschrankt.

Abbildung 61 - Dialogfeld ,Set Password"
(Kennwort einstellen)
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Sicherheit

Sicherheit aufheben

Die Geratesicherheit kann vollstandig zuriick auf die Voreinstellung gesetzt werden, sodass andere ein
Administrator-Kennwort einstellen und Benutzer-Zugangsstufen definieren kénnen.

So wird der Kennwortschutz entfernt:
Das Gerat in den Live-Modus schalten.
[Security>Set Password] (Sicherheit>Kennwort einstellen) aus dem Hauptmeni wahlen.

Das Dialogfeld ,Set Password“ (Kennwort einstellen) wird eingeblendet, wie in Abbildung 61 auf
der vorigen Seite dargestellt.

Das aktuelle Kennwort in das Feld [Old Password] (Altes Kennwort) eingeben und die
Eingabetaste driicken oder auf [OK] Kklicken.

Gegebenenfalls den Administratornamen und die Kontaktinformationen léschen.

Die Felder [Administrator Password] (Administrator-Kennwort) und [Confirm Password]
(Kennwort bestatigen) leer lassen.

Auf [OK] klicken.

Damit sind alle Zugangseinschrankungen aufgehoben.

Hinweis: Die Sicherheitsattribute individueller Prozessorblocke bleiben bestehen, sind aber

unwirksam, bis das Geréat auf die Zugangsstufe 2 eingestellt wird.

Sicherheit individueller Prozessoren

Durch individuelle Prozessorsicherheit wird der Zugang zu bestimmten Prozessorblécken in einem Preset gesperrt.
Es ist moglich, den Zugang zu einem einzelnen Block, zu mehreren Bldcken oder zu allen Blocken in einem Preset
zu sperren. Diese Funktion kann beispielsweise verwendet werden, wenn der Endbenutzer in der Lage sein soll,
Verstarkungseinstellungen zu andern, aber nicht PEQ-Einstellungen. Ein gesperrter Prozessor kann immer noch
geodffnet werden, um Pegelanzeigen zu Uberwachen oder Einstellungen einzusehen.

Wahrend die Benutzer-Zugangsstufe geratespezifisch ist, ist die Prozessorblock-Sicherheit presetspezifisch.
AuRRerdem ist die individuelle Prozessorsicherheit ein separates Attribut eines jeden Blocks. Wenn beispielsweise ein
gesperrter Block kopiert wird, wird dieses Sicherheitsattribut mit dem Block kopiert. Dieses Attribut bleibt beim
Arbeiten im Design-Modus und Live-Modus bestehen.

A w DN PR

So werden Prozessorbldocke gesperrt:

Das Gerét in den Live-Modus schalten.

Sicherstellen, dass das Geréat auf die Sicherheitsstufe 1 eingestellt ist.

Durch Klicken einen Prozessorblock markieren oder mit Strg+Klicken mehrere Blocke wahlen.

[Security>Level 2>Lock Selected] (Sicherheit>Stufe 2>Sperre gewahlt) aus dem Hauptmeni
wahlen.

Neben dieser Menuloption wird ein Hakchen eingetragen, um darauf hinzuweisen, dass der
gewahlte Prozessor gesperrt ist.

Das Gerat auf die Benutzer-Zugangsstufe 2 einstellen.

Hinweis: Es ist moglich, Prozessorblocke im Design-Modus zu sperren, aber dies wird erst

wirksam, wenn die Szene-Datei in einem Gerat als Preset gespeichert und die Sicherheit
dieses Gerats auf die Stufe 2 eingestellt wird.
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BERICHTE DRUCKEN

Berichte Drucken

Die Software des P4800 kann Berichte zur Dokumentation aller im Gerat gespeicherten Presets und Einstellungen

drucken. Diese Berichte sind fur die folgenden Zwecke vorgesehen.

1. Dokumentation der Geratekonfiguration fir den Kunden und Endbenutzer

2. Erstellung einer Sicherheitskopie auf Papier, sodass die Geratekonfiguration erforderlichenfalls

rekonstruiert werden kann

Hinweis: Die Berichte werden direkt zu einem Drucker und nicht in eine Datei ausgegeben,
sodass zur Verwendung dieser Funktion ein Drucker angeschlossen sein muss.

So werden P4800-Berichte gedruckt:
1. [File>Print] (Datei>Drucken) aus dem Hauptmeni wahlen.

2. Das Dialogfeld ,,Choose Report” (Bericht wéhlen) wird
eingeblendet.

Auf den Bericht klicken, der gedruckt werden soll.
4. Ein Dialogfeld wird fiir den gewahlten Bericht eingeblendet.

Die Informationen, die in den Bericht aufgenommen werden
sollen, nach den Anweisungen im folgenden Abschnitt
festlegen.

6. Auf [OK] klicken.

7. Das Windows-Dialogfeld ,Print“ (Drucken) wird eingeblendet.

P4800-Berichte
Gerateinformationen

Chooze Report E

— Scope

" Device

" Individual Prezets from Device
¢ Currently Displayed Prezet or Scene

¢~ Individual Processor Blocks

Cancel | Help

Abbildung 62 - Dialogfeld ,,Choose Report*
(Bericht wahlen)

Der Bericht ,Device Information“ (Gerateinformationen) listet alle Informationen auf Geréteebene mit
Ausnahme des Sicherheits-Kennworts auf. Wenn das Dialogfeld ,Device Information” eingeblendet wird, aus
der Pulldown-Liste [Device] (Gerat) das Gerat wahlen, fur das ein Bericht gedruckt werden soll. Die
Informationen fir das gewahlte Gerat eingeben und auf [OK] klicken. Die hier eingegebenen Informationen
werden nur im anschlieBenden Bericht gedruckt, aber nicht fur zukinftige Verwendung gespeichert. Fir ein

Muster dieses Berichts siehe Seite 90.

]|

Device
Device : IGymna&ium j
Location : |4325 W, Divizion, Chicago
Clietit : |Sau:red Heart 5chool
Designer : IBCIb Rieiling
Irstaller : IFH: Communications

Syztem Description :

kain Gymnasium System Processor

o |

Cancel

Abbildung 63 - Dialogfeld ,Device
Information“ (Gerate-Informationen)
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Berichte Drucken

Preset-Informationen und Informationen Uber das aktuelle Preset

Der Bericht ,Preset Information“ (Preset-Informationen) listet die Einzelheiten tber ein bestimmtes, im Gerat
gespeichertes Preset auf. Wenn das Dialogfeld ,Preset Information“ eingeblendet wird, aus der Pulldown-
Liste [Device] (Gerat) das Gerat wahlen, fur das ein Bericht gedruckt werden soll. Dann das Preset wahlen,
fur das ein Bericht gedruckt werden soll, und auf [OK] klicken. Fir ein Muster dieses Berichts siehe Seite 91
und 92.

Der Bericht ,Current Preset Information“ (Informationen Uber das aktuelle Preset) ist identisch dazu. Er
enthélt die Einzelheiten des Presets oder der Szene, das/die gerade angezeigt wird.

Individual Presets from Device |

Currently Dizplayed Prezet or Scene | x|

Device IGymnasium

Preset: | Mumber | Marme Cancel |

Frintz Report for the Currentliy

Prezet 1 Concert

Pregeat 2 Azzembly Dizplayed Preset or Scene
Preset 3 Garne irt the kain Window
Preszet 4 Dance

Cancel |

Abbildung 64 - Dialogfeld ,Preset Information*” Abbildung 65 - Dialogfeld ,,Current Preset Information”
(Preset-Informationen) (Informationen Uber das aktuelle Preset)

Prozessor-Informationen

Der Bericht ,Processor Information“ (Prozessor-Informationen) listet die Einstellungen von einem oder
mehreren Prozessorblécken auf. Im Dialogfeld ,Processor Information“ wird eine Liste aller festen und
verschiebbaren Prozessoren aus der angezeigten Szene oder dem angezeigten Preset angezeigt. Einen
Prozessor durch Klicken oder mehrere mit UmscHALTTASTE+KIlicken wéhlen und dann auf [OK] klicken. Fur
ein Muster dieses Berichts siehe Seite 93.

Individual Processor Blocks |

Select Proceszzor Blocks from the currently
dizplayed scene or prezet

[

Farametric EQ in Top Cir 8% (1] - UnLocked

Cut and Shelf in Top Cir 5'z [2] - UnLocked

PEQ with C5 in Too LR 5= 111 - UnLacked T

(] I Cancel |

Abbildung 66 - Dialogfeld ,Processor Information”
(Prozessor-Informationen)
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Muster der Berichte

Berichte Drucken

DEVICE INFORMATION

Installation Information:

Location:
Client:
Designer:
Installer:

System Description:

4325 W. Division, Chicago
Sacred Heart School
Bob Reiling

RC Communications

Main Gymnasium System Processor

Hardware Information:

ShureLink Device ID:

Device Name:

15

Gymnasium

Pin-5: Switch
Pin-6: Potentiometer
Pin-7: Potentiometer

Pin-5: Logic Control

Preset Information:

Total Presets:

lof1l

Control Input Pin Configuration:

Pin-1: Encoding Type: Priority, Mapped to preset: 1
Pin-2: Encoding Type: Priority, Mapped to preset: 2
Pin-3: Encoding Type: Priority, Mapped to preset: 3
Pin-4: Encoding Type: Priority, Mapped to preset: 4

Pin-8: NONE [DISABLED]

Control Output Pin Configuration:

Pin-1: Encoding Type: One to One, Mapped to preset: 1
Pin-2: Encoding Type: One to One, Mapped to preset: 2
Pin-3: Encoding Type: One to One, Mapped to preset: 3
Pin-4: Encoding Type: One to One, Mapped to preset: 4

Pin-6: Logic Control [DISABLED]
Pin-7: Logic Control [DISABLED]
Pin-8: Logic Control [DISABLED]

4
Preset1 Concert
Preset 2 Assembly
Preset3 Game

Preset 4 Dance

March 29, 2001, 11:11AM
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Berichte Drucken

PRESET INFORMATION:

Preset ID: 2
Preset Name: Assembly

Descripiton: Preliminary tuning.

Design Mode

Create and Manage Scenes

o S

Maininput

DHNEEE: | oam e

Control Input Pin Mapping:

Pin-1: Reserved for Preset Control - See Device Information
Pin-2: Reserved for Preset Control - See Device Information
Pin-3: Reserved for Preset Control - See Device Information
Pin-4: Reserved for Preset Control - See Device Information
Pin-5: Mutes: Input: 2

Pin-6: Gains: Input: 1 2, Gain Range: -30.0 to 30.0 dB

Pin-8: N/A

Control Output Pin Mapping:

Pin-1: Reserved for Preset Display - See Device Information
Pin-2: Reserved for Preset Display - See Device Information
Pin-3: Reserved for Preset Display - See Device Information
Pin-4: Reserved for Preset Display - See Device Information
Pin-5: Mutes: Input: 2

Pin-6: Mutes: N/A

Pin-7: Mutes: N/A

Pin-8: Mutes: N/A

1of2

gullm ™ B B

Pin-7: Gains: Output: 123456 7 8, Gain Range: -30.0 to 30.0 dB

Under bacl

March 29, 2001, 11:12AM
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Berichte Drucken

Drag and Drop Processors:

Input-1, Slot-1, Processor:
Input-1, Slot-2, Processor:
Input-1, Slot-3, Processor:
Input-1, Slot-4, Processor:
Input-1, Slot-5, Processor:

Input-2, Slot-1, Processor:
Input-2, Slot-2, Processor:
Input-2, Slot-3, Processor:
Input-2, Slot-4, Processor:
Input-2, Slot-5, Processor:

PEQ 10CS
N/A

N/A

N/A

SFT LIM

PEQ 10CS
GEQ30
N/A

N/A

N/A

Input-3, Slot-1, Processor:
Input-3, Slot-2, Processor:
Input-3, Slot-3, Processor:
Input-3, Slot-4, Processor:
Input-3, Slot-5, Processor:

Input-4, Slot-1, Processor:
Input-4, Slot-2, Processor:
Input-4, Slot-3, Processor:
Input-4, Slot-4, Processor:
Input-4, Slot-5, Processor:

N/A
N/A
N/A
N/A
N/A

N/A
N/A
N/A
N/A
N/A

Output-1, Slot-1, Processor:
Output-1, Slot-2, Processor:
Output-1, Slot-3, Processor:
Output-1, Slot-4, Processor:
Output-1, Slot-5, Processor:
Output-1, Slot-6, Processor:

Output-2, Slot-1, Processor:
Output-2, Slot-2, Processor:
Output-2, Slot-3, Processor:
Output-2, Slot-4, Processor:
Output-2, Slot-5, Processor:
Output-2, Slot-6, Processor:

Output-3, Slot-1, Processor:
Output-3, Slot-2, Processor:
Output-3, Slot-3, Processor:
Output-3, Slot-4, Processor:
Output-3, Slot-5, Processor:
Output-3, Slot-6, Processor:

Output-4, Slot-1, Processor:
Output-4, Slot-2, Processor:
Output-4, Slot-3, Processor:
Output-4, Slot-4, Processor:
Output-4, Slot-5, Processor:
Output-4, Slot-6, Processor:

20f2

PEQ 10CS
CUT/SHELF
N/A

N/A

N/A

N/A

PEQ 5CS
N/A
N/A
N/A
N/A
N/A

PEQ 5CS
N/A
N/A
N/A
N/A
N/A

PEQ 5CS
N/A

N/A

N/A

N/A

DLY 150ms

Output 5, Slot-1, Processor:
Output-5, Slot-2, Processor:
Output-5, Slot-3, Processor:
Output-5, Slot-4, Processor:
Output-5, Slot-5, Processor:
Output-5, Slot-6, Processor:

Output-6, Slot-1, Processor:
Output-6, Slot-2, Processor:
Output-6, Slot-3, Processor:
Output-6, Slot-4, Processor:
Output-6, Slot-5, Processor:
Output-6, Slot-6, Processor:

Output-7, Slot-1, Processor:
Output-7, Slot-2, Processor:
Output-7, Slot-3, Processor:
Output-7, Slot-4, Processor:
Output-7, Slot-5, Processor:
Output-7, Slot-6, Processor:

Output-8, Slot-1, Processor:
Output-8, Slot-2, Processor:
Output-8, Slot-3, Processor:
Output-8, Slot-4, Processor:
Output-8, Slot-5, Processor:
Output-8, Slot-6, Processor:

March 29, 2001, 11:12AM

PEQ 5CS
N/A
N/A
N/A
N/A
DLY 150ms

PEQ 5CS
N/A

N/A

N/A

N/A

DLY 150ms

N/A

N/A

AGC

SFT LIM
N/A

DLY 150ms

PEQ 3CS
N/A

AGC

LIM

N/A

DLY 150ms
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Berichte Drucken

PROCESSOR INFORMATION:

Input Gain Block

Security: Unlocked

Input-1:, Name: Main input, Operating Level: +4 dBu, Polarity: +, Gain: -4.5dB, Pad: On, Mute: Off, Link Group: N/A
Input-2:, Name: Foyer, Operating Level: +4 dBu, Polarity: +, Gain: 8.5dB, Pad: On, Mute: Off, Link Group: N/A
Input-3:, Name: Record AUX, Operating Level: +4 dBu, Polarity: +, Gain: 0.0dB, Pad: On, Mute: On, Link Group: N/A
Input-4:, Name: Not used, Operating Level: +4 dBu, Polarity: +, Gain: -4.5dB, Pad: On, Mute: Off, Link Group: N/A

Input-1, Slot-1, Processor: PEQ 10CS
Name: PEQ with CS, Link Group: N/A, Security: Unlocked
Bypass: Off

Filter: L, Type: Shelf, Freq: 0.0kHz, Gain: 0.0dB, Width(oct):
Filter: H, Type: Shelf, Freq: 20.0kHz, Gain: 0.0dB, Width(oct):
Filter: 3, Freq: 0.1kHz, Gain: -2.0dB, Width(oct): 2/3

Filter: 4, Freq: 2.2kHz, Gain: -6.0dB, Width(oct): 1/10

Filter: 5, Freq: 0.3kHz, Gain: -4.5dB, Width(oct): 1/3

Filter: 6, Freq: 5.0kHz, Gain: 2.5dB, Width(oct): 1

Filter: 7, Freq: 2.7kHz, Gain: -3.0dB, Width(oct): 1/2

Input-1, Slot-5, Processor: SFT LIM
Name: Soft Limiter, Link Group: N/A, Security: Unlocked
Bypass: Off

Threshold: 9.5 VU, Attack: 2ms, Ratio: 100.0, Decay: 50ms
Input Gain: 0.00, Output Gain: 0.00

Knee Soft

Input-2, Slot-1, Processor: PEQ 10CS

Name: PEQ with CS, Link Group: N/A, Security: Unlocked
Bypass: Off

Filter: L, Type: Shelf, Freq: 0.1kHz, Gain: -18.5dB, Width(oct):
Filter: H, Type: Shelf, Freq: 10.9kHz, Gain: -18.5dB, Width(oct):
Filter: 3, Freq: 4.3kHz, Gain: -9.0dB, Width(oct): 2/3

Filter: 4, Freq: 0.7kHz, Gain: 4.5dB, Width(oct): 1

Filter: 5, Freq: 0.2kHz, Gain: -9.0dB, Width(oct): 1/6

Filter: 6, Freq: 0.1kHz, Gain: -6dB, Width(oct): 1/3

Filter: 7, Freq: 6.8kHz, Gain: -6.0dB, Width(oct): 1/6
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ANHANG A: TABELLEN FUR BINARE CODIERUNG

Die folgenden Tabellen enthalten die Binarcodes fiir die Presets des System-Prozessors. Diese Codierung auf die
Steuerungs-Eingangspins anwenden, um das Geréat zum entsprechenden Preset umzuschalten. Der System-
Prozessor gibt das jeweils aktuelle Preset an den Logikausgangspins mit dieser Codierung an.

Binére Codierung uber ein Pin

PRESET Nr. PIN 1
1 o}
2 |

Binare Codierung tber zwei Pins

PRESET Nr. PIN 1 PIN 2
1 O O
2 O |
3 | 0]
4 | |

Binare Codierung tber drei Pins

PRESET Nr. PIN 1 PIN 2 PIN 3
1 O O O
2 O O |
3 O | O
4 (0] | |
5 | (0] (0]
6 | 0] |
7 | | 0]
8 | | |

0 = Pin spannungsfihrend 1 = Pin massegeschlossen
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Binare Codierung tber vier Pins

PRESET PIN 1 PIN 2 PIN 3 PIN 4

Nr.

1 O O O O
2 O O O |
3 O O | O
4 O O | |
5 O | O O
6 O | O |
7 O | | O
8 O | | |
9 | O O O
10 | O O |
11 | O | O
12 | O | |
13 | | O O
14 | | O |
15 | | | O
16 | | | |

0 = Pin spannungsfihrend 1 = Pin massegeschlossen

Anhang A
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Binare Codierung tber funf Pins

PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5
1 O O O O O
2 O O O O |
3 O O O | O
4 (0] (0] (0] | |
5 O O | O O
6 O 0] | 0] |
7 (0] (0] | | (0]
8 (0] (0] | | |
9 O | 0] O O
10 O | O 0] |
11 (0] | (0] | (0]
12 O | O | |
13 O | | 0] 0]
14 (0] | | (0] |
15 (0] | | | (0]
16 O | | | |
17 | 0] O O O
18 | (0] (0] (0] |
19 | O 0] | O

20 | 0] 0] | |
21 | (0] | (0] (0]
22 | (0] | (0] |
23 | 0] | | O
24 | (0] | | |
25 | | (0] (0] (0]
26 | | O O |
27 | | O | O
28 | | (0] | |
29 | | | (0] (0]
30 | | | O |
31 | | | | (0]
32 | | | | |

0 = Pin spannungsfihrend 1 = Pin massegeschlossen

Anhang A
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Binare Codierung tber sechs Pins

PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6
1 O O O O O O
2 O O O O O |
3 O O O O | O
4 (0] (0] (0] (0] | |
5 O O O | O O
6 O O O | O |
7 (0] (0] (0] | | (0]
8 (0] (0] (0] | | |
9 O O | O O O
10 O 0] | O O |
11 (0] (0] | (0] | (0]
12 O 0] | 0] | |
13 O 0] | | O O
14 (0] (0] | | (0] |
15 (0] (0] | | | (0]
16 O 0] | | | |
17 O | 0] O O O
18 (0] | (0] (0] (0] |
19 O | O 0] | 0]
20 O | O 0] | |
21 (0] | (0] | (0] (0]
22 (0] | (0] | (0] |

23 O | O | | O
24 O | O | | |
25 (0] | | (0] (0] (0]
26 O | | 0] O |
27 O | | 0] | 0]
28 (0] | | (0] | |
29 (0] | | | (0] (0]
30 O | | | 0] |
31 (0] | | | | (0]
32 (0] | | | | |
33 | O 0] O O O
34 | 0] 0] O O |
35 | (0] (0] (0] | (0]
36 | (0] (0] (0] | |
37 | O 0] | 0] O
38 | (0] (0] | (0] |
39 | (0] (6] | | (0]
40 | (0] O | | |
41 | O | 0] O O
42 | (0] | (0] (0] |
43 | (0] | (0] | (0]
44 | 0] | O | |

0 = Pin spannungsfihrend 1 = Pin massegeschlossen

Anhang A
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PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6
45 | 0] | | O O
46 | 0] | | O |
47 | O | | | O
48 | (0] | | | |
49 | | (0] (0] (0] (0]
50 | | 0] O O |
51 | | (0] (0] | (0]
52 | | (0] (0] | |
53 | | 0] | 0] O
54 | | O | O |
55 | | (0] | | (0]
56 | | (0] | | |
57 | | | O O 0]
58 | | | (0] (0] |
59 | | | (0] | (0]
60 | | | O | |
61 | | | | O O
62 | | | | (0] |
63 | | | | | (0]
64 | | | | | |

0 = Pin spannungsfihrend 1 = Pin massegeschlossen

Anhang A
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Binare Codierung tber sieben Pins

Anhang A

PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 PIN 7
1 o} o} o} o O O o}
2 o o o o} o o [
3 o} o} o} o o} | O
4 o} o} o} o} O | |
5 o} o} o} o [ O O
6 o} o} o} o [ O |
7 o o o o [ | o
8 o o o o [ | [
9 o o o [ o o o}
10 o o o [ o o [
11 o} o} o} | O | O
12 o} o} o} | o} | |
13 o} o} o} | | o} o}
14 o} o} o} | | o} |
15 o o o [ [ [ o
16 o o o | [ [ |
17 o o [ o o o o}
18 o o [ o o o [
19 o} o} | o o | O

20 o} o} | o o | |
21 o} o} | o} | o} o
22 o} o} | o} | o} |
23 o o [ o [ | o
24 o O [ o [ | [
25 o o [ [ o o o
26 o o [ [ o O |
27 o} o} | | o} | o}
28 o} o} | | o} | |
29 o} o} | | | o} o}
30 o} o} | | | o} |
31 o o | | [ | O
32 o o | | [ | |
33 o [ o o} O o o
34 o [ o o} O o [
35 o} | o} o} o} | o}
36 o} | o} o} o} | |
37 o} | o} o} | o} O
38 o} | o} o} | o} |
39 o} | o} o} | | O
40 o | o o [ | [
41 o | o | o o o
42 o | o | o o [
43 o | o | o | o
44 o} | o} | o} | |
45 o} | o} | | o} o}
46 o} | o} | | o} |
47 o} | o} | | | o

0 = Pin spannungsfihrend 1 = Pin massegeschlossen
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PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 PIN 7
48 (0] | (0] | | | |
49 O | | 0] O O O
50 (0] | | (0] (0] (0] |
51 (0] | | (0] (0] | (0]
52 (0] | | (0] (0] | |
53 (0] | | (0] | (0] (6]
54 O | | 0] | O |
55 O | | 0] | | O
56 O | | O | | |
57 O | | | O O O
58 (0] | | | (0] (0] |
59 (0] | | | (0] | (0]
60 (0] | | | (0] | |
61 (0] | | | | (0] (0]
62 (0] | | | | (0] |
63 O | | | | | (0]
64 O | | | | | |
65 | 0] O O O O O
66 | O 0] O O O |
67 | (0] (0] (0] (0] | (0]
68 | (0] (0] (0] (0] | |
69 | (0] (0] (0] | (0] (0]
70 | (0] (0] (0] | (0] |
71 | 0] O O | | O
72 | 0] 0] O | | |
73 | 0] O | O O O
74 | O 0] | 0] O |
75 | (0] (0] | (0] | (0]
76 | (0] (0] | (0] | |
77 | (0] (0] | | (0] (0]
78 | (0] (0] | | (0] |
79 | (0] O | | | O
80 | (0] O | | | |
81 | 0] | O O O O
82 | O | (0] 0] O |
83 | (0] | (0] (0] | (0]
84 | (0] | (0] (0] | |
85 | (0] | (0] | (0] (0]
86 | (0] | (0] | (0] |
87 | 0] | O | | O
88 | 0] | O | | |
89 | O | | O 0] 0]
90 | 0] | | O O |
91 | (0] | | (0] | (0]
92 | (0] | | (0] | |
93 | (0] | | | (0] (0]
94 | (0] | | | (0] |
o5 | (0] | | | | O
96 | (0] | | | | |

0 = Pin spannungsfihrend 1 = Pin massegeschlossen
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PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 PIN 7
97 | | o} o} o} o} o}
98 [ [ o o o o [
99 | | o} o} o} | o}
100 | | o} o} o} | |
101 | | o} o} | o} o}
102 | | o} o} | o} |
103 [ | o o [ | o
104 [ | o o [ | [
105 [ [ o [ o o o
106 [ [ o [ o o [
107 | | o} | o} | o}
108 | | O | o} | |
109 | | o | | o o}
110 | | o} | | o} |
111 | | o} | | | o}
112 [ | o [ | [ [
113 [ [ | o 0o o o
114 [ | | o o o [
115 [ | | o o | o
116 | | | o} o} | |
117 | | | o} | o} o}
118 | | | o | o} |
119 | | | o} | | o}
120 [ | | o | [ [
121 [ [ [ [ o o o
122 [ [ [ [ o o |
123 [ [ [ [ o [ o
124 | | | | o} | |
125 | | | | | o} o}
126 | | | | | o} |
127 | | | | | | o}
128 [ [ [ [ [ [ |

0 = Pin spannungsfihrend 1 = Pin massegeschlossen
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ANHANG B: DSP-AUSLASTUNG PRO PROZESSOR

Anhang B

Die folgende Tabelle fihrt den Prozentsatz der DSP-Ressourcen auf, den die einzelnen Prozessoren belegen. Die
DSP-Ressourcen werden durch folgende Faktoren bestimmt:

Kombination der verwendeten Prozessoren
Anordnung der Prozessoren im Signalflussdiagramm

Die erste Spalte [% des DSP] fuhrt den Prozentsatz der DSP-Ressourcen auf, die jeder Prozessor in einem P4800
mit einer Seriennummer, die mit dem Buchstaben N oder hdher beginnt, belegt.

Die zweite Spalte [% des DSP] fuhrt den Prozentsatz der DSP-Ressourcen auf, die jeder Prozessor in einem P4800
mit einer Seriennummer, die mit den Buchstaben L oder M beginnt, belegt.

Hinweis:Sie kénnen die DSP-Ressourcen, die eine Konfiguration belegt, nicht genau schatzen,
indem Sie lediglich die in dieser Tabelle aufgefiihrten Prozentséatze addieren.

% des % d
DSP N 0 des
KATEGORIE BLOCKNAME BESCHREIBUNG oder DSPL
héher oder M
Grafischer GEQ 10 Grafischer Equalizer mit 10 Bandern 3,5 3,9
Equalizer GEQ 30 Grafischer Equalizer mit 30 Bandem 7,7 8,5
Parametrischer PEQ 3 Parametrischer Equalizer mit 3 Bandern 2,1 2,3
Equalizer PEQ5 Parametrischer Equalizer mit 5 Béandern 2,5 2,8
PEQ 7 Parametrischer Equalizer mit 7 Béandern 2,9 3,3
PEQ 10 Parametrischer Equalizer mit 10 Bandern 3,5 3,9
PEQ3+C/S Parametrischer Equalizer mit 3 Bandern mit Filtern mit steilflankiger/Kuhschwanz- 2,5 2,8
Charakteristik
PEQ5+C/S Parametrischer Equalizer mit 5 Bandern mit Filtern mit steilflankiger/Kuhschwanz- 2,9 3,3
Charakteristik
PEQ 7 +C/S Parametrischer Equalizer mit 7 Bandern mit Filtern mit steilflankiger/Kuhschwanz- 3,3 3,7
Charakteristik
PEQ 10 + C/S Parametrischer ~ Equalizer mit 10  Béndern  mit  Filtern  mit 4,0 4,4
steilflankiger/Kuhschwanz-Charakteristik
CUT/SHELF Hpch- und Niederfreq.uenz-FiIter mit steilflan.kiger Charakteristik/Hoch- und 2,7 30
Niederfrequenz-Filter mit Kuhschwanz-Charakteristik '
Ruckkopplungs- | DFR5 Digitale Riickkopplungsreduzier-Stufe mit 5 Bandern 111 12,4
Reduzierung DFR10 Digitale Riickkopplungsreduzier-Stufe mit 10 Bandern 12,4 13,8
Delay DLY 5ms Maximale Verzdgerung von 5 ms 3,3 3,7
DLY 150ms Maximale Verzdgerung von 150 ms 3,3 3,7
DLY 500ms Maximale Verzdgerung von 500 ms 3,3 3,7
DLY 2s Maximale Verzdgerung von 2 Sekunden 3,3 3,7
Dynamik COMP Kompressor 2,1 2,3
SFT COMP Kompressor - Soft-Knee-Option 2,3 2,6
ST COMP Stereo-Kompressor 4,2 4,6
SFT ST COMP Stereo-Kompressor - Soft-Knee-Option 5,6 6,2
LIM Limiter 2,1 2,3
SFT LIM Limiter - Soft-Knee-Option 2,3 2,6
ST LIM Stereo-Limiter 4,2 4,6
SFT ST LIM Stereo-Limiter - Soft-Knee-Option 5,6 6,2
AGC Automatische Verstarkungsregelung 2,9 3,2
GATE Gate 2,4 2,7
DOWN EXP Abwaérts-Expander 2,4 2,7
PEAKLIM Peak-Stop-Limiter 2,8 3,2
DUCK Ducker 3,5 3,9
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Frequenzweiche | XOVER 2 2-Wege-Frequenzweiche 3,7 4,1
XOVER 3 3-Wege-Frequenzweiche 4,7 52
XOVER 4 4-Wege-Frequenzweiche 57 6,4
XOVER 5 5-Wege-Frequenzweiche 6,7 7,5
SPLIT 2 2-Wege-Verteiler 0,9 1,0
SPLIT 3 3-Wege-Verteiler 1,0 11
SPLIT 4 4-Wege-Verteiler 1,2 1,3
SPLIT5 5-Wege-Verteiler 1,4 15
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ANHANG C: DATEINAMENERWEITERUNGEN

Anhang C

Die folgende Tabelle enthalt die Erweiterungen der verschiedenen Dateitypen, die von der System-
Prozessor-Software erzeugt werden.

2?\:\2322?}2_ Herkunft

.agc Automatische Verstarkungsregelung

.backup Gesamte Gerate-Datensicherung

.cdk Ein- und Ausgangsverstarkung

.comp Kompressor

.cutshf Hoch- und Niederfrequenz-Filter mit steilflankiger
Charakteristik/Hoch- und Niederfrequenz-Filter mit
Kuhschwanz-Charakteristik

.dfr10 Digitale Ruckkopplungsreduzier-Stufe mit 10 Bandern

.dfr5 Digitale Ruckkopplungsreduzier-Stufe mit 5 Bandern

.dly150ms Maximale Verzdgerung von 150 ms

dly2s Maximale Verzdgerung von 2 Sekunden

.dly500ms Maximale Verzdgerung von 500 ms

.dly5ms Maximale Verzdgerung von 5 ms

.duck Ducker

.exp Abwarts-Expander

.gate Gate

.geq10 Grafischer Equalizer mit 10 Bandern

.geq30 Grafischer Equalizer mit 30 Bandern

im Limiter

.mix Matrixmischer

.peaklim Peak-Stop-Limiter

.peql0 Parametrischer Equalizer mit 10 Bandern

.peqlOcs Parametrischer Equalizer mit 10 Bandern mit Filtern mit
steilflankiger/Kuhschwanz-Charakteristik

.peqg3 Parametrischer Equalizer mit 3 Bandern

.peg3cs Parametrischer Equalizer mit 3 Bandern mit Filtern mit
steilflankiger/Kuhschwanz-Charakteristik

.peq5 Parametrischer Equalizer mit 5 Bandern

.peg5cs Parametrischer Equalizer mit 5 Bandern mit Filtern mit
steilflankiger/Kuhschwanz-Charakteristik

.peq? Parametrischer Equalizer mit 7 Bandern

.peq7cs Parametrischer Equalizer mit 7 Bandern mit Filtern mit
steilflankiger/Kuhschwanz-Charakteristik

.pin Pin-Konfiguration

.scn Szene-Datei

.softcomp Kompressor - Soft-Knee-Option

.softlim Limiter - Soft-Knee-Option

.softstcomp Stereo-Kompressor - Soft-Knee-Option

.softstlim Stereo-Limiter - Soft-Knee-Option

.stcomp Stereo-Kompressor

.stlim Stereo-Limiter

.xover2 2-Wege-Frequenzweiche

.xover3 3-Wege-Frequenzweiche

.xover4 4-Wege-Frequenzweiche

.xover5 5-Wege-Frequenzweiche
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ANHANG D: STORUNGSSUCHE

Kommunikationsstorung zwischen dem Computer und dem P4800:

Die folgenden Meldungen werden bei Kommunikationsstérungen der P4800 Software mit dem Gerat
angezeigt.

»COM(port) is already in use or does not exist.." (COM-Anschluss wird bereits
verwendet oder existiert nicht)

Diese Meldung wird unter den folgenden Umstanden angezeigt:
= Der vorgegebene COM-Anschluss wird bereits von einer anderen Anwendung verwendet.

Wenn der vorgegebene COM-Anschluss bereits von einer anderen Anwendung verwendet wird, lasst sich
das Problem durch Beenden der anderen Anwendung beheben. Beispiele von Anwendungen, die den COM-
Anschluss gedffnet halten, sind der HotSync Manager und ahnliche Dienstprogramme zur Synchronisierung
des Computers mit Geraten wie Palm Pilot™. Das SchlieRen solcher Programme ist unter Umstanden nicht
einfach moglich, da sie haufig als Hintergrundanwendungen ausgefiihrt werden. Informationen sind aus dem
Benutzerhandbuch der jeweiligen Anwendung ersichtlich. Desktop-Computer verfligen gewdhnlich Uber
mehr als nur einem physischen seriellen Anschluss. In diesem Fall kann das Problem behoben werden,
indem ein anderer COM-Anschluss gewéahlt und das serielle Kabel fiir den P4800 dort angeschlossen wird.

= Der serielle Anschluss des Computers ist deaktiviert.

Die BIOS-Einrichtroutine ausfiihren und den seriellen Anschluss aktivieren. Dabei die Einstellungen des
seriellen Anschlusses (IRQ- und E/A-Adresse) notieren und sicherstellen, dass unter Windows diese
Einstellungen einem COM-Port zugewiesen sind. Danach diesen COM-Anschluss in der P4800 Software
wahlen.

»Network not ready..." (Netzwerk nicht bereit)

Diese Meldung weist darauf hin, dass die P4800 Software den COM-Anschluss erfolgreich 6ffnen konnte, aber
kein daran angeschlossenes Gerat vorfand. Vor der Kommunikation mit dem P4800 sicherstellen, dass er
eingeschaltet ist und seinen Startablauf beendet hat. Wenn der Computer mehr als einen COM-Anschluss
aufweist, sicherstellen, dass das Netzwerkkabel an den gleichen COM-Anschluss angeschlossen ist, der im
Dialogfeld ,Select COM Port* (COM-Anschluss wahlen) eingestellt wurde.

Sicherstellen, dass ein einwandfreies serielles DB9-Kabel verwendet wird und dass es richtig am Computer
und am P4800 angeschlossen ist. AuRerdem sicherstellen, dass die Verbindung zum richtigen Anschluss am
Gerat hergestellt wurde: der RS232 ist der Anschluss, der normalerweise verwendet wird.

»NoO devices detected.” (Keine Gerate gefunden)

Die P4800 Software hat ein anderes Gerét als ein P4800 am gewdahlten COM-Anschluss vorgefunden.
Méglicherweise ist ein Modem oder ein anderes serielles Gerat wie beispielsweise ein DFR11EQ vorhanden.
Dieses Problem lasst sich beheben, indem der COM-Anschluss gewdahlt wird, an dem der P4800
angeschlossen ist.

An der Vorderseite des P4800 wird ein statisches LED-Muster angezeigt:

An der Geratevorderseite wird moglicherweise ein ungewdhnliches LED-Muster angezeigt, wenn der P4800
einen internen Fehler wie in den folgenden Beispielen hat:

= Der Steuerpin-Versorgungsstrom (5 Volt, max. 100 mA) war zu hoch oder ist massegeschlossen. Alle
Steuerpin-Anschlisse entfernen und die Spannungsversorgung des Geréts aus- und wieder einschalten.

» Eine beschadigte Szene ist im Geratespeicher vorhanden und muss geléscht werden. Wenn das Problem
nach Ausfihrung der nachstehenden Anweisungen fortbesteht, wenden Sie sich an Shure’s Applications
Group.

So werden beschadigte Presets geldscht:

1. Die P4800 Software 6ffnen und im Design-Modus ,File>Delete Preset’ (Datei>Preset I6schen)
wahlen.

2. Presets, die als ,Corrupted” (Beschadigt) angezeigt werden, l6schen. Wenn das aktive Preset
(LIVE) die Storung verursacht, auf [Cancel] (Abbrechen) klicken.
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8. ,File>New" (Datei>Neu) wahlen, um eine leere Szene zu erzeugen, und dann ,File>Store
Preset” (Datei>Preset speichern) wéhlen und das beschadigte aktive Preset (LIVE) mit der
leeren Szene Uberschreiben.

= Die Aktualisierung der Firmware wurde unterbrochen. Zur Korrektur die nachstehenden Anweisungen
ausfuhren. Wenn das Problem fortbesteht, wenden Sie sich an Shure’s Applications Group.

So wird die Firmware-Aktualisierung abgeschlossen:
1. Die Spannungsversorgung des Gerats aus- und wieder einschalten.
2. [Firmware Upgrade] (Firmware-Aktualisierung) aus dem Men [File] (Datei) auswahlen.

3. Wenn die Software zur Aktualisierung des Codes auffordert, auf [Continue] (Weiter) klicken.

Umschalten von Gerate-Presets vom Computer ist nicht moglich:

e Die Sicherheitsstufe des Geréts Uberprifen. Damit Presets vom Computer umgeschaltet werden kénnen,
muss das Gerat auf Sicherheitsstufe 1 oder auf die benutzerdefinierte Stufe 2 eingestellt sein. Fir weitere
Informationen siehe den Abschnitt Sicherheit auf Seite 85.

e Wenn die Preset-Umschaltung Uber die Steuerungs-Eingangspins aktiviert ist, reagiert das Gerat nicht auf
Preset-Umschaltung tber den Computer. Zum Beheben des Problems die Steuerpins fir Preset-
Umschaltung im Fenster ,Control Pin“ deaktivieren. Fir weitere Informationen siehe den Abschnitt Preset-
Steuerblock auf Seite 78.

Die Software schaltet unvermittelt vom Live-Modus in den Design-Modus:

Wenn beim Arbeiten im Live-Modus an den Steuereingangen angeschlossene Gerate zum Umschalten von
Presets, Stummschalten von Kanélen oder Einstellen der Lautstarke verwendet werden, schaltet die
Software méglicherweise in den Design-Modus. Dies ist ein normaler Vorgang. Die Uberwachung von
externer Geratesteuerung Uber die Software wird gegenwartig nicht unterstiitzt. Bei schnelleren Computern
tritt diese Situation weniger oft ein.
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Anhang E

ANHANG E: FIRMWARE-AKTUALISIERUNGEN

Wenn ein P4800 zum ersten Mal angeschlossen wird, erhalten Sie eventuell eine Aufforderung zur Aktualisierung der
Firmware. Falls diese Aufforderung erfolgt, ist eine Aktualisierung erforderlich, bevor die neuen Funktionen und
Verbesserungen der Softwareversion 4.0 des P4800 Systemprozessors genutzt werden kdnnen.

Bevor mit der Aktualisierung weitergemacht wird, missen alle Shure Link Kabel und samtliche externen Steuergerate
abgenommen werden. Sie sollten auch alle anderen offenen Anwendungen schlieRen. Stellen Sie mit einem RS-232-
Kabel eine direkte Verbindung mit dem P4800 her

Sie kénnen dann eine Sicherungskopie aller Daten in Ihrem P4800 erstellen, indem Sie auf die Schaltflache [Backup
Device] (Gerat-Datensicherung) klicken und die Anweisungen befolgen. Nachdem die Datensicherung
abgeschlossen ist, beginnt die Firmware-Aktualisierung. Unterbrechen Sie die Aktualisierung nicht, nachdem sie
begonnen hat!

Hinweis: Wenn die Firmware-Aktualisierung aus irgendeinem Grund fehlschlagt (z.B. aufgrund
eines Stromausfalls oder eines abgenommenen Kabels), mussen Sie [Firmware
Upgrade] (Firmware-Aktualisierung) im Menu [File] (Datei) wahlen, um den
Aktualisierungsvorgang nochmals zu starten.
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